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2. Introduction to Thermo-Calc 
This guide is an introduction to working with both Graphical Mode and Console 
Mode in Thermo-Calc.  

• The Thermo-Calc Software 
• Typographical Conventions 
• Graphical Mode vs Console Mode 
• Help Resources 
• Example Collections  
• The Thermo-Calc Modules 
• Displaying Thermo-Calc License Information 
• Databases 
• Using This Guide 

 The Thermo-Calc Software 

The Thermo-Calc software is a sophisticated database and programming 
interface package used to perform thermodynamic calculations. It can 
calculate complex homogeneous and heterogeneous phase equilibria, and 
then plot the results as property diagrams and phase diagrams.  

The Thermo-Calc software (also referred to as the Thermo-Calc program or the 
software to distinguish it from the company name) fully supports 
stoichiometric and non-ideal solution models and databases. These models 
and databases can be used to make calculations on a large variety of materials 
such as steels, alloys, slags, salts, ceramics, solders, polymers, subcritical 
aqueous solutions, supercritical electrolyte solutions, non-ideal gases and 
hydrothermal fluids or organic substances. The calculations take into account a 
wide range of temperature, pressure and compositions conditions. 

A Software Development Kit (SDK) is available. This SDK is used to plug the 
calculation engine into your own application or into other third-party 
applications.  

The Thermo-Calc program also includes modules to run simulations of 
diffusion controlled transformations in multicomponent systems, DICTRA and 
DIC_PARROT.  

 For information about how to use DICTRA in Console Mode, search the 
online help or see the DICTRA User Guide.  

 Typographical Conventions 

The following conventions are used throughout the documentation: 

Convention Definition 

Forward arrow → The forward arrow symbol → instructs you to select a 
series of menu items in a specific order. For example, 
Tools →Options is equivalent to: From the Tools menu, 
select Options. 

http://www.thermocalc.com/support/documentation/
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Convention Definition 

Boldface font A boldface font indicates that the given word(s) are 
shown that way in on a toolbar button or as a menu 
selection. For example, if you are told to select a menu 
item in a particular order, such as Tools →Options, or to 
click Save. 

Italic font An italic font indicates the introduction of important 
terminology. Expect to find an explanation in the same 
paragraph or elsewhere in the guide.  

COMMAND This font and all capital letters in the body of the text 
indicates that this is a COMMAND used in the Console 
Mode terminal.  
Examples of how you can use a command are written 
with the code font: 
SET_CONDITION T=1000 P=1E5 X(C)=0.01 
N=1 

HELP Text in blue and underline is a link to another section.  

<Enter> Text with <angle brackets> indicates a keyboard entry. 
Usually to press <Enter> (or Return). 

code and code bold A code font shows a programming code or code 
example. The code bold font highlights the entry. 

Important  
 Provides important information and indicates 

that more detail is located in the linked or named 
topic. 

Note  
The information can be of use to you. It is 

recommended that you read the text or follow the 
link to more information. 

Also see  Go to more information about the topic being 
discussed. 

Examples 
 Go to the example collection to learn more. 

 Graphical Mode vs Console Mode 

There are two interfaces for the Thermo-Calc program: Graphical Mode with a 
graphical user interface (GUI) and Console Mode, which uses a command line 
interface.  

• In Graphical Mode calculations are set up, carried out, and visualized as 
part of a project. The steps in the project are performed with activities. 
There are templates and a Wizard available to guide you through the 
process of defining the project. 
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• In Console Mode you work with modules, which are managed using 
commands typed at a prompt. Some modules, called response-driven 
modules, prompt you with a series of questions that typically take you 
through the process of defining your system, setting calculation conditions, 
performing calculations and plotting the results. 

2.3.1 Switching Between Modes 
The first time you open Thermo-Calc, it defaults to Graphical Mode. For any 
future instance it defaults to the last mode used.  

Along the top of the GUI is the toolbar where you switch between modes. The 
first example is the toolbar in Graphical Mode. 

 
In Console Mode, except for the Switch to Graphical Mode button, the toolbar 
is not used.  

 

 Also see Main Menu and Toolbar for information about the Tools, Window 
and Help menus, which are available in both modes. 

 The two modes can be run simultaneously, but there is no communication 
between them. What you do in Graphical Mode does not affect the state of 
the Console Mode session and vice versa. One exception is the plot settings.  

 Also see Graphical and Console Mode-Plotting. 

Although many calculations can be done in either mode, only data 
optimisation and thermodynamic or kinetic assessments are available in 
Console Mode.  

 Help Resources 

All the documentation and examples are available online or in PDF format. 

2.4.1 Using Online Help 
To access online help, open Thermo-Calc and select Help → Online Help. 
This online help contains the same documentation that is installed in folders 
with your software. The advantage is you can browse all the content and 
search for key words and phrases. 

Browse 

Use the Contents panel to explore the documentation. Click to expand or 
collapse a branch in the tree. The node you click in Contents opens the topic in 
the right panel. In this example, the content is a list of topics. Click the links to 
go to those topics. 
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Click the web browser navigation buttons after clicking a link: When you are in 
the help content and you click a hyperlink, use the web browser buttons to 
move back and forth in the history. 

 
Toggle between Expand All and Collapse All 

On pages that have content in drop-down lists, click Expand all and Collapse 
all to toggle between the options. 

 

Navigate Previous and Navigate Next 

Click the Navigate previous or Navigate next buttons to move back and forth 
through the documentation tree one topic at a time. 
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Browse the Index 

Click the Index tab and scroll through the keyword terms. Click a term to open 
a list of related topics. Click keywords with an arrow next to them to view the 
second level keyword. 

 
Search the Contents 

Enter a search word or string. To search for a specific phrase or word, enclose 
it in quotation marks ("). For example, "Property Model Calculator" returns 
only results with that string but Property Model Calculator searches for all the 
words. 

 
Search the Index 

Enter a search word or part of a word. Results are listed. Click a keyword to 
open a list of related topics. 
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Print 

Click the print button to print the content in the right panel. This button is not 
available when you use the Context help window. 

 

2.4.2 Using Context Help 
To access some feature help, in the lower left corner of the Configuration 
window, click the help button  for information about the active tab or node. 
In this example, clicking the button opens information about System Definer. 

 
The window that opens has the same content as the help you access in the 
browser except you cannot Print from this window.  
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Click the Contents  button to toggle open and close the Contents and 
Index tabs as well as Search functionality. 

Use the Collapse all, Navigate previous, and Navigate next buttons 

 
to browse the content as described in Welcome to Thermo-Calc. 

Use the buttons on the bottom of the window, 

 
to navigate Back and Forward (these are only active once you have started 
using the help to load pages and create a history), to Close the window, 
and Reload the original content. 

2.4.3 Console Mode Help 
In Console Mode at the command line prompt, you can access help in these 
ways: 

• For a list of all the available commands in the current module, at the 
prompt type a question mark (?) and press <Enter>. 

• For a description of a specific command, type HELP followed by the name 
of the command. You can only get online help about a command related to 
the current module you are in. 

• For general system information type INFORMATION. Specify the subject or 
type ? and the available subjects are listed. This subject list is specific to 
the current module. 

2.4.4 PDFs 
On Thermo-Calc Software’s website and wherever the software is installed, 
folders containing the PDFs versions of the documentation are also 
downloaded.  

 Also see the Thermo-Calc Installation Guide for details of where these are 
installed for your operating system.  

 Example Collections 

To learn more about how to use the software you can open and run the 
example projects (Graphical Mode) and macro files (Console Mode). These are 
in the format of project files (*.TCU) and macro files (*.TCM), respectively. 
Some examples are referred to throughout this guide. 

Examples on the Website 

You can find the Graphical and Console Mode examples on the website under 
Examples. The example files are also included in the installation.  

http://www.thermocalc.com/support/documentation/
http://www.thermocalc.com/support/documentation/
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Figure 1: The Examples available on the Thermo-Calc website. 

Installed Examples  

The default directories where the software and its components are installed, 
vary by platform and user type.  

 On a Windows network user login, the Thermo-Calc and DICTRA Examples 
and Materials folders are located here C:\Users\Public\Documents\Thermo-
Calc\2015b. The TC_PRISMA Examples folder is located here 
C:\Users\<user>\Documents\Thermo-Calc\2015b. For all products, the 
manuals are located here C:\Program Files\Thermo-Calc\2015b\Manuals. 

 On Windows, once Thermo-Calc is installed, you can also locate the 
Thermo-Calc and DICTRA Examples and Materials folders, plus all the Manuals 
using the shortcuts located in the Start menu. Go to Start → All Programs 
>Thermo-Calc and click Examples, Manuals, or Materials as required to open 
the applicable folder. The TC_PRISMA Examples folder is currently available 
from here C:\Users\<user>\Documents\Thermo-Calc\2015b. 

In the table, <user> stands for the username and <version> for the version of 
Thermo-Calc, for example 2015b. 

OS User type Default directory 

 

Normal user  • Users\<user>\Thermo-Calc\<version> 
• Users\<user>\Documents\Thermo- 

Calc\<version> 
• My documents  

Administrator • Program Files\Thermo-Calc\<version> 
• Users\Public\Documents\Thermo- 

Calc\<version> 
• Public documents 

 

Administrator 
(user name and 
password 
required) 

Examples and manuals in /Users/Shared/Thermo-
Calc/<version> 
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OS User type Default directory 

To go to this folder, in Finder, from the Go main 
menu select Go to folder. Enter the above file path 
and click Go. 

 
Non root user home/<user>/Thermo-Calc/<version> 

Root user usr/local/Thermo-Calc/<version> 

2.5.1 Graphical Mode Examples 
These project files have the extension *.tcu.  

 

Opening a Project File 

Navigate to the file location and double-click the *.tcu file to open it. It 
launches a new session of the software. Or you can select File → Open Project 
from an open session of Thermo-Calc. 

 Also see the Thermo-Calc Graphical Mode Examples Guide. 

Graphical Mode Example Projects 

# Example Description 

1 Shows the result from a single-point equilibrium calculation in the Fe-C 
system. It calculates a single-point equilibrium using the Equilibrium 
Calculator. 

2 Shows how the fractions of stable phases vary for an Fe-0.1 mass-% C 
alloy when the temperature is varied between 500 and 2000 K. It 
calculates the stepping in temperature in the Fe-C system using the 
Equilibrium Calculator and plots it with a Plot Renderer and displays the 
text using a Table Renderer. 

3 Shows the stable Fe-C phase diagram (stable meaning that the graphite 
phase is entered in the calculation). The same diagram is calculated 
using a Binary Calculator activity and then a System Definer with an 
Equilibrium Calculator activity.  

4 Shows a ternary phase diagram in the Fe-Cr-C system at 1000 K. The 
same diagram is calculated using a Ternary Calculator and then a 
System Definer with an Equilibrium Calculator activity. 
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# Example Description 

5 Shows how to overlay results from two calculations (the stable and the 
metastable Fe-C phase diagrams) in the same plot using the Equilibrium 
Calculator. 

6 Shows how to use serially coupled Equilibrium Calculators for more 
complex equilibrium conditions. Four examples using the Equilibrium 
Calculator help you learn how to do this in Thermo-Calc. 

7 Shows the use of user-defined functions. A series of equilibria for an Fe-
Cr-C alloy are calculated by varying temperature between 500 and 3000 
K using the Equilibrium Calculator. 

8 Shows a comparison for an Al-Si alloy solidified under full local 
equilibrium and under the Scheil assumptions using the Scheil 
Calculator.  

9 Shows how to use property grid calculations to plot the driving force for 
a carbide as a function of two composition variables. The final plot, 
using the Plot Renderer, can be either a heat map or a contour plot. 

10 Uses the Property Model Calculator to predict the transition 
temperature to the unwanted brittle Sigma phase. The example shows 
how the temperature is influenced by changes to a steel alloy’s 
composition using the uncertainty calculation type and how to create 
either a histogram or probability plot. 

11 Uses the Property Model Calculator and both thermodynamic and 
kinetic demonstration steel databases. With a grid calculation type it 
produces three plots: a heat map, a contour plot and a cross plot with 
contour (where both the interfacial energy and coarsening rate is 
shown). 

12 Uses the Property Model Calculator and both thermodynamic and 
kinetic demonstration steel databases. Using a grid calculation type it 
produces a contour plot comparing the driving force and interfacial 
energy. 

2.5.2 Console Mode Examples 
These macro files (with the extension *.TCM) include comments, which you can 
either run in Thermo-Calc or open and read in a text editor. If you read the 
macro file in a text editor, you do not see the output that Thermo-Calc gives in 
response to the commands stored in the macro file. However, the PDF guide, 
Thermo-Calc Console Mode Examples Guide (see Figure 1), also shows the 
output for each example. 

Opening a Macro File 

Navigate to the file location, where each example is in its own folder.  
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In the folder, double-click the *.TCM file to open it. It launches a new session of 
Thermo-Calc and opens in Console Mode. If you have an instance of Thermo-
Calc open in Console Mode, you can also drag and drop the file to run the 
macro. You can also open any text file editor and drag the file into it to see its 
contents. 

Console Mode Macro Examples 

# Example Description 

1 Calculation of the binary Fe-C phase diagram. 

2 Plotting of thermodynamic functions in unary, binary and ternary systems 
and working with partial derivatives and partial quantities 

3 Calculation of an isothermal section using the TERNARY module. 

4 Calculation of the miscibility gap in Fe-Cr 

5 Calculation of a vertical section from Al to 30% Mg2Si 

6 Calculation of an isopleth in low alloyed Fe-Mn-Si-Cr-Ni-C steel. 
This example calculates a multicomponent phase diagram using the define-
material command in POLY and the TCFE steel database. The material 
contains 1.5 %Cr + 0.4 %Mn + 3.5 %Ni + 0.3 %Si and 1 %C (by weight). These 
conditions and the temperature are set by the command. Hidden 
commands set the pressure to 1 bar and so that iron is "the rest". 
After calculating the first equilibrium a phase diagram is calculated with one 
axis variable as temperature and the other as the carbon content. 

7 Calculation of single equilibria in low alloyed Fe-Mn-Si-Cr-Ni-C steel. 
There are two general ways to perform a single equilibrium calculation: 

• Get data from a database, then in POLY use SET_CONDITION and 
COMPUTE_EQUILIBRIUM. 

• Go directly to POLY and use DEFINE_MATERIAL. 
The COMPUTE_TRANSITION command is also used to determine the 
temperature or composition where one phase forms or disappears. 

8 Calculation of property diagrams for a high speed steel i.e. phase fraction 
plots, activity vs temperature, etc. 

9 Calculation of dew point. 
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# Example Description 

10 The example calculates an equilibrium with suspended or dormant phases 
and shows how to avoid clogging of Cr2O3 in a continuous casting process. 
The origin of this example is that a manufacturer wanted to increase the Cr 
content of a material from 18 to 25 weight percent but the continuous 
casting of this material was problematic because solid Cr2O3 was formed. 
Using Thermo-Calc to calculate the equilibria in the steel/slag system, a 
simple correction was found: modify the Mn or Si content to decrease the 
oxygen potential. 
In Thermo-Calc, you can FIX a phase with zero amount to simulate how to 
avoid forming this phase. You then release one of the conditions, usually 
one of the compositions, and this composition is determined by the 
equilibrium calculation. 

11 This example demonstrates the oxidation of Cu2S with H2O/O2 gas mixture. 
Thermo-Calc is used to find the optimum O/H ratio (i.e. oxygen potential) as 
certain oxygen potential values can desulphurize Cu2S without forming 
copper oxides. 
In Thermo-Calc, the problem reduces to perform equilibria calculations in a 
Cu-S-H-O system. The amounts of the components should be kept to correct 
ratio corresponding to Cu2S and H2O using a command 
SET_INPUT_AMOUNTS in POLY_3. Initially, O/H = 0.5 is given. Optimum O/H 
ratio is calculated with the desired calculation conditions. For example, to 
simulate one phase disappearing, you can FIX the phase with zero amount. 

12 This example shows a number of independent cases using the TAB- module 
to tabulate thermodynamic data for reactions. 

13 Binary calculation of Al-Ti phase diagram and G curve. 

14 Calculation of heat and heat capacity variations during solidification of an 
Al-Mg-Si alloy. 

15 Solidification simulation of a Cr-Ni alloy using the SCHEIL module. 
There is no back diffusion in the solid. 

16 Calculation of the second order transition line in the Bcc field of the Al-Fe 
system. 

17 Calculation of pseudo- or quasi-binary phase diagram in the CaO-SiO2 
system. 
This database can be used both for pseudobinary systems like the one in 
this case, CaO-SiO2, or for full ternary systems like Ca-Fe-O. 

18 Calculation of the A3 temperature of a steel and the influence of each 
alloying element on this temperature. 
A3 temperature is the temperature where ferrite starts to form from 
austenite. You can easily read A3 from an Fe-C phase diagram. But for 
complex multicomponent steels, no simple diagram can be used. This 
example shows how to calculate the A3 temperature of a steel. Using POLY, 
it is easy to find out the influence of each alloying element on A3 
temperature. This information is useful if you want to modify the 
compositions of a steel but keep A3 unchanged. 

19A Mapping of univariant equilibria with the liquid in Al-Cu-Si. Part A. Step-by-
step calculation using POLY. 
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# Example Description 

19B Mapping of univariant equilibria with the liquid in Al-Cu-Si. Part B. Using the 
TERNARY module, you can get the information on invariant reactions, such 
as temperature and compositions. 

20 Calculation of adiabatic decompression in a geological system using the 
geochemical database. 

21 Calculate a ternary isotherm in Fe-Cr-Ni with a user-defined database. 

22 Calculation of a heat balance. In this case C3H8 is burned in oxygen and the 
adiabatic flame temperature is calculated. 

23 Calculation of a para-equilibrium and the T0 temperature in a low alloyed 
steel. 

24 Simulation of the silicon arc furnace using the REACTOR module. 
This is a simple reactor model with output of gases at the top and output of 
condensed phases at the bottom. The gas phase from one segment flows to 
higher segments, 80 % reacts in the first above, 15% in the second above 
and 5 % in the third above. 
The condensed phases flow downwards and all of it goes to the next lowest 
segment. Heat can be added at any module. The only way to specify the 
initial state of the reactants added to the reactor is to specify their heat 
content. 

25 Simulation of steel refining. 
Raw iron used to produce steel usually has high carbon and silicon content, 
which is why oxygen is blown into the furnace to burn off carbon. Lime 
(CaO) is added to form a slag with silica, and the slag can be removed. 
Alloying elements, such as Mn, Ni, Cr and V are added to produce the 
desired steel. Since the reaction between O and C increases the 
temperature, scrap iron is added in order to keep the temperature constant 
(it is assumed the furnace is isolated and no heat is lost to the 
environment). This is a typical steel refining process. 
This example simulates blowing oxygen into a liquid steel of one metric ton 
(1e6 grams) with 4 w/o C, 2 w/o Si and 1 w/o Mn. 100 moles of CaO 
(equivalent to 5.6 kg) is added. Keeping the enthalpy constant is the way to 
simulate the isolation of the furnace. The oxygen reacts with carbon and 
increases the temperature. After blowing a certain amount of oxygen, scrap 
iron is added to keep the temperature constant. 

26 Example of plotting the partial pressures of a gas species along the solubility 
lines in the As-Ga phase diagram. The calculation makes it possible to 
monitor the input gases to a process of depositing solid AsGa. 

27 CVD calculations 

28 Example showing calculation of PRE (Pitting Resistance Equivalence) for a 
duplex stainless steel. 

29 Calculation of speciation of a gas 

30A Scheil solidification simulation for Al-4Mg-2Si-2Cu alloy. Part A. Step-by-step 
calculation using POLY and the STEP_WITH_OPTION command, EVALUATE 
option.  

30B Scheil solidification simulation for Al-4Mg-2Si-2Cu alloy. Part B. Simulation 
performed using SCHEIL module. 
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# Example Description 

31 Calculations of CVM and comparisons with sublattices of a fictitious A B 
system. Also shows how to overlay diagrams from two calculations. 

32 Calculation of oxide layers on steel. Also shows how to append databases. 

33 Benchmark calculation - An isopleth in the Fe-Cr-C system. 

34 Calculation of the phase diagram and G curves in the Al-Zn system. An 
example of using the BINARY module. 

35 Calculation of potential diagram 

36 Assessment - The use of the PARROT module 
The example is divided into four parts corresponding to the files in the 
folder. 
• The problem is presented with "selected" experimental data (see the 

tcex.36.readme file). The example uses a fictitious binary A-B system 
where element A is BCC until it melts. Element B is BCC up to 1100 K 
and FCC above. There is a compound A2B stable in a limited 
temperature range. 

• The creation of the "setup" file is described (tcex36a.TCM) 

• The creation of the experimental data file is described (tcex 36b.TCM) 
• The actual run in the PARROT module in order to obtain the result (tcex 

36cpd.TCM) 

37 Calculation of an isothermal section using command lines. 

38 Calculation of the Morral “rose” (miscibility gaps). 

39 This example shows how Thermo-Calc calculates the reversible Carnot cycle 
of a heat engine using one mole of an ideal gas with two fictitious species A 
and A2.  
The Reversible Carnot cycles are usually drawn schematically. Using 
Thermo-Calc and realistic data it is possible to calculate a reversible Carnot 
cycle of a heat engine and to relate it to different thermodynamic 
quantities.   
One application of the Second Law is to the efficiencies of heat engines, 
pumps and refrigerators. Whenever there is a difference of temperature, 
work can be produced - the principle of heat engines. The Gibbs energy also 
enables the prediction of the maximum work that a process may achieve. 

40 A series of examples designed to demonstrate the advanced POURBAIX 
module calculations and graphical processing. Also see the text file the 
Extended folder (TCEX40-README.txt). 
The first example automatically calculates and plots a Pourbaix diagram for 
0.001 m Fe in a 0.1 m NaCl aqueous solution at 25C and 1 bar. A so-called 
Pourbaix diagram is actually a phase diagram with independently-varied 
acidity (pH) and electropotential (Eh), for a heterogeneous interaction 
system at a certain bulk composition (that is by default always set as 1 kg of 
water dissolving a specified amount of metals and other solutes), under a 
defined temperature and pressure condition.  

 For details about the other examples, see Pourbaix Examples TCEX40, 
40A to 40E, and TCEX53. 

41 Calculation of a solubility product. Shows the STEP_WITH_OPTION 
command, T-ZERO option. 
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# Example Description 

42 Formation of para-pearlite (isopleth calculation) Fe-Mn-C system at 2.5%Mn 
Mass u-fraction (an example of a paraequilibrium calculation). 

43 Formation of para-pearlite (calculation of isothermal section) Fe-Mn-C 
system at 700 C (an example of a paraequilibrium calculation). 

44 This example uses variables and functions to predict properties e.g. proof 
strength for an austenitic stainless steel at elevated temperatures (20-
550C). 

45 3D-diagram that calculates the gamma volume in the Fe-Cr-C system. 
To view the generated file, tcex45.wrl, install a WRML (Wirtual Reality 
Modelling Language) viewer to the web browser. WRML viewers can be 
downloaded from various sites, e.g. www.parallelgraphics.com or 
www.sim.no. 

46 3D-diagram that calculates the liquidus surface of the Fe-Cr-C system. 
To view the generated file, tcex46_tri.wrl and tcex46_sqrt, install a WRML 
(Wirtual Reality Modelling Language) viewer to the web browser. WRML 
viewers can be downloaded from various sites, e.g. 
www.parallelgraphics.com or www.sim.no. 

47 3D-quaternary diagram that calculates the gamma volume in the Fe-Cr-V-C 
system at 1373K. 
To view the generated file, tcex47.wrl, install a WRML (Wirtual Reality 
Modelling Language) viewer to the web browser. WRML viewers can be 
downloaded from various sites, e.g. www.parallelgraphics.com or 
www.sim.no. 

48 This is an example of Scheil solidification with C back diffusion in solid 
phases and compares it with simple Scheil and equilibrium calculations. 

49 This example shows how to enter parameters for a FACT quasichemical 
liquid model and how to calculate the sulfur activity using the 
GIBBS_ENERGY_SYSTEM (GES) module commands. 

50 This example shows the quasichemical model using TDB to replicate figures 
3 and 4 from Kongoli, F., Pelton, A. D. & Dessureault, Y. Thermodynamic 
modeling of liquid Fe-Ni-Cu-Co-S mattes. Metall. Mater. Trans. B 29, 591–
601 (1998). 

51 Calculation of molar volume, thermal expansivity and density. 

52 This example shows how to change the excess models for binary/ternary 
interactions in a solution phase, either through direct interactive 
amendments of phase descriptions within the GIBBS_ENERGY_SYSTEM 
(GES) module, or enforced by specific type-definitions given in a database 
file retrieved by the TDB module.  

• For binary excess model: from the default R-K model to Mixed-Excess-
Model (Note the phase has to be a substitutional phase)  

• For Ternary Extrapolation Model: from the default R-K-M model to 
Toop_Kohler model. 

53 Pourbaix Diagram Calculations through the TDB-GES-POLY-POST routine. 
Using PAQ2 or PAQS2 database; for the Fe-X-H2O-NaCl heterogeneous 
interaction systems (X = Cr-Ni-Co). 

http://www.parallelgraphics.com/
http://www.sim.no/
http://www.parallelgraphics.com/
http://www.sim.no/
http://www.parallelgraphics.com/
http://www.sim.no/
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 The Thermo-Calc Modules and Activities 

Although many calculations can be done in either Graphical or Console Mode, 
only data optimisation and thermodynamic or kinetic assessments are 
available in Console Mode. Conversely, only the Property Model Calculator is 
available in Graphical Mode. 

Modules and Activities briefly describes the available modules. The specific 
modules, using the names in the table, are accessed through Console Mode. 
For Graphical Mode, the underlying principles, and the final calculations, are 
incorporated into the projects and activities. Some modules require additional 
licenses. 

The Graphical Mode column indicates whether there is an equivalent activity 
available in Graphical mode.  

 For the Console Mode only commands see The Console Mode Interface 
and the Thermo-Calc Console Mode Command Reference. 

Modules and Activities 

Full Module Name 
in Console Mode 

Short 
Name 

Graphical 
Mode 
Activity 

Primary Functions 

BINARY_DIAGRAM_EASY BIN Binary 
Calculator 

Calculate binary phase 
diagrams. Access to specific 
databases designed for BIN, 
such as TCBIN, is required. 

DATABASE_RETRIEVAL DATA System 
Definer 

Select appropriate databases, 
define chemical systems and 
retrieve the data required for 
calculations.  

DICTRA_MONITOR1 DICTRA Console 
Mode only 

Run simulations of diffusion 
controlled transformations in 
Thermo-Calc.  

DIC_PARROT1 DIC_PARROT Console 
Mode only 

This is the data optimisation 
module for DICTRA. It allows 
you to assess experimental data 
and use such data to optimise 
calculations.  

EDIT_ EXPERIMENTS ED_EXP Console 
Mode only 

Part of the PARROT submodule, 
use it to edit experimental data 
points to make reliable 
optimisations. 

GIBBS_ENERGY_SYSTEM GIBBS Console 
Mode only 

Handles thermodynamic 
models and quantities. 
Generally you do not need to 
use this module, but you can 
get information about models, 
and list, add or amend the 
thermodynamic parameters in 
use.  
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Full Module Name 
in Console Mode 

Short 
Name 

Graphical 
Mode 
Activity 

Primary Functions 

PARROT PARROT Console 
Mode only 

A data optimisation module to 
assess experimental data and 
use the data to optimise 
calculations.  

not available - Property 
Model 
Calculator 

You can evaluate models 
simultaneously over a range of 
compositions and cross plot the 
results. You can then conduct 
an uncertainty analysis and plot 
the results as either a 
histogram or as a probability 
plot. 

POLY-3 POLY Equilibrium 
Calculator 

Equilibrium calculation module. 
Specify conditions and make 
calculations. 

POST_PROCESSOR POST Plot Renderer For post-processing and 
plotting of calculation results. 
Modify property and phase 
diagrams, add labels, change 
the diagram colours, etc. 
Submodules to POLY-3 and 
DICTRA for example. 

POTENTIAL_DIAGRAM POTENTIAL Ternary 
Calculator 

Calculate and plot gas potential 
diagrams in a ternary system. 
The potential of two gas species 
are used as the diagram axes.  

POURBAIX_DIAGRAM POURBAIX Console 
Mode only 

Calculate and plot pH-Eh 
diagrams (Pourbaix diagrams) 
and property diagrams for 
heterogeneous interaction 
systems involving aqueous 
solutions.  

REACTOR_SIMULATOR_3 REACTOR Console 
Mode only 

Simulate chemical reaction 
processes in several feed-
forward steady-state stages or 
in several dynamic stages. 

SCHEIL_SIMULATION SCHEIL Scheil 
Calculator 

Simulate and plot Scheil-
Gulliver solidification processes 
with no diffusion in the solid 
phases and with/without 
consideration of back diffusion 
of interstitial components (such 
as C, N, O, S). 
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Full Module Name 
in Console Mode 

Short 
Name 

Graphical 
Mode 
Activity 

Primary Functions 

SYSTEM_UTILITIES SYS Console 
Mode only 

In Console Mode, interact with 
the operating system and 
change environmental settings. 
Create and execute MACRO 
files. 

TABULATE_REACTION TAB Console 
Mode only 

Tabulate properties of chemical 
reactions and substances 
(stoichiometric or solution 
phases). 

TERNARY_DIAGRAM TERN Ternary 
Calculator 

Calculate ternary phase 
diagrams. 

 Displaying Thermo-Calc License Information 

You can start (and install) the software without a valid Thermo-Calc license but 
you cannot do any calculations. To show information about the available and 
installed licenses, from the main menu select Help → Show License Info.  

Figure 2 is an example of the License Information window for a network client 
installation.  

 Also see the Thermo-Calc Installation Guide for more about license types. 

 
Figure 2: License window for a network installation. 

http://www.thermocalc.com/support/documentation/
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• The number of licenses column is how many instances of each license type 
available to be checked out simultaneously 

• The in use column shows how many license instances are checked out. 
• Under each license type with instances checked out, there is a list of who 

checked out each license. In the example, two users, amanda and nli, have 
licenses checked out. 
• In Graphical Mode, an instance is checked out when an Equilibrium 

Calculator activity is created, and checked back in when that 
Equilibrium Calculator is removed.  

• In Console Mode, an instance is checked out when you enter the POLY 
module and is checked back in when you exit the POLY module. 

• There is also site and user information available. 

Console Mode License Restrictions 

• If you start Thermo-Calc without a valid Thermo-Calc license you cannot 
leave the SYS module. 

• If all the licenses are checked out for a network client installation of 
Thermo-Calc, you may not be able to enter the POLY or DICTRA modules 
until a license is available.  

• To enter the DICTRA and the DIC_PARROT modules, you need a valid 
DICTRA license key. 

• If you enter and use either the DIC_PARROT module or the PARROT 
module, then you cannot enter the other module in the same session. You 
must close down Thermo-Calc and launch the program again to enter the 
other data optimisation module.  

Network Computer License Restriction 

If you have a network computer installation of Thermo-Calc, then you may not 
be able to do any calculations even if you have access to a valid network 
license file. This is because others who are part of your network installation 
may have checked out all allowed instances of the software.  

If you are running a network installation of Thermo-Calc, you can see how 
many instances of the client licenses are currently checked out and how many 
of them are left. You can also see which client computers have checked out the 
licenses. See Figure 2. 

 Databases 

Depending on the type of license and operating system, the databases are 
located in a subfolder to the Thermo-Calc installation. For example, in a 
Windows standalone installation, you can find these in a folder called data (file 
path is C:\Program Files\Thermo-Calc\2015b\data).  

All databases have the file extension .TCD. 

In Graphical Mode you may need to navigate to a database file location. For 
example, in the System Definer activity you can click Open user database to 
choose a database. 
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2.8.1 Database Checker 
The Thermo-Calc software includes a program for checking that the syntax of 
Thermo-Calc database files is correct. This program is intended for advanced 
users who develop and manage databases.  

To launch the Database Checker application, from the main menu select Tools 
→Database Checker. 

 Using This Guide 

If you are a new user, Graphical Mode is a good way to learn how to work with 
Thermo-Calc. Console Mode has more functionality but until you are 
comfortable with the concepts, it is recommended you start in Graphical Mode  

This user guide is a supplement to the command references available for 
Console Mode and DICTRA. Additional documentation and training material is 
described in Help Resources. 

The Graphical Mode Interface introduces you to the GUI layout and the 
workflow. In Graphical Mode Projects, it goes into more detail about how to 
set up and run your projects (with the Quick Start Wizard), using templates, 
scheduling jobs and creating activities. The Graphical Mode Activities section 
specifically describes how to set up each type of available activity in the tree 
structure. 

Console Mode has more functionality than Graphical Mode but the underlying 
concepts are the same. There are, however, command lines and extensive 
details applicable to this mode. This guide is only the beginning of the learning 
objectives. In particular, refer to the Thermo-Calc Console Mode Command 
Reference for details about all the commands available.  

In this guide it is a basic introduction to the layout of the Command windows, 
as described in The Console Mode Interface.  

Several sections describe and give an example of the calculation types: 

• Equilibrium Calculations 
• Property Diagrams 
• Phase Diagrams 
• Scheil Simulations 
• T0 Temperature Simulations 
• Paraequilibrium 
• Potential Diagrams 
• Aqueous Solutions 
• Tabulation of Chemical Substances, Phases or Reactions 

In Console Mode Visualisation there is an overview of plotting and for both 
Graphical and Console mode, the Changing Global Settings section gives 
information about adjusting global user settings. 
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3. The Graphical Mode Interface 
This section introduces you to the concepts and terminology of Graphical 
Mode and describes the basic workflow.  

 Also see The Console Mode Interface. 

• The GUI Layout 
• Project Activities and the Tree Structure 
• Activity Successor and Predecessor Nodes 
• Graphical Mode Workflow 
• Main Menu and Toolbar 
• Saving and Opening Thermo-Calc Project Files 
• Project Activity Nodes 
• Project and Activity Menus 
• Moving Windows 
• Moving Nodes in the Tree and Using the Grid 
• Node Status Markers 

 The GUI Layout 

Figure 3 is an example of the default GUI layout for Graphical Mode. You can 
easily reorganize these windows.  

 Also see Moving Windows. 

 
Figure 3: The Graphical Mode default window layout. Note that the Results window also has a 
Plot Renderer tab in this example. You can also have a Table Renderer tab. 

The windows in Figure 3 are: 

1. Project: Create, manipulate and navigate between the activities that make 
up a project.  

2. Configuration: Shows the settings that can be configured for the currently 
selected activity. 
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3. Results: Shows the results of a calculation, either plotted as a diagram or 
displayed in table format. In this example, there is a Plot Renderer tab in 
the Results window. 

4. Scheduler: Displays information about jobs, such as calculations, that are 
being performed or are scheduled to be performed. You can cancel 
scheduled jobs and if a job has failed, then you can view information about 
the error. 

5. Event Log: By default this window is closed but it displays during 
calculation processes. You can always open it to view progress of 
calculations and to troubleshoot. 

 Project Activities and the Tree Structure 

In a project, a set of linked activities is called a tree. A result calculated within a 
tree is fed as input into the next activity in the tree. Consequently, if you have 
an Equilibrium Calculator with another Equilibrium Calculator as its successor, 
the successor takes the calculation results of the predecessor as the starting 
values for its calculation (see Activity Successor and Predecessor Nodes for 
definitions). When working with activities in the Project window these are also 
referred to as nodes (or activity nodes) in the tree structure. 

The Project window in Figure 4 shows a My Project node with two trees. In 
each tree, settings and calculation results are propagated downward until the 
calculation and the visualisation of the results are completed in the Plot 
Renderer nodes.  

The system definitions, settings and calculation results of the two trees are 
independent of each other. 

 
Figure 4: An example of a project with two trees with successor and predecessor activity nodes. 
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 Activity Successor and Predecessor Nodes 

An activity node located below another activity node in a tree is referred to as 
that activity’s successor. An activity located above another activity is called 
that activity’s predecessor. A predecessor is performed before the 
predecessor’s successors and its result is fed forward to any successor 
activities. 

 
Figure 5: Predecessor and successor nodes in the tree structure. 

For example, to calculate and display a phase diagram, create a branch with 
three linked activities: A System Definer activity linked to an Equilibrium 
Calculator activity, which in turn is connected to a Plot Renderer activity.  

Figure 6 is an example of a Project window with successors and predecessors. 
For example, Binary Calculator 1 is a predecessor to the successors, Plot 
Renderer 2 and Table Render 1.  

You can determine the available successors by right-clicking a node in the 
Project window and choosing options from the menus.  

 Also see Project and Activity Menus. 

 
Figure 6: An example of successors and predecessors. 

3.3.1 Creating Activities and Successors 
You can create a new activity in these ways: 

• In the Project window, right-click an activity and choose Create New 
Activity (My Project node only) or Create New Successor (all other nodes).  

• Select the activity you want to create from the submenu. 
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At the bottom of the Configuration window, click Create New Activity or 
Create New Successor and select the activity to create. 

 Also see Cloning Activities and Trees. 

Predecessors and Successors by Activity 

Activity Possible predecessors Possible successors 

My Project None; this is the first node of 
the tree structure 

System Definer, Binary 
Calculator, Ternary 
Calculator, Experimental 
File Reader. Also choose 
templates from this level. 

System Definer My Project, System Definer Property Model 
Calculator, Equilibrium 
Calculator, Scheil 
Calculator 

Property Model 
Calculator 

System Definer Plot Renderer 

Equilibrium Calculator System Definer, Equilibrium 
Calculator 

Equilibrium Calculator, 
Plot Renderer, Table 
Renderer 

Plot Renderer Property Model Calculator, 
Equilibrium Calculator, 
Binary Calculator, Ternary 
Calculator, Scheil Calculator, 
Experimental File Reader 

None 

Table Renderer Equilibrium Calculator, 
Binary Calculator, Scheil 
Calculator 

None 

Experimental File 
Reader 

My Project Plot Renderer 

Binary Calculator My Project Plot Renderer, Table 
Renderer 

Ternary Calculator My Project Plot Renderer 

Scheil Calculator System Definer Plot Renderer, Table 
Renderer 

 Graphical Mode Workflow 

You can set up a tree in the Project window (starting with the My Project node) 
and then perform all the activities at once, or create and perform one activity 
at a time. 

The typical workflow is to: 

1. Define a system: Create a System Definer activity (in the Project window) 
where you select a database and the elements to have as system 
components (in the Configuration window). 
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2. Set up and run a calculation: Create an Equilibrium Calculator activity (a 
successor to the System Definer), where calculation conditions are set 
(temperature, pressure, etc.). This is where axis variables are set to create 
a property or phase diagram. These settings are also made in the 
Configuration window. You can also create a Property Model Calculator. 

3. Visualize the results: Create either a Plot Renderer or a Table Renderer 
activity in the Project window. When calculated, this creates a plot or table 
in the Results window. The results are shown in a Plot Renderer or a Table 
Renderer tab.  

You need to Perform a Plot Renderer or a Table Renderer activity to 
visualize the calculation results from an Equilibrium Calculator. 

 Main Menu and Toolbar 

Along the top of the GUI is a toolbar and menus as described in this section. 

 
Graphical Mode Menu and Toolbar Options lists the main menu and toolbar 
options. The File menu and toolbar are reserved for Graphical Mode but in 
Console Mode the Tools, Window and Help menus have the same options.  

In Console Mode you use commands to access the other options instead. 
These are discussed in The Console Mode Interface section. 

Graphical Mode Menu and Toolbar Options 

Option Description Action (s) 

New  Create a new project. Click New on the toolbar.  
Select File →New Project. 
Press <Ctrl+N>. 

Open Open an existing project. See 
Saving and Opening Thermo-
Calc Project Files. 

Click Open on the toolbar. 
Select File →Open Project. 
Press <Ctrl+O>. 

Save Save a project. See Saving and 
Opening Thermo-Calc Project 
Files. 

Click Save on the toolbar. 
Select File →Save Project. 
Press <Ctrl+S>. 

Switch to Console 
Mode 

Launch Console Mode and the 
command prompt. 

Click the button to exit 
Graphical Mode and open 
Console Mode. 

Switch to Graphical 
Mode 

Launch Graphical Mode to 
work with the GUI version. 

Click the button to exit 
Console Mode and open 
Graphical Mode. 

Append Project Combine two projects into 
one project file. See Saving 
and Opening Thermo-Calc 
Project Files. 

Select File →Append 
Project. 
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Option Description Action (s) 

Save Project As… Save an existing project with a 
new name. 

Select File →Save Project 
As…. 

Exit Exit the program. In the upper right-corner of 
the program, click the X. 
Select File →Exit. 
Press <Ctrl+Q>. 

Options Change the global defaults for 
a variety of settings. See 
Changing Global Settings. 

Select Tools →Options. 

Database Checker Open the Database Checker, a 
program to check that the 
syntax of Thermo-Calc 
database files is correct. This 
is for advanced users who 
develop and manage 
databases. 

Select Tools →Database 
Checker. 

Window menu Highlight a specific window on 
the GUI  

From the Window menu, 
select an option to refocus 
on that specific window.  

Online Help Open the online help system 
where you can browse or 
search all the Thermo-Calc 
documentation. 

Select Help →Online Help 

Show License Info Open the License Information 
window. See Displaying 
Thermo-Calc License 
Information and the Thermo-
Calc Installation Guide for 
more information. 

Select Help →Show License 
Info 

Check for update Check the Thermo-Calc 
Software website for updates 
to the software. 

Select Help →Check for 
update 

 Saving and Opening Thermo-Calc Project Files 

Thermo-Calc Graphical Mode uses project files with the file name suffix .TCU.  

To save your project and all its settings and results, on the toolbar click Save. 
Select to Include calculated results in the project file (the default) as required.  

To open a Thermo-Calc project file, on the toolbar click Open and select the 
project file in the Open file window.  

You can only have one project file open at a time. However, you can attach 
(append) the trees from additional project files to the topmost My Project 
node. To append an additional project file in this way, from the main menu 
select File →Append Project and open a project file. 

 Also see Saving Plots and Saving Tabulated Data. 
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 Project Activity Nodes 

Project Activity Node Descriptions is a brief description of the project activity 
types. When working with activities in the Project window these are also 
referred to as nodes. 

Project Activity Node Descriptions 

Activity type Description 

System Definer Define a certain thermodynamic system and read it from file 
into memory. 

Property Model 
Calculator 

Choose one or more general models to predict and optimize 
material properties. You can evaluate models simultaneously 
over a range of compositions and cross plot the results. You 
can then conduct an uncertainty analysis and plot the results 
as either a histogram or as a probability plot. 

Equilibrium 
Calculator 

Set thermodynamic conditions and define axis variables when 
a series of equilibrium calculations are to be performed in one 
or more dimensions.  

Plot Renderer Determine the layout of non-text based output.  

Table Renderer Use it for text-based output.  

Binary Calculator Use it for some calculations involving two components only. It 
is like a combination of System Definer and Equilibrium 
Calculator activities with adaptations to simplify the 
configuration of calculations on binary systems.  

To perform this activity, you need a database designed 
for the Binary Calculator, such as the TCBIN database.  

Ternary Calculator Use it for some calculations involving three components. It is 
like a combination of System Definer and Equilibrium 
Calculator activities with adaptations to simplify the 
configuration of calculations on ternary systems.  

To get a reliable result you need a database that fully 
assesses binary and ternary systems.  

Scheil Calculator Perform Scheil-Gulliver calculations (also known as Scheil 
calculations). A default Scheil calculation is used to estimate 
the solidification range of an alloy assuming that i) the liquid 
phase is homogeneous at all times and ii) the diffusivity is 
zero in the solid. However, it is possible to disregard the 
second assumption for selected components.  

Experimental File 
Reader 

Read experimental data files (*.EXP). This type of file contains 
information specifying a plotted diagram, written in the 
DATAPLOT graphical language. For more information about 
DATAPLOT, search the online help or refer to the DATAPLOT 
User Guide. 
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 Project and Activity Menus 

When working in the Project window you can right-click nodes to open menus 
with the available actions. For example, click the My Project node to open the 
menus shown in Figure 7. Most nodes in the tree have a common menu as 
shown in Figure 8, with differences due to placement in the tree and the 
activity type. 

 
Figure 7: Menu options available for the My Project node. 

 
Figure 8: An example of the common menu for other activities. 

Menu Options for Activities 

Option Description Action (s) 

Create New 
Activity 

Add System Definer, Binary 
Calculator, Ternary Calculator, and 
Experimental File Reader nodes.  

Right-click My Project and 
from the Create New Activity 
menu choose an option. 
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Option Description Action (s) 

See Creating Activities and 
Successors. 

Create New 
Activity → Use 
Template 

Choose from the available 
templates to use the Wizard or add 
predefined nodes.  
See Creating a Project from a 
Template. 

Right-click My Project and 
from the Create New Activity 
→Use Templates menu 
choose an option. 
The templates are also 
available on the Configuration 
window, which you can access 
by clicking the My Project 
node, or from the Window 
menu. 

Create New 
Successor 

Add a successor to the selected 
node. Options are System Definer, 
Equilibrium Calculator or Scheil 
Calculator. 
See Creating Activities and 
Successors. 

Right-click one of these nodes 
System Definer, Property 
Model Calculator, Equilibrium 
Calculator, Binary Calculator, 
Ternary Calculator or 
Experimental File Reader, and 
from the Create New 
Successor menu choose an 
option. 

Add a 
Predecessor 

Add a predecessor to the selected 
node.  

Right-click a node to add a 
predecessor to it (when 
available). 

Perform Now 
or Perform 
Later 

Perform a calculation or create a 
plot or table immediately, or 
schedule it for a time in the future. 
See Using the Scheduler. 

Right-click any node. 

Rename Change the name of the node. Right-click any node. 

Remove Delete the selected node from the 
tree. 

Right-click any node except 
My Project. 

Clone Duplicate the selected node and 
add it to the same tree. See 
Cloning Activities and Trees. 

Right-click any node except 
My Project. 

Clone tree Duplicate a tree and add it to My 
project. 

Right-click any node except 
My Project. 

Apply Auto 
Layout 

Apply an automatic layout to the 
nodes in the tree. 

Right-click any node. 

Snap to Grid Snap a node to align it with the 
grid. See Moving Nodes in the Tree 
and Using the Grid. 

Right-click any node. 

Show Grid Turn the grid on or off in the 
Project window. 

Right-click any node. 

Zoom In, 
Zoom Out, 
Reset Zoom 

Zoom in and out of the Project 
window or reset the zoom to the 
default. 

Right-click any node. 
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 Moving Windows 

The windows in Thermo-Calc can be fixed or free-floating. When fixed, it can 
also be set to auto-hide, where the window is minimized if you select another 
window. The minimized window is then shown either along the bottom or side 
of the Thermo-Calc window. A free-floating window is shown on top of the 
other windows and can be moved outside the frame of the Thermo-Calc 
window. 

By default, the windows are fixed and open, except the Event Log window, 
which is set to auto-hide by default. 

To return to the standard desktop layout, from the main menu, select 
Windows → Reset Windows. 

Floating, Hiding and Minimizing Windows in the GUI 

For each window you can rearrange, resize, minimize and close it. At the top 
right corner are the buttons listed in the table. 

Button(s) Description 

    Click to toggle on/off free-floating 

   Click to toggle on/off auto-hide. 

 Click to minimize an open window that has auto-hide turned on.  
The window automatically minimizes if another window is selected.  

 Click to close the window. You can open the window again from the 
Window main menu. 

 Moving Nodes in the Tree and Using the Grid 

In the Project window, you can work with the activity nodes in these ways. 

• Click an activity node to select it.  
• To select several activities, hold down <Ctrl> while clicking on the nodes 

you want to select.  
• Click and hold the mouse button and draw a square around the activity 

nodes to select. Both the name and the icon that represents an activity 
must be within the square. 

 
• To move activities, click and hold the activity node and move the cursor. 
• Zoom in and out with the mouse scroll wheel.  
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• In the Project window right-click and select Zoom In or Zoom Out. To go 
back to the default zoom, select Reset Zoom. 

• To show a grid of light-grey cross-hairs overlaid on a project (see Figure 9), 
click Show Grid in the toolbar. Click the button again to turn the grid off. 
Or right-click in the Project window and select Show Grid. 

• Click Snap to Grid in the toolbar or right-click in the Project window and 
select Snap to Grid to automatically position each activity in the Project 
window at a cross-hairs point in the grid. 

 
Figure 9: The project window with the grid turned on and activity nodes moved from the default 
location. These nodes are snapped to the grid. 

 Node Status Markers 

Status markers indicate whether an activity is ready to be performed, is being 
performed, or has been performed. The markers are overlaid on the activity 
icons in the Project window. The status markers are displayed on a System 
Definer icon. 

Node Status Markers for the Project and Scheduler Windows 

Window Status 
marker 

Description 

Project 
window  

No status marker means the activity is ready to be performed (it 
has not been performed).  

 

A yellow triangle means the activity cannot be run. The 
necessary configurations for the activity may not be set or other 
prerequisites are not met. 

 
A green disc means the activity is performed. 

 
A red circle with a dial (a clock face) means the activity is 
currently being performed. 

Scheduler 
window  

No status marker means the activity (the job) is scheduled to be 
performed (the job has not started). 

 
A yellow triangle means there an error happened during the 
activity job.  

 
A green disc means the activity (the job) performed successfully. 

 
A green right-facing arrow means the activity (the job) is being 
performed. 
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4. Graphical Mode Projects 
This section describes how you create, perform and link activities. 

• The Quick Start Wizard 
• Creating a Project from a Template 
• Cloning Activities and Trees 
• Performing Projects, Trees and Activities 
• Using the Scheduler 
• The Event Log 

 The Quick Start Wizard 

Even before you understand how to work with Thermo-Calc projects, the Quick 
Start wizard helps you set up a project and run calculations in Graphical Mode. 
You can set up, calculate and visualize any of the following: 

• Single point equilibrium 
• Property diagram 
• Phase diagram 
• Scheil solidification simulation 

4.1.1 Creating a Project with the Quick Start Wizard 
To set up, perform and visualize a calculation using the Quick Start wizard: 

1. In the Configuration window click Quick Start. If you cannot see the Quick 
Start button, first click My Project in the Project window. 

 
2. In the Select Project Type window click to select the type of calculation to 

perform. Single point equilibrium, Property diagram, Phase diagram or 
Scheil solidification simulation. Click Next. 
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3. In the Define System window, choose an available Database. 

 
4. Click to select Elements check boxes to include as system components. To 

add elements from an existing material file, click the Material file button 
to enter the file path to a material file or click the Select Material File 
button (to the right of the field) to navigate to a file on the computer. 

5. Click Next. 

6. The Select Conditions window has different options depending on the 
Project type and the elements selected.  

• In this example figure, using a Single Point Equilibrium, choose the 
Composition unit and under Condition Definitions specify the values of 
the state variables in the system. 

 
• For a Property diagram or Phase diagram, specify the Axis Definitions of 

the stepping or mapping operation. Choose minimum and maximum 
values for the variable(s) (select Linear – min no. of steps, Linear – max 
step size or Logarithmic –scale factors) and whether it is Normal or 
Separate phases. 

• For a Scheil solidification simulation, and where applicable, select Fast 
diffuser to account for back-diffusion of any fast-diffusing elements.  

7. Click Finish. 

8. Click to expand the Event Log window to see information about the 
progress of the calculation. 

 



Thermo-Calc User Guide 
Version 2015b 

39 | Graphical Mode Projects 

9. The diagram is plotted in a Plot Renderer tab in the Results window. If you 
have calculated a single-point equilibrium, then a Table Renderer tab 
shows information about the equilibrium. 

 
10. To save the project, click Save on the main toolbar. To save a diagram or 

table, right-click the diagram or table and select Save As. 

 Creating a Project from a Template 

Use a Template to create all the activities for a certain type of calculation. In 
the Project window click the My Project node to display the templates in the 
Configuration window as in Figure 10. 

 
Figure 10: The templates section in the Configuration window. 

When you click a template, an activity tree is added to the Project window. 
You can then configure and perform the activities or the project.  

For example, if you click Property Diagram, a tree is added to the My Project 
node with System Definer, Equilibrium Calculator and Plot Renderer nodes. 
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You can also select templates from the Project window. Right-click the My 
Project node and choose templates from the Create New Activity → Use 
Template submenu. 

 

 Cloning Activities and Trees 

As discussed in Creating Activities and Successors, you can clone a single 
activity or the selected activity and all the activities that come after it 
(successors). The predecessor of the selected activity also is the predecessor of 
the clone.  

Cloned activities are configured exactly like the activities that they were cloned 
from, and any results of calculations or plots are also cloned. To clone a 
selected activity, right-click the activity and select Clone. 

For example, if you clone the Equilibrium Calculator in this project the result is 
an Equilibrium Calculator 2 created as a successor to System Definer 1: 

 
Figure 11: Cloning an Equilibrium Calculator activity node. 

The following applies to clones. 

• The new Equilibrium Calculator has the same settings for conditions, 
functions and options as its Equilibrium Calculator 1 clone.  

• If the Equilibrium Calculator is already performed, then the calculation 
results are cloned. 

• If the activity is a Plot Renderer or a Table Renderer, then the plot or table 
is cloned.  

• If you want to clone all the successor activities that follow a selected 
activity, then right-click and select Clone Tree instead. 
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4.3.1 Equilibrium Calculator Clones and Successors 
If you create an Equilibrium Calculator as a successor to another Equilibrium 
Calculator, then the successor inherits all the settings for conditions, functions 
and options from its predecessor. In this respect, it is similar to a clone.  

 The Equilibrium Calculator successor is different from a clone in that it 
does not inherit any calculated results and it is a successor to the Equilibrium 
Calculator instead of a successor to its predecessor.  

The calculated result from an Equilibrium Calculator that is the predecessor to 
another Equilibrium Calculator is the starting value for the latter’s calculation. 
The clone of an Equilibrium Calculator on the other hand, does not receive any 
data as input from the Equilibrium Calculator that it is cloned from. 

 Performing Projects, Trees and Activities 

You can trigger the performance of an activity (also called a job) and all the 
activities below it in the same tree in either the Project or Configuration 
window. In the Project window you can also perform a single activity without 
performing its successors or perform the whole project (all the activity trees).  

In the Configuration window, click Perform Tree to perform the currently 
selected activity and all the activities below it. If there are no activities below 
the selected activity, then the button says Perform instead. 

 All activities that must be completed as prerequisites are automatically 
performed first. For example, if you Perform Tree for a Plot Renderer, then the 
predecessors, Equilibrium Calculator and System Definer, are automatically 
performed before the Plot Renderer. 

 
In the Project window, you can do any of the following: 
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• Perform an activity: Right-click the activity and select Perform Now, or 
Perform Later and schedule a time to perform the activity.  

 
• Perform an activity and all activities below it in the tree: Right-click any 

node in the tree and select Perform Tree Now. Or select Perform Tree 
Later and schedule a time for all activities in the tree to be performed. 

• Perform a project: Right-click My Project and select Perform Now or 
Perform Later and schedule a time to perform all project activities in the 
tree. 

If there is an error during the performance of an activity, icons display 
status markers, which are described in Node Status Markers. 

 Using the Scheduler 

The Scheduler window has activity information about current or scheduled 
jobs. A job is any activity you have selected to be performed. The Scheduler 
also indicates if there is an error during a job and when a job has stopped. If 
you have set an activity, tree or project to be performed at a later time then 
this is also listed.  

The following applies to jobs. 

• Whenever you trigger the performance of a whole project, tree or 
individual activity, all the activities to be performed are shown under a job 
heading. 

• When all the activities belonging to a job are completed the job and its 
activities disappear from the Scheduler window.  

• If there is an error during the performance of an activity, icons for that job 
and activity remain in the Scheduler window until removed.  
 Also see Node Status Markers. 

 
Figure 12: An example of a list of scheduled jobs. 
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4.5.1 Managing the Schedule 
In the Scheduler window, you can cancel scheduled jobs, remove errors and 
show information about errors. 

• To cancel all jobs, right-click the Scheduled Jobs label or the cogwheel 
icon, and select Cancel All Jobs. 

• To remove (clear) all failed activities and jobs, right-click the Scheduled 
Jobs label or the cogwheel icon, and select Clear All Errors. 

• To cancel a specific job, right-click the job label (for example, Job no 1) and 
select Cancel Job. 

• To remove (clear) a specific failed job, right-click the job label (for example, 
Job no 1) and select Cancel Job. 

• To open a window with error details, right-click the label for the failed job 
(for example, Job no 1), and select Show Error Log. 

 The Event Log 

The Event Log window is closed by default. Click the Event Log window once to 
expand it or select it from the Window →Event Log menu. Double-clicking the 
window maximizes the window. 

Information about what Thermo-Calc is processing or doing is in blue text and 
error or warning messages are in red text. 

To specify the level of detail in the Event Log window, from the main menu 
select Tools → Options. In the General tab set the Log level slide bar to 
anything between Debug (most detailed) and Error (least detailed).  

 Also see Changing Global Settings. 

 
Figure 13: An example of an Event Log with information, warnings and errors. 



Thermo-Calc User Guide 
Version 2015b 

44 | Graphical Mode Activities  

5. Graphical Mode Activities 
This section describes the activity types and has instructions for procedures 
tied to specific activities. 

• System Definer 
• Property Model Calculator 
• Equilibrium Calculator 
• Plot Renderer 
• Table Renderer 
• Experimental File Reader 
• Binary Calculator 
• Ternary Calculator 
• Scheil Calculator 

 System Definer 

In a System Definer activity, you select the database to use to retrieve 
thermodynamic data and define which elements the system has as 
components. You can also select which species to include as well as change the 
reference temperature and pressure for your components.  

Also see Creating Activities and Successors for a list of possible successors and 
predecessors for this activity. 

 
Figure 14: An example of a System Definer Configuration window with a TCFE8 database selected 
by default. 
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5.1.1 The System Definer Settings 
Choose Database(s) or a Database Package 

 
At the top of the Configuration window you can choose to add one or more 
databases by clicking the Add a database  button. You can also choose a 
predefined or custom database package from the Package list. Depending on 
your license, there are predefined database packages available to select. 

You can also click Remove this database  button as required.  

If you have chosen a database and then remove or change a database, a 
message displays Selected databases and selected package may differ. This 
means that the original package you selected, which added preset databases, 
does not match the databases you are using for the project.  

 Also see Clearing a Database Package Message. 

There are several settings tabs available for the System Definer activity. 

 
The following example uses the FEDEMO and MFEDEMO databases and 
Example 12 available with the Graphical Mode Examples. 

 

Elements 

On the Elements tab, and based on the databases or database package 
selected, you can select and review elements using a Periodic Table or 
Alphabetic List format. Unavailable elements are greyed out on the Periodic 
Table view. 

 
Figure 15: Periodic Table view with available elements for both selected databases. In this 
example, using the demonstration databases FEDEMO and MFEDEMO, there are only a select 
number of elements to choose from. 
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Figure 16: Alphabetic List view with the available elements listed. 

On the Periodic Table page, you can also define the material composition: 

 
At the bottom of the window, click Load material to open a material file. Click 
Save material as to save the material you defined, for example Ferritic.  

If you Load a material file and then change the composition, a message 
displays The composition has changed. This means that the original 
values/composition does not match the values you are using for the project. 
The message is cleared by either reloading the material file or editing the 
composition field to the original value. 

Species 

On the Species tab for each database you can select and edit the Species.  
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At the bottom of the window, click Add new species and enter the name of 
species in the field. 

. 

Phases and Phase Constitution 

 
At the top of the Phases and Phase Constitution tab for each database, you 
can review and edit the Status (Entered or Dormant) for the selected Phases. 
Select the Check/uncheck all check box to toggle between the options. 

To review the Phase constitution for a specific phase, click it in the Phase list 
(for example BCC_A2) and its details are displayed at the bottom of the 
window. Click Edit then click an element to select or reject a constituent. The 
last remaining constituent on a sublattice cannot be rejected. 
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Components 

The Components tab is where you can review and edit the Component, 
Reference phase, Reference temperature, and Reference pressure. Click to 
toggle the SER (Stable Element Reference) check box on and off. Then choose a 
Reference phase from the list and edit accordingly. 

 
Data Sources 

Data sources are not available until the activity has been performed. Click 
Perform Tree to display available data sources.  

 
Description 

The Description tab displays a description of the selected database(s). In this 
example, MFEDEMO. 

 

5.1.2 Creating a System Definer Activity 
This section describes how to define a system; specifically how to select one or 
more databases and define the elements in the system.  

 Also see Databases. 

1. Right-click My Project and from the menu select Create New Activity → 
System Definer. 

2. In the Project window, click the System Definer activity node. 
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3. In the Configuration window, from the Databases menu Choose 
Database(s) or a Database Package. Options are to: 

• Select <User database> to define your own.  

• You can choose to add one or more databases by clicking the Add a 
database  button.  

• From the Package list, choose a predefined database package to add 
multiple databases at a time. Depending on your license, there are 
predefined database packages available to select. 

 To change the default database or create a database package, see System 
Definition (System Definer) and Creating a Database Package. 

4. Select the Elements tab to choose the elements in the Periodic Table or 
use the Alphabetic List to choose elements for the system. 

5. As required click the tabs to make edits: Species, Phases and Phase 
Constitution, and Components. 

 The Data Sources and Description tabs provide information as indicated 
and based on the database. 

6. Click Perform to start the System Definer activity immediately and retrieve 
thermodynamic data about the system. Click the Event Log window to 
watch the progress of the job.  

 Property Model Calculator 

A Property Model Calculator allows you to predict and optimize material 
properties. A set of general models is available to use: a Phase Transition 
Model, Driving Force Model, Interfacial Energy Model, Coarsening Model, and 
an Equilibrium Model.  

You can evaluate models simultaneously over a range of compositions and 
cross plot the results. You can then conduct an uncertainty analysis and plot 
the results as either a histogram or as a probability plot. The Configuration 
window for a Property Model Calculator using the Phase transition model is 
shown in Figure 17 and described in Defining the Property Model Calculator. 
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Figure 17: An example of a Property Model Calculator Configuration window. 

5.2.1 Property Model Calculator Workflow 
When a project is first being designed, it is recommended you test it by first 
performing a Single calculation type. This verifies that the configuration of the 
model is valid, otherwise you will get a Not a Number result in The Event Log 
window indicating the calculation did not work correctly.  

 Also see Defining the Property Model Calculator. 

Once the Single calculation type performs successfully, you can experiment 
with other calculation types such as Grid, Min/Max or Uncertainty. Best 
practice for both Grid and Uncertainty is to start with a small number of steps 
(Grid) or samples (Uncertainty) to confirm that it works before increasing the 
number of steps or samples.  

In general, the workflow for the different models will differ. A recommended 
start point is to do a Property Diagram calculation to determine what phases 
you get and where the transitions are before setting up the Property Model 
Calculator. You can create a Property Diagram using the Quick Start wizard or a 
template.  
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 Also see The Quick Start Wizard and Creating a Project from a Template. 

 For examples using the Property Model Calculator, see examples 10, 11, 
and 12 in Graphical Mode Examples. 

5.2.2 Defining the Property Model Calculator 
1. From the left side of the Configuration window, click to select one or more 

of the check boxes under the General Models folder. 

A tab with the same name as the property model opens in the right side of 
the window under Condition Definitions. When you select more than one 
model, a matching tab is added in the same order that the check box is 
selected. 

 
2. Enter the settings described in the following table for the Condition 

Definitions and for each Calculation Type (Single, Grid, Min/Max, and 
Uncertainty). For each model on the Configuration tab, select or enter 
settings as required. Click the Description tab for more information about 
the model and refer to the individual sections for more details:  

• Phase Transition Model 

• Driving Force Model 

• Interfacial Energy Model 

• Coarsening Model 

• Equilibrium Model 

Property Model Calculator Configuration Settings 

Setting/Button Description 

Composition unit Choose a unit: Mass percent, Mole percent, Mass fraction or 
Mole fraction  

Condition Definitions Choose a unit (Kelvin, Celsius or Fahrenheit) and then enter 
a value for the Temperature and Composition.  
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Setting/Button Description 

The values entered in Condition Definitions are used as 
the start values for the different calculation types.  

Calculation Type Choose a calculation type: Single (no axes), Grid, Min/Max 
or Uncertainty.  
For the Single calculation type no further settings are 
required. The results from this calculation are displayed in 
the Event Log.  
Select a Grid to evaluate two axis variables of the selected 
quantities in the specified range and number of steps. 
The Min/Max calculation evaluates the property model(s) 
for all variations of the selected quantities at the given limits. 
The Mean field is as defined under Condition Definitions for 
the respective quantity. The total minimum and maximum of 
the model(s) results are shown in the Event log. 
The Uncertainty calculation evaluates the property model(s) 
where the values of the quantities are sampled from 
Gaussian distributions. The Mean field is as defined under 
Condition Definitions for the respective quantity. The result 
is visualized as a histogram or normal probability plot by 
adding a Plot Render activity. 

Grid Definitions For the Grid calculation type, define the two axes variables 
using the fields and menus: Quantity, Min, Max and Number 
of steps. The number of steps along with the minimum and 
maximum values for the axes define a grid. For each grid 
point the selected models are evaluated. 

Min/Max Definitions For the Min/Max calculation type, click to select the 
applicable check boxes under Quantity to enable or disable 
an axis. The Mean field is as defined under Condition 
Definitions for the respective quantity.  

Enter numerical values in the ∆Min/Max fields to evaluate 
the change to the quantity. The highest and lowest value of 
each selected model results are shown in the Event log. 

Sampling of Data 
from Gaussian 
Distributions 

For the Uncertainty calculation type, click to select the 
applicable check boxes under Quantity to vary this quantity. 
The Mean field is for the distribution function as defined 
under Condition Definitions for the respective quantity. 
∆Min/Max is the 95% confidence interval.   

 Also see About the Uncertainty Calculations. 

Sampling 
Parameters 

For the Uncertainty calculation type, choose a number of 
Standard deviations where you want to Truncate the 
distribution. Choose the Total number of samples.  

Also see About the Uncertainty Calculations. 
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About the Uncertainty Calculations 

The following example uses the Phase Transition Model and an Uncertainty 
Calculation Type to describe how the sampling of data is performed. The 
example (which is example 10 in Graphical Mode Examples) predicts the 
transition temperature to the unwanted brittle Sigma phase and shows how 
the temperature is influenced by changes to a steel alloy’s composition. 

The Uncertainty calculation in Thermo-Calc uses the values (the mean) 
entered for quantities in the Condition Definitions section as the starting point 
to estimate, within a certain probability, the true variation of the quantity.  

An example of a Gaussian distribution is shown in Figure 18. The mean is at the 
peak of the curve (labelled µ). The standard deviation (σ) is a plus and minus 
range, ±1σ, ±2σ or ±3σ, of the variance from the mean. 

 
Figure 18: Gaussian distribution, the 3-sigma rule (image by Dan Kernler, 
https://en.wikipedia.org/wiki/Normal_distribution#/media/File:Empirical_Rule.PNG). 

As long as the number of events (the sample size) is very large, then the 
Gaussian distribution function can be used to describe physical events. A 
Gaussian distribution is assumed to describe how each quantity varies in an 
uncertainty calculation.  

Creating a Histogram Plot 

In Thermo-Calc, the mean of the quantity’s distribution is defined in the 
Condition Definitions section. The Mean is then used in the Sampling of Data 
from Gaussian Distributions section (Figure 19) as the starting point for how 
much you want to deviate from this value. 

https://en.wikipedia.org/wiki/Normal_distribution#/media/File:Empirical_Rule.PNG
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Figure 19: The mean defined in Condition Definitions is used during the sampling. 

The values entered in the ∆ Min/Max fields are the resulting width of the 
distribution corresponding to the 95% confidence interval (approximately µ ± 
2σ) shown in Figure 18. This confidence interval means that approximately 
95% of the sampled values will fall within these limits.  

The default value for truncating the distribution is set at 3 standard deviations 
in the Sampling Parameters section. This is also where you set the Total 
number of samples. The default is 200. In order to maintain a Gaussian 
distribution for the varied quantities, this number should not be too low. 

 
You can experiment by varying the conditions and the number of samples to 
see the distribution results smooth out as is to be expected based on the 
Central Limit Theorem. For example, on the Plot Renderer the variable is set to 
measure the Composition of Ni. The initial sample size uses the default, 200, 
and then, as in Figure 20, the sample size is increased to 300, 400, 600, 800, 
and 1000 to show how the plot follows the Gauss distribution. 
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Figure 20: An example of the uncertainty calculations sampling data from Gaussian distributions. 
This is a series of histogram plots comparing the Ni composition where the total sample size is 
increased to show how the model follows the Gauss distribution.  

Normal Probability Plot 

You can also plot the results as a Normal probability as shown in Figure 21.  

The normal probability plot is a technique used to graphically assess whether a 
data set is close to being normally distributed. The data set is compared to a 
theoretical normal distribution and then both results are plotted in the same 
graph. As long as the points approximately form a straight line, the data set is 
considered to be normally distributed.  

Continuing with this example, on the Property Model Calculator Configuration 
window the X-Axis variable is plotted as Mass percent Ni and the Y-Axis 
variable is plotted as the Normal probability.  
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Figure 21: An example of the uncertainty calculations sampling data from Gaussian distributions. 
This is a normal probability plot comparing the Ni composition where the total sample size is 
200. The sampled data (blue line) closely follows the ideal normal distribution (red line). 
Deviations are naturally larger at the tails (≈1%Ni and ≈2%Ni) since the number of samples are 
fewer there compared to the center of the distribution.   

5.2.3 Phase Transition Model 
By varying set conditions, the Phase Transition model calculates the point 
when a new phase may form. The model is useful to determine melting 
temperature, boiling temperature or solubility limits. It returns the phase 
transformation temperature, or composition, depending on the varied 
condition. Define the: 

• Matrix phase - The single phase region to start in. Select 'Any phase' to use 
the phases that take part of the initial equilibrium or choose a specific 
phase. 



Thermo-Calc User Guide 
Version 2015b 

57 | Graphical Mode Activities 

• Phase to form - For the new phase to be formed, select 'Any phase' or 
choose a specific phase.  

• Condition to vary – Choose whether to vary a composition or temperature 
condition when calculating the phase transition. 

• Search direction - For the composition or temperature condition being 
varied, choose the Search direction to be in a Positive, Negative, or 
Positive and Negative direction. 

• Upper search limit and Lower search limit - These values also relate to the 
search direction, where an estimated change to the released condition 
implies where a new phase is expected.  

The start value (given in Condition Definitions) and phase transition point 
need to be within these limits, otherwise the model returns Not a Number 
as result. For example, a start temperature is 1100 K then the limits need 
to be outside these, e.g. 500-1500. 

 For an example of a phase transition model, see example 10 in Graphical 
Mode Examples. 

5.2.4 Driving Force Model 
The Driving Force model calculates the thermodynamic driving force for a 
phase. 

• Matrix phase: Choose a Matrix phase, the single phase region to start in. 
Select 'Any phase' to use the phases that take part of the initial equilibrium 
or choose a specific phase. 

• Precipitate phase: Choose a Precipitate phase to calculate its driving 
force. 

The calculation result is the driving force divided by RT. 

 For an example of a driving force model, see example 12 in Graphical 
Mode Examples 

5.2.5 Interfacial Energy Model 
Use the Interfacial Energy model to estimate the interfacial energy between a 
matrix phase and a precipitate phase using thermodynamic data from a 
CALPHAD database. The approximation model is based on Becker's bond 
energy approach and is also available in TC-PRISMA. In the actual calculation, 
the coefficients taken distinguish between only bcc and fcc structure for the 
(110) and (111) lattice plane, respectively.  

For other planes and/or other phases, the estimate is approximate. In most 
situations, it is recommended to perform calibrations against some 
experimental data because the interfacial energy is dependent on so many 
factors that are ignored in the estimation, for example entropy, incoherency, 
orientation, and curvature, etc. Uncertainty factors must also be considered as 
thermodynamic data in CALPHAD databases are not always accurate.  

Select the Matrix phase and Precipitate phase to return the interfacial energy 
[J/m2]. 
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 For an example of an interfacial energy model, see example 11 in 
Graphical Mode Examples 

Estimation of Coherent Interfacial Energy 

Interfacial energy is an important parameter used in precipitation simulations 
to calculate the rates of nucleation, growth/dissolution, and coarsening. The 
value of interfacial energy can vary dramatically (usually between 0.01 to 2.0 
J/m2). 

The extended Becker’s model functions to estimate coherent interfacial energy 
by using thermodynamic data from existing CALPHAD thermodynamic 
databases:  

Eq. 1 
σ = ∆s s

c s
A l

n z E
N z  

where σc is the coherent interfacial energy, ns is the number of atoms per unit 
area at the interface, zs is the number of cross bonds per atom at the interface, 
zl is the coordination number of an atom within the bulk crystal lattice, and ∆Εs 
is the energy of solution in a multicomponent system involving the two phases 
being considered. 

Reference 
Becker, R., Die Keimbildung bei der Ausscheidung in metallischen 
Mischkristallen, Ann. Phys. 424, 128–140 (1938). 

5.2.6 Coarsening Model 
The Coarsening model calculates the coarsening rate coefficient K (m3/s) of a 
spherical precipitate phase in a matrix phase. 

• Matrix phase: Choose the Matrix phase. 

• Precipitate phase: Choose a Precipitate phase to calculate its 
coarsening rate. 

Returns the coarsening rate coefficient [m3/s] for the precipitate phase 
and the interfacial energy [J/m2] between matrix and the precipitate 
phase. 

 This model requires that the thermodynamic and kinetic databases used 
include descriptions of molar volume of the matrix and precipitates as well as 
mobilities for the matrix phase. 

 For an example of a coarsening model, see example 11 in Graphical Mode 
Examples. 

Particle Coarsening  

In the coarsening regime where the driving force is capillarity, the change of 
mean particle radius evolves according to the equation: 

Eq. 2 𝑟̅𝑟3 − 𝑟̅𝑟03 = 𝐾𝐾𝐾𝐾 

Following Morral and Purdy, the rate constant of precipitating β phase in a 
multicomponent α phase is 
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Eq. 3 𝐾𝐾 = 8𝜎𝜎𝑉𝑉𝑚𝑚
𝛽𝛽
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The mobility matrix M is not the same as the mobilities that can be obtained 
directly from DICTRA. The M matrix instead corresponds to the L’’ matrix as 
defined by Andersson and Ågren. 

Using the u-fractions that is defined as 

∑
∈

=

Sj
j

k
k x

xu  

where the summation only is performed over the substitutional elements give 
the final equation for the coarsening rate coefficient.  

Eq. 4 𝐾𝐾 = 8𝜎𝜎𝑉𝑉𝑚𝑚
𝛽𝛽
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The interfacial energy 𝜎𝜎 is calculated using the extended Becker’s model (that 
also is available as a separate Property Model Calculator model) 

References 
• Morral, J. E. & Purdy, G. R. “Particle coarsening in binary and 

multicomponent alloys,” Scr. Metall. Mater. 30, 905–908 (1994). 
• Andersson, J. & Ågren, J. Models for numerical treatment of 

multicomponent diffusion in simple phases. J. Appl. Phys. 72, 1350–1355 
(1992). 

5.2.7 Equilibrium Model 
The Equilibrium model calculates the equilibrium for the given conditions. 
Optionally define additional Function Definitions. All quantities that normally 
can be obtained from an equilibrium calculation can also be obtained when 
plotting the results, as well as the defined functions.  

 Equilibrium Calculator 

An Equilibrium Calculator allows you to set the conditions for, and perform, a 
calculation. The Configuration window for an Equilibrium Calculator has these 
tabs (Figure 22): 

Conditions: Set the conditions for your calculation that define the stepping or 
mapping axis variables. This tab can be viewed in a simplified mode and in an 
advanced mode.  Also see Setting Equilibrium Calculator Conditions, 
Setting Conditions for Simplified Mode, and Calculating with a Fixed Phase 
(Advanced Mode). 
• Functions: Define your own quantities and functions, which you then can 

calculate and plot.  Also see Calculating and Plotting Functions. 
• Options: Modify numerical settings that determine how equilibria are 

calculated, as well as how stepping and mapping calculations are 
performed. 
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 Also see Creating Activities and Successors for a list of possible successors 
and predecessors for this activity. An Equilibrium Calculator that is the 
successor of another Equilibrium Calculator inherits all the Configuration 
window settings of the predecessor. 

For an example of how serially coupled Equilibrium Calculators can be 
used, see example 6 in Graphical Mode Examples. 

The Options tab is where you can locally define specific Equilibrium 
Calculator settings. These are the same settings described in the Changing 
Global Settings section, Calculation (Equilibrium Calculator). 

 
Figure 22: An example of an Equilibrium Calculator Configuration window. 

5.3.1 Setting Equilibrium Calculator Conditions 
Conditions and axis variables for the Equilibrium Calculator are set in the 
Conditions tab of the Configuration window (Figure 22). The tab can be viewed 
in two modes: simplified (the default) or advanced. 

 The conditions to set depend on the type of calculation. For examples of 
how to set up different calculations, see Graphical Mode Examples:  

• Example 1 is a single-point equilibrium calculation;  
• Example 2 is a stepping calculation;  
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• Example 5 is a mapping calculation. 

In advanced mode, you can add and remove conditions as well as set 
additional axis definitions. However, the number and types of conditions set 
must still conform to the Gibbs’ phase rule. The Number of missing conditions 
is field, at the top of the tab shows how many conditions that you have left to 
set. If the number is negative, then that number of conditions need to be 
removed.  

5.3.2 Setting Conditions for Simplified Mode 
The following table briefly describes what you can set on the Conditions tab in 
simplified mode. Click Switch to advanced mode for more options. 

 

Conditions Tab, Simplified Mode Settings 

Setting or condition Options 

Composition unit Choose from Mass percent, Mole percent, Mass 
fraction or Mole fraction  

Condition Definitions Specify the values (and units) of the state variables: 
Temperature, Pressure, and System size. 

Calculation Type Single equilibrium (no axes), Property diagram, 
Property grid or Phase diagram. 
For the Single calculation type no further settings 
are required. The results from this calculation are 
displayed in the Event Log.  

Axis Definitions Property diagram: Define the axis variable using 
these fields and menus: Quantity, Min, Max, Step 
division and Type.  
Property grid: Define the two axis variables using 
these fields and menus: Quantity, Min, Max and 
Number of steps. 
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Setting or condition Options 

Phase diagram: Define the two axis variables using 
these fields and menus: Quantity, Min, Max, Step 
division and Type. 

If the Equilibrium Calculator already has a Plot 
Renderer as a successor and you change the 
stepping/mapping quantities, then the quantities 
represented on the X- and Y-axis are automatically 
updated in the Plot Renderer. 

Number of steps (Property 
grid) 

Set a fixed Number of steps. The number of steps 
along with the minimum and maximum values for 
the axes define a grid. For each grid point an 
equilibrium is calculated. 

Type and Step division 
(Property diagram and Phase 
diagram) 

Type options: Linear - min no. of steps, Linear - 
max step size and Logarithmic - scale factor. 
For Linear - min no. of steps, the Step division value 
specifies a minimum number of steps that is 
calculated between the minimum and maximum 
value during the stepping/mapping operation.  
For Linear - max step size, the Step division sets the 
maximum size of each step. 
For Logarithmic - scale factor, Step division 
specifies the scale factor of a logarithmic function 
that distributes the steps from the initial 
equilibrium to the minimum and maximum values 
defined. 

5.3.3 Calculating with a Fixed Phase (Advanced Mode) 
This section describes how to use the advanced mode to set a phase to be 
fixed at a certain amount. This allows you to, for example, find out at what 
temperature a material starts to melt. If you set the phase to be fixed to liquid 
phase at zero amount, and do not define the temperature state variable, then 
you can calculate at what temperature the material enters a state where the 
liquid phase is no longer zero (that is, when it starts to melt).  

 For a fixed phase equilibrium calculation, it is recommended to serially 
couple the Equilibrium Calculators. This is where one Equilibrium Calculator 
activity is the successor to another Equilibrium Calculator activity that 
performs an ordinary equilibrium calculation, and then, for the condition you 
are interested in, you make a rough estimate of the value. This gives the fixed 
phase calculation better starting values. 

1. Right-click a node that can add an Equilibrium Calculator to your project. 
See Creating Activities and Successors for a list. 

2. In the Project window, click the Equilibrium Calculator activity node. 

3. In the Configuration window, click Switch to advanced mode (Figure 22).  

 If the Default calculation mode is globally set to Advanced then by 
default the Configuration window is already in advanced mode.  
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 Also see Changing Global Settings. 

4. Under Condition Definitions, click the Add quantity  button. 

5. Select Fix phase from the first menu. 

6. Select the phase that you want to fix in the second menu, and set the 
amount of that phase you want to fix the phase to. For example, if you 
want to know when your material starts to melt, set the phase to LIQUID 
and the value to 0.0: 

 
Above the condition definitions, the Number of missing conditions is field 
is probably -1. This means that you must remove one condition.  

7. To remove a condition, either click the remove  button, or click to clear 
the check-box. For example, if you want to know at what temperature 
your material starts to melt, then you cannot have a fixed temperature, in 
which case the temperature condition is not selected: 

 
The Number of missing conditions is field displays 0. When you have set 
all your conditions, you can perform the Equilibrium Calculator (now or 
later). 

5.3.4 Calculating and Plotting Functions 
The Functions tab allows you to define your own functions that can be plotted 
in a Plot Renderer.  

 For an example of how you can use functions that you yourself define, see 
example 7 in Graphical Mode Examples. 

1. Create an Equilibrium Calculator node and click it in the Project window.  

2. In the Configuration window click the Functions tab. 

3. Under Quantity Definitions, define Q1. Click the add  button to Add a 
new quantity. Then from the lists, choose the variable for each quantity to 
define. The quantities are called Q1, Q2, Q3 and so on. In this example, the 
quantity Q1 is defined as the Amount of phase, with No normalization, 
LIQUID in Mole units. 



Thermo-Calc User Guide 
Version 2015b 

64 | Graphical Mode Activities  

 
4. Under Function Definitions, click the add  button to add a new function. 

In the left field edit the default name of each function and enter the 
function itself in the right field after the equal sign. In this example, the 
quantity defined as Q1 is renamed to fraction_solid, which gives as its 
output the fraction of solid phase (1-Q1). 

You can also use Console Mode syntax when entering the function. For 
example, the function above can be entered as 1-NP(LIQUID). 

5. To plot the defined function, right-click Equilibrium Calculator and choose 
Create new successor →Plot Renderer.  

6. Click the Plot Renderer node. In the tab for the Equilibrium Calculator that 
contains the function, set an Axis variable to Function, then from the 
menu select the defined function. In this example the Y-axis is set to plot 
the value of the function fraction_solid. 

When run, the Plot Renderer plots the value of the function. 
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 Plot Renderer 

The Plot Renderer displays results from the various calculator activities 
(Equilibrium Calculator, Property Model Calculator, Binary Calculator, Ternary 
Calculator, and Scheil Calculator).  

The available Plot Renderer functionality varies by calculation type. For 
example: 

• For a Property Grid calculation type or a Plot Renderer Grid calculation 
type, you choose a Plot type: Contour or Heat map.  

• For a Property Model Calculator Uncertainty calculation type, you choose 
an Axis type: Frequency, Histogram or Normal probability. For other 
calculators (e.g. Equilibrium, Binary, and Scheil) there are different Axis 
types available such as Linear, Logarithmic, Logarithmic 10 and Inverse. 

The Plot Renderer is used to set the plotting axis variables for a property 
diagram and phase diagram. If you are plotting a Property grid (Equilibrium 
Calculator) or Grid (Property Model Calculator) then the X- and Y-axes always 
represent the quantities that define the stepping axes, but you need to set a 
variable for the Z-axis (the axis perpendicular to the plane defined by the X- 
and Y-axes). 

 Also see Creating Activities and Successors for a list of possible successors 
and predecessors for this activity. The configurations that can be set in the 
Configuration window for a Plot Renderer vary depending on the kind of 
predecessor it is created from. 

Plot Several Calculations in One Diagram 

A Plot Renderer can have several predecessors (if you want to plot several 
calculations in the same diagram), in which case there are several tabs in the 
Configuration window, one for each predecessor. 

 For an example of a project in which several calculations are plotted in 
one diagram, see example 5 in Graphical Mode Examples. 

Several Plot Renderer activities (as well as Table Renderer activities) can be 
shown in the Results window as different tabs as in Figure 23 (from example 4 
in Graphical Mode Examples).  

 Also see Plotting Several Calculations in One Diagram. 
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Figure 23: Multiple tabs can be viewed in the Results window. 

Add Axes to Diagrams 

You can add additional X- and/or Y-axes to a plot to compare two or more 
variables at the same time as in Figure 24.  

 Also see Adding Axes to a Diagram. 
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Figure 24: Two variables plotted on the Y-axis. 

Merge Results in One Diagram 

You can merge (or overlay) calculated results for several variables into one 
diagram. This is similar to adding an axis, but instead of displaying different 
variables along the X- and/or Y-axes, the same X and Y variables are used to 
compare the third variable (defined in the Plot Renderer as the Z-axis). 

As in Figure 25 (from example 12 in Graphical Mode Examples), the driving 
force and interfacial energy results are combined into one diagram. The X and 
Y axis is the same for both (Mass percent Cr/Mass percent Mn).  

 Also see Merging Plots into One Diagram for details of how to combine 
diagrams. 
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Figure 25: A contour plot showing both the driving force and interfacial energy calculation results 
comparing Mass percent Cr to Mass percent Mn. 

5.4.1 Plot Renderer Configuration Window 
The Configuration window has different options available based on its 
predecessor. The following is an example of the Configuration window for a 
Plot Renderer that is the successor to an Equilibrium Calculator. The options 
along the top are available for most of the calculation types (e.g. phase 
diagrams, property diagrams, min/max, uncertainty and so forth). For an 
Equilibrium Property Grid calculation type and a Property Model Calculator 
Grid calculation you can choose a Plot type. 
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Plot Renderer Configuration Settings 

Setting/Button Description 

Save Diagram 

 

Save the plot diagram. 

Show Triangular 

 

Display the diagram in triangular form, with the X-axis along 
the base and the Y-axis along the left side. Such a diagram is 
often useful if you want to plot the fractions of two 
components in a ternary diagram. 

Show Grid 

 

Overlay a grid on the diagram. 

Switch Axes 

 

Show the plotting X axis variable on the diagram’s Y-axis, 
and the Y axis variable on the diagram’s X-axis. 

Retain Labels 

 

Toggle the default to keep labels displaying on the plot. By 
default labels are retained. 

Tie lines Select how many tie lines to be plotted in the diagram. 
Every nth number of tie line is plotted, where n is the 
number set here. Consequently, the higher the number, the 
fewer the number of plotted tie lines in the diagram. 

This setting is not available if the Plot Renderer is a 
successor to a Scheil Calculator or to an Equilibrium 
Calculator where only one axis is defined and varied (that is, 
an Equilibrium Calculator that has performed a stepping 
calculation).  

Legend option Select whether the diagram’s legend displays the Stable 
phases, the Axis quantity, or choose Off for no legend.  

Legend style You can select a Legend style for the Stable phases or Axis 
quantity selected for Legend option. Choose None, All, 
Constitution description, or Ordering description. 

 Also see About Legend Styles. 

Plot type (property 
grid or grid 
calculation types 
only) 

This menu is only available if the Plot Renderer is a 
successor to either an Equilibrium Calculator that is set up 
to calculate a property grid or a Property Model Calculator 
that is calculating a Grid.  
Choose either Heat map or Contour.  
On a heat map diagram, each equilibrium calculation in the 
grid is represented by a colour-coded pixel, where dark red 
represents the highest Z-axis variable value and dark blue 
represents the lowest Z-axis variable value. 
On a contour diagram, Z-axis variable values are traced with 
curves in different colours (in the same way that height 
values are traced with curves on a topographical map). 
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Setting/Button Description 

Axis variable  Set which state variable that you want plotted along the X-
axis and the Y-axis. 

If the stepping/mapping variables are changed in the 
Equilibrium Calculator that precedes the Plot Renderer, 
then the variables to be plotted along the diagram’s X- and 
Y-axis are automatically updated to the appropriate 
quantities. 

Axis type Select what type of scale to use on the axis. Options are 
based on calculation types. 
Choose between Linear, Logarithmic, Logarithmic 10, 
Inverse, Probability, or Histogram. 

Limits Specify the range along the axis that is shown in the plot by 
setting the minimum and maximum values of the axis 
variable. You can also determine the step size between the 
tick marks along each axis.  
Alternatively, select Automatic scaling. 

Add an axis  and 
Remove this axis  
buttons. 

Use these buttons to add additional X- and/or Y-axes to a 
plot or to merge plots (to overlay one plot with another in 
the same diagram). When merging plots, you define this 
variable as the Z-axis.  

 Also see Adding Axes to a Diagram and Merging Plots 
into One Diagram for details. 

Plot Status Marker 

If you have plotted a diagram and then modify something in the tree that the 
Plot Renderer is associated with, then a notification sign—an exclamation 
mark enclosed in a yellow triangle—is shown in the Plot Renderer’s tab.  

 Also see Node Status Markers. 

 

5.4.2 About Legend Styles 
There are a variety of legend styles you can use to display detail about the 
phases.  

The same legend styles are available for both Graphical Mode and Console 
Mode plots. For Console Mode, use the command CHANGE_LEGEND.  

 Also see the Thermo-Calc Console Mode Command Reference Guide.  

In Graphical Mode the label styles are defined when using the Plot Renderer. 
You can select a Legend style for the Stable phases or Axis quantity selected 
for Legend option. 

When there is a legend in the diagram you can append constitution and/or 
ordering descriptions to the phase name.  
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If constituent description is included in the legend, then for each equilibria 
along a line in the diagram, the largest constituent fractions are summed until 
they are equal or greater than 0.6. This is done separately for each sublattice. 
If the equilibria along the line gets different sets of constituents these are all 
appended to the list for that sublattice. 

The ordering description is only printed for partitioned phases (phases that 
have a disordered contribution) that begins with at least two identical 
sublattices (sublattices where the set of constituents are identical).  DISORD 
(disordered) is shown if site fractions are identical between identical 
constituents on all identical sub lattices (with an error margin) otherwise ORD 
(ordered) is shown in the legend. 

If ordering between equilibria in a line are different, then ORD + DISORD is 
shown in the legend. 

Legend Examples 

To show the differences between labels, the following uses the same example 
file that creates Figure 6 in TCNi8 database extended information document 
(found on the Thermo-Calc website 
http://www.thermocalc.com/media/23650/tcni8_extended_info_formatted_0
2.pdf). 

Figure 24 is a label that shows All available detail as follows:  

• There are two disordered FCC phases (matrix and carbide), one ordered 
FCC (gamma prime), plus a phase NI3TA_D0A (called Delta in Ni-alloys).  

• ORDERING shows the different FCC phases.  
• CONSTITUTION shows that FCC_L12#1 is NbC, FCC_L12#2 is matrix with Ni 

and Cr as major constituent, FCC_L12#3 is Ni3Al with Nb addition and 
NI3TA_D0A is Nb-rich (eg. Ni3Nb).  

 
Figure 26: An example of when All is selected to display all information. 

The following examples are for each label style choice. The instructions are for 
when you are setting the options using the Plot Renderer. In Console Mode, 
you choose the options (ALL, NONE, CONSTITUTION, or ORDERING) after the 
command CHANGE_LEGEND. 

When None is selected the legend includes the standard information about the 
phases. 

http://www.thermocalc.com/media/23650/tcni8_extended_info_formatted_02.pdf
http://www.thermocalc.com/media/23650/tcni8_extended_info_formatted_02.pdf
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When you select All the Constitution description and the Ordering description 
(when there is ordering) are included. 

 
When you select Constitution description, this is added to the standard 
description. 

 
When you select Ordering description and when there is ordering, this is 
added to the standard description. 

 

5.4.3 Adding and Editing Plot Labels  
To add a label text at a certain point in a plot, right click the point, and select 
Add Label.  

You can enter the label as Plain text or in LaTeX-formatted text. For LaTeX-
formatted text the chosen point name is added by default. Use the LaTeX 
math text to enter or edit the text as required. For example, underscores (_) 
are added before the numbers to make subscripts in the label.  

 For a list of supported LaTeX commands, see: 
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html 

http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
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The suggested label specifies the names of the stable phases at the coordinate 
where you clicked. By default the Show anchor check box is selected, which 
includes an arrow from the label point to the coordinates. 

If you do not want the label oriented horizontally in the Plot Renderer tab, 
then specify the number of degrees of rotation in the Rotation angle field. 

Click OK to add the label to the plot. You can also move the labels by clicking 
and dragging it. The default anchor arrow is added to indicate the point that 
belongs to the label. 

 

 
Figure 27: Drag and drop labels anywhere on the plot. The anchor arrow points to the point of 
origin. 

5.4.4 Changing the Plot Properties 
 For global changes to the default settings plots see Graphical and Console 

Mode-Plotting. The settings are the same but applied to all new plots. 

To make local changes to the appearance of a specific plot, in the Results 
window right-click a plot and select Properties. You can also edit some 
properties for individual plot lines (the color, the line width and type, and 
whether data points are included).  
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In the Results window, hover the mouse over a plot line. When it is over a line 
that can clicked the crosshair cursor turns into a pointing finger.  

 

 To prevent unintended edits, hold down <Ctrl> while moving the cursor 
around the plot to only display it as a crosshair. 

5.4.5 Saving Plots 
1. To save a diagram, at the top of the Configuration window click Save 

Diagram. 

 
Or right-click the diagram in the Results window and select Save As. 

2. In the Save window, navigate to where you want to save the plot, enter a 
File name, and choose the File type to save it in. Click Save. 

5.4.6 Plotting Several Calculations in One Diagram 
You can plot several calculations in the same diagram by adding extra 
predecessors to the Plot Renderer activity. 

To plot several calculations in one diagram, you must have, in addition to the 
Plot Renderer’s original predecessor, at least one available Plot Renderer 
predecessor in your project. The extra predecessor can be any of these: 
Equilibrium Calculator, Binary Calculator, Ternary Calculator, Scheil Calculator 
or Experimental File Reader. 

1. In the Project window click the Plot Renderer node.  

2. In the Configuration window click Add Predecessor. Or right-click the Plot 
Renderer and choose Add Predecessor. 
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3. Select a predecessor. When added, the extra predecessor is linked to the 
Plot Renderer. On the Plot Renderer’s Configuration window, the 
predecessors are shown as two tabs: 

 
4. Configure how you want each calculation plotted on the tabs in the 

Configuration window, then click to Perform the Plot Renderer activity. 

The calculations are plotted in the same diagram in a tab in the Results 
window. If any of the axis variables of the plots differ, then the label and 
scale of all calculations are shown parallel to each other. The following 
screen shot shows a diagram in which two calculations with different 
plotting axes variables have been plotted. 

 

5.4.7 Adding Axes to a Diagram 
You can add additional X- and/or Y-axes to a plot to compare two or more 
variables at the same time.  

1. In the Project window right-click the calculator node (e.g. an Equilibrium 
Calculator) and add a Plot Renderer node from the Create New Successor 
menu.  

2. Click the Plot Renderer node. 

3. In the Configuration window, define the plot. Available settings are based 
on the calculation type. 
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4. Click the Add an axis  button. A new axes settings section is added 
underneath. 

5. From the X Axis and/or Y Axis sections define another Axis variable and 
choose an Axis type. In this example Amount of phase and Volume are 
selected as the Y-axis variables and Temperature for the X-axis. 

 
6. Click Perform to plot both variables on the selected axis. 
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5.4.8 Merging Plots into One Diagram 
You can merge (or overlay) calculated results for several variables into one 
diagram. The same X and Y variables are used to compare the third variable 
(defined in the Plot Renderer as the Z-axis). 

You cannot overlay heat map or frequency plots. 

The following uses example 12 in Graphical Mode Examples to describe the 
steps to overlay two plots: the driving force and interfacial energy results are 
combined into one diagram. The X and Y axis is the same for both (Mass 
percent Cr/Mass percent Mn).  

1. In the Project window right-click the calculator node (e.g. a Property 
Model Calculator) and add a Plot Renderer node from the Create New 
Successor menu.  

2. Click the Plot Renderer node. 

3. In the Configuration window, define the plot. Available settings are based 
on the calculation type. 

In this example the Property Model Calculator is set to a Grid calculation 
type. Choose On for the Legend option and Contour as the Plot type. 
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4. Click the Add an axis  button. A new axes settings section is added 

underneath. 

5. From the Z Axis section choose the Axis variable. In this example, 
Interfacial energy. 
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6. Click Perform to plot both on the same diagram. In this case, a contour 
plot showing both the driving force and interfacial energy calculation 
results comparing Mass percent Cr to Mass percent Mn. 

 

 Table Renderer 

A Table Renderer visualizes calculation results in a table. Several Table 
Renderer activities (as well as Plot Renderer activities) can be shown in the 
Results window as different tabs. 

You can only successfully tabulate the results of a single-equilibrium 
calculation or a stepping operation. The tabulated data from an equilibrium 
calculation is different from the tabulated data from a stepping calculation. 

 Also see Creating Activities and Successors for a list of possible successors 
and predecessors for this activity. 

5.5.1 Tabulated Results from an Equilibrium Calculation 
The following tab shows the result of an equilibrium calculation (from 
example 1in Graphical Mode Examples). 
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For each stable phase listed, from the Composition and constitution menu you 
can select the information to view. In this example, the maximum amount of 
information is shown and includes details about both composition and 
constitution for BCC_A2#1. 

Setting Background Colours 

To change the background colours of the table, in the Results window right-
click a Table Renderer tab, and select Properties. Modify as required. 

 

5.5.2 Tabulated Results from a Stepping Operation 
The Table Render 1 tab in the example shows the results of a stepping 
calculation (from example 2 in Graphical Mode Examples). 
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5.5.3 Table Renderer Configuration Window Settings 

 

Defining the Table Columns 

In the Configuration window for the Table Renderer 1 node, set the level of 
detail for the Columns: 

Setting Number Format and Number of Decimal Digits 

The table results can be presented in ordinary decimal number format or with 
normalized scientific notion. The Number format menu defaults to Auto to use 
the most appropriate format based on the tabulated data. Or choose Scientific 
or Decimal to increase or decrease the number of Decimal digits used in the 
table. 

Saving Tabulated Data 

To save all the data in a table as a plain text file, in the Configuration window 
click Save table or in the Results window right-click in the table and select 
Save As. 

To copy the data from a single cell of a table to the clipboard, right-click the 
cell and select Copy. To copy the whole table to the clipboard, select Copy all. 

 The data saved is what is shown in the Table Renderer tab. If data is 
calculated but not displayed it is not saved. 

 Experimental File Reader 

The Experimental File Reader activity can only be created from the top My 
Project node. This activity allows you to read an experimental data file (*.EXP). 
This type of file has information specifying a plotted diagram, written in the 
DATAPLOT graphical language. For more information about DATAPLOT search 
the online help or refer to the DATAPLOT User Guide. 

 Also see Creating Activities and Successors for a list of possible successors 
and predecessors for this activity. 
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5.6.1 Plotting an Experimental Data File 
1. Right-click My Project and from the Create New Activity submenu choose 

Experimental File Reader. 

2. In the Configuration window in the EXP file field, enter the name of the 
EXP-file to plot. 

3. Click Create New Successor and select Plot Renderer. Or right-click the 
Experimental File Reader node and from the Create New Successor 
submenu choose Plot Renderer. 

4. In the Configuration window click Perform or right-click the Plot Renderer 
node and select Perform. 

 Binary Calculator 

A Binary Calculator can be used for some calculations involving two 
components. You can think of this activity as a combination of a System 
Definer and an Equilibrium Calculator, but designed to simplify setting up and 
performing calculations on binary systems.  

The Binary Calculator relies on some specifications that are not supported by 
all databases. You need a specially designed database for the Binary Calculator 
such as the TCBIN database. 

For an example of how a Binary Calculator can be used in a project, see 
example 3 in Graphical Mode Examples.  

 Also see Creating Activities and Successors for a list of possible successors 
and predecessors for this activity. 

5.7.1 Binary Calculator Configuration Window 
The following shows the Configuration window of a Binary Calculator activity: 
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Figure 28: An example of a Binary Calculator Configuration window. 

The table lists the available settings to configure before performing the 
calculation. 

Binary Calculator Configuration Settings 

Setting Description 

Select database Select a database that contains specifications dedicated 
to the Binary Calculator.  

Elements 
(periodic table) 

In the periodic table, select the two elements that make up the 
components of the system. 

Phases and Phase 
Constitution  

This tab is the same as for a System Definer.  

 Also see Phases and Phase Constitution for an example. 

Data Sources This tab is the same as for a System Definer.  

 Also see Data Sources for an example. 

Description This tab is the same as for a System Definer.  

 Also see Description for an example. 

Calculation Type 

Phase diagram Select to perform a mapping calculation. Click Calculate Phase 
Diagram to plot the results.  
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Setting Description 

Gibbs energy 
curves 

Select the Temperature and click Calculate Gibbs Energy 
Curves to calculate at a constant temperature over the whole 
composition range. 

Activity curves Select the Temperature and click Calculate Activity Curves to 
calculate at a constant temperature over the whole 
composition range. 

Phase fractions Select the Mole fraction and click Calculate Phase Fractions to 
calculate as a function of temperature at a constant 
composition. 

 Ternary Calculator 

A Ternary Calculator is used for some calculations involving three components. 
You can think of this activity as a combination of a System Definer and an 
Equilibrium Calculator, but designed to simplify setting up and performing 
calculations on ternary systems.  

For an example of how a Ternary Calculator is used in a project, see 
example 4 in Graphical Mode Examples.  

 Also see Creating Activities and Successors for a list of possible successors 
and predecessors for this activity. 

5.8.1 Ternary Calculator Configuration Window 
The following shows the Configuration window of a Ternary Calculator activity: 
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Figure 29:  An example of a Ternary Calculator Configuration window. 

The table lists the available settings that must be configured before performing 
the calculation. 

Ternary Calculator Configuration Settings 

Setting Description 

Select database Select a database that contains specifications dedicated to 
the Ternary Calculator.  

Elements (periodic 
table) 

In the periodic table, select the three elements that make 
up the components of the system.  

Phases and Phase 
Constitution  

This tab is the same as for a System Definer.  

 Also see Phases and Phase Constitution for an 
example. 

Data Sources This tab is the same as for a System Definer.  

 Also see Data Sources for an example. 

Description This tab is the same as for a System Definer.  

 Also see Description for an example. 

Calculation Types 

Isothermal section Select the Temperature at which the ternary system is 
calculated for the whole composition range.  
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Setting Description 

Monovariant lines The variation of the liquid compositions with temperature 
is calculated. 

Liquidus projection Select the Temperature range (Min and Max) and an 
Interval. The projection liquid surface and the 
monovariant lines are calculated over the given 
temperature range. 

 Scheil Calculator 

The Scheil Calculator activity is used to perform simulations of Scheil (Scheil-
Gulliver) solidification processes. By default, a Scheil calculation results in an 
estimation of the solidification range of an alloy. The calculation is based on 
the assumption that the liquid phase is homogeneous at all times and that the 
diffusivity is zero in the solid. However, it is possible to disregard the latter 
assumption for selected components. 

See example 8 in Graphical Mode Examples.  

 Also see Creating Activities and Successors for a list of possible successors 
and predecessors for this activity. 

By default, a Plot Renderer successor has the default plot axes Mole fraction 
of solid (X-axis) and Temperature Celsius (Y-axis). When these default axes are 
used in the Plot Renderer, the results of normal equilibria calculations are 
automatically plotted in the same diagram as the Scheil calculations. 

 Also see Scheil Simulations in the Console Mode section. 

5.9.1 Scheil Calculator Configuration Window 
The main Configuration window of a Scheil Calculator activity is shown below 
and listed in the table. These settings must be configured before performing 
the calculation. 

 
Figure 30: An example of a Scheil Calculator Configuration window. 
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Scheil Calculator Configuration Settings 

Setting Description 

Start temperature Enter a Start temperature that is higher than the liquidus 
temperature of the alloy, in other words, the temperature 
at which the alloy is completely melted. 

Temperature step Enter a Temperature step. Decreasing the temperature 
step increases the accuracy, but the default value is usually 
adequate. 

Temperature unit Select the Temperature unit: Kelvin, Celsius or Fahrenheit. 

Composition unit Select the Composition unit: Mass percent, Mole percent, 
Mass fraction or Mole fraction. 

Composition This is based on what is entered in the System Definer. 

Fast diffuser Click to select the Fast diffuser check box to allow 
redistribution of this component in both the solid and 
liquid parts of the alloy. 

Scheil Calculator Advanced Options 

Additional advanced settings are available as shown below and in the table: 

Click Show advanced options to open this configuration window: 

 
Scheil Calculator Advanced Settings 

Setting Description 

Global 
minimization 

By default the Global minimization check box is not 
selected. Click to select it to perform a global minimization 
test when an equilibrium is reached. This costs more 
computer time but the calculations are more robust.  

Allow BCC → FCC By default the Allow BCC→ FCC check box is not selected. 
Select the check box to allow transformations in the 
solidified part of the alloy caused by each of the 
components specified to be a fast diffuser. It is 
recommended that you only select this for steels. 
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Setting Description 

Liquid phase The default in the list is the Liquid phase already defined in 
the database. 

Composition mode Use this setting to choose the composition type (the mode) 
o store for post processing. This must be chosen before 
performing a simulation. 
The results of a Scheil Calculator activity are stored in the 
same workspace as the standard POLY-3 calculations. There 
are two composition types, segregated or average, that can 
be stored in this workspace. By default, it is stored in the 
workspace as a Segregated composition. Choose instead to 
save it as an Average composition so you can maintain the 
mass balance and evaluate several other quantities during a 
simulation. 

Terminate on Enter a value to terminate the calculation on the Fraction 
of liquid phase or at a specific Temperature. 
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6. The Console Mode Interface 
The following is an introduction to the Console Mode’s user interface and the 
command line prompt.  

 Also see The Graphical Mode Interface. 

• The Console Mode Layout 
• Console Window 
• Console Mode Results Window 
• Event Log Window 
• Console Mode Workflow 
• Performing Calculations in Console Mode 
• Using the Command Line Prompt 
• Moving Between Modules and Submodules 
• Entering Command Names or Abbreviations 
• Specifying Parameters 
• Wild Card Characters 
• Controlling Console Output 
• Command History 
• Log, Macro and Workspace Files 
• Log Files 
• Macro Files 
• Workspace Files 
• Main Menu Commands 
• Defining a System in Console Mode 

 The Console Mode Layout 

By default the first time you launch Thermo-Calc it opens in Graphical Mode. 
After this, the mode defaults to the most recent one. You can switch back and 
forth between modes. To open the Console Mode interface, click Switch to 
Console Mode on the toolbar.  

 
Figure 31: The Console Mode user interface with windows and tabs. 
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The currently selected window is called the active window. This has a darker 
title bar than the other windows. The windows shown in Figure 29 are: 

1. Console, with a Console 1 tab. 

2. Console Results, with a Results Console 1 tab as well as a sub-tab (Plot 1), 
which is what is displayed in the window in the figure. 

3. Event Log, which is the active window in this example. 

By default, the tabs are side-by-side: 

 
You can toggle to view the tabs top-to-bottom/stacked (click the  button) 
and back to side-by-side (click the  button) or the  button. 

 
Open a specific window from the Window main menu, or select Reset 
Windows to return to the default window layout.  

 Console Window 

By default the Console window is on the left-hand side of the console. This is 
where you enter commands. The window can have several Console tabs.  

To open and close Console tabs: 

• To open (or add), click the  button, press <Ctrl+T> when the Console 
window is active, or right-click a tab header and select New Console. 

• To close, click the  button, press <Ctrl+W> or <Ctrl+F4>, or right-click the 
tab header and select Close. 

• To close all tabs except one, right-click the header of the tab you want to 
keep and select Close Other. 

• To close all tabs and open a new one, right-click the header of any tab and 
select Close All. 

You can change the tab name, font and colours for an individual Console tab by 
right-clicking its header and selecting Properties.  

 Also see Console Mode-Default Appearance. 
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 Console Mode Results Window 

By default, the Console Results window is on the right-hand side of the screen. 
This is where plotted diagrams display. Each Console has its own Results tab in 
the Results window. All the plots and tables generated are presented in the 
Results tab.  

• To open new Plot tabs press <Ctrl+Shift+T> or click the add  button. 
• To open a new Plot tab for the currently active Console tab, press 

<Ctrl+Shift+T>. To close the Plot tab, press <Ctrl+Shift+W> or 
<Ctrl+Shift+F4>. 

 Event Log Window 

By default the Event Log is collapsed (closed). It includes important 
information about the commands that run and are completed, including error 
messages. Click once to toggle it open and closed. 

 Console Mode Workflow 

Working with Thermo-Calc involves moving between different modules. The 
workflow differs depending on the type of calculation:  

• If you want to perform a calculation using the POLY module, you typically 
first retrieve thermodynamic data in the DATA module, perform the 
calculation in POLY, and visualize the results in the POST module. See 
Typical POLY Module Workflow. (It is possible to define a system directly in 
POLY using DEFINE_MATERIAL and DEFINE_DIAGRAM). 

• If you want to calculate and plot a diagram using a response-driven 
module, such as POTENTIAL or SCHEIL, then you can go directly to that 
module. Response-driven modules prompt you to go through the steps to 
do the calculation and the required post-processing. These modules 
include BIN, TERN, POTENTIAL, POURBAIX, and SCHEIL. You typically end 
up in the POST module after having used a response-driven module. In the 
POST module you can modify the plots and save the diagram. 

• If you want to tabulate a chemical substance, phase, or reaction, go 
directly to the TAB module.  
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6.5.1 Typical POLY Module Workflow 
Figure 30 represent the typical workflow when you perform calculations in the 
POLY module. The solid arrows represent your typical movements between 
the modules. The dashed arrows represent the movement of data within 
Thermo-Calc. 

 
Figure 32: An example of a typical POLY module workflow. 

The basic workflow is: 

1. You are in the SYS module when you start Thermo-Calc in Console Mode. 

2. In the DATA module define the system. Before performing a calculation, 
you must define the system and retrieve thermodynamic data. The data is 
retrieved from a database file (*.TDB or *.TDC). 

3. The data needed to describe a system is then sent to the GIBBS module. 
This data is accessed by the POLY module when you instruct it to perform 
calculations.  

4. In the POLY module, perform the calculations. 

• In POLY, the conditions are set for an equilibrium calculation 
(temperature, pressure, system composition, etc.), then an 
equilibrium calculation is done.  

• If you want to make a property or phase diagram, you set the 
conditions for a stepping or mapping operation and perform that 
operation.  

• This generates data that can be used to plot a property diagram (if a 
stepping operation is performed) or a phase diagram (if a mapping 
operation is performed). 

5. In the POST module plot and visualize your data. 

• If a stepping or mapping operation is performed, then you can go to 
the POST module and plot a property or phase diagram.  
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• The diagram can be plotted quickly using default settings, but you can 
also modify which variables to plot of the diagram axes and change 
the appearance of the diagram.  

• You can save the diagram either as a plain text file with data about all 
the coordinates or as an image file. 

 Performing Calculations in Console Mode 

Later in this guide are descriptions of the common calculations performed in 
Thermo-Calc. Calculations can be performed either in the POLY module, or 
using some of the response-driven modules designed to perform specific types 
of calculations. 

The Equilibrium Calculations, section describes generally how to calculate and 
plot Property Diagrams and Phase Diagrams. To calculate and plot a property 
diagram or a phase diagram, you must first calculate an equilibrium. 

Additional sections discuss Scheil Simulations, T0 Temperature Simulations, 
Paraequilibrium, Potential Diagrams, and Aqueous Solutions.  

 Also search the online help or see Tabulation of Chemical Substances, 
Phases or Reactions and the Thermo-Calc Console Mode Command Reference 
(the POLY Commands section). 

 Using the Command Line Prompt 

The command line prompt in the Console window tells you which module you 
are currently in. When Thermo-Calc is first opened in Console Mode, you are in 
the SYS module, which is indicated with the command line prompt SYS. 

To use Console Mode, you type in commands at the command line prompt. 
The available commands depend on which module you are in. You can list the 
commands by typing ? at the prompt and then press  <Enter>, as in Figure 31. 

 
Figure 33: A list of the available SYS module commands. 

 Also see: 

• Moving Between Modules and Submodules 
• Entering Command Names or Abbreviations 
• Specifying Parameters 

http://www.thermocalc.com/support/documentation/
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• Default Parameters Values 
• Wild Card Characters 
• Controlling Console Output 
• Command History 

 Moving Between Modules and Submodules 

To go to a specific module, you typically use GOTO_MODULE followed by the 
name of the module. For example, to go to the DATA module, type 
GOTO_MODULE DATA. 

The exceptions are the submodules POST and ED-EXP: 

• To go to the POST module, you must enter the POST command from 
within the POLY module, or if you have DICTRA, from that module.  

• To go to the ED-EXP module, you must enter the ED-EXP command from 
within the PARROT module. 

To go back to the previous module type BACK. For example, if you are in the 
DATA module and entered it from the SYS module, when you type BACK, you 
return to the SYS prompt. This command is also available to exit from the 
submodules POST and ED-EXP.  

 Without a valid Thermo-Calc license, you cannot leave the SYS module. To 
enter the DICTRA and DIC_PARROT modules, you also need a valid DICTRA 
license key. 

 Entering Command Names or Abbreviations 

The name of a command typically consists of terms linked with underscores, 
for example, LIST_EQUILIBRIUM. Note the following: 

• UPPER or lower case letters are OK.  
• Hyphens (-) instead of underscores (_) are OK, e.g. LIST-EQUILIBRIUM. 
• You can abbreviate commands as long as it is unambiguous, e.g. when 

more than one command begins with LIST_, you need to type the next 
letter or word to distinguish between the commands. 

• Each word can be abbreviated e.g., L_E for LIST_EQUILIBRIUM.  

Examples of Command Names and Abbreviations 

Command name Abbreviation 

CALCULATE_EQUILIBRIUM C-E 

CALCULATE_ALL_EQUILIBRIA C-A 

LIST_EQUILIBRIUM L-E 

LIST_INITIAL_EQUILBRIUM LI-I-E 

LOAD_INITIAL_EQUILBRIUM LO-I-E 

LIST_PHASE_DATA CBCC L-P-D CBC 
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Command name Abbreviation 

LIST_PHASE_DATA CEMENTITE L-P-D CEM 

SET_ALL_START_VALUES S-A-S 
S-AL 

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025 S-A-V 1 X(F,FE) 0 .89 .025 

SET_START_CONSTITUENT  S-S-C 

SET_START_VALUE S-S-V 

SET_AXIS_PLOT_STATUS S-A-P 

SET_AXIS_TEXT_STATUS S-A-T-S 
S-A-TE 

SET_AXIS_TYPE S-A-TY 

SET_OPTIMIZING_CONDITION S-O-C 

SET_OPTIMIZING_VARIABLE S-O-V 

SET_OUTPUT_LEVEL S-O-L 
S-OU 

 Specifying Parameters 

Running a command typically requires that several parameter values are 
specified, which can be done directly in the command line after the command 
name. For example, to set an axis variable for a stepping or mapping 
operation, enter: 

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025 

You can also type SET_AXIS_VARIABLE and press <Enter>. At the command 
line prompt, you then specify the parameters one at a time.  

On all command lines, you can enter a question mark (?) for help. For some 
parameters, enter two question marks (??) for more detailed information. 

6.10.1 Default Parameters Values 
When you are requested to specify a parameter, Thermo-Calc usually suggests 
an appropriate default value, which is displayed at the prompt between two 
slash signs (//). For example, this prompt means the default answer is 
TERMINAL: 

OUTPUT FILE /TERMINAL/: 

Press <Enter> to accept the default.  

If you specify some parameters directly after the command name, then you 
can still choose to accept default values for some parameters.  
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To accept the default value for a parameter, type a comma (,) instead of a 
value for that parameter. For the comma to be interpreted correctly, type a 
blank space on each side of the comma. However, if you accept the default 
values for several parameters that follow each other, then the commas can be 
typed in without blank spaces separating them: (,,,) is interpreted in the 
same way as (, , ,).  

For some commands and parameters, Thermo-Calc treats the values 
previously assigned as default values if the command is used again. For 
example, if the first stepping or mapping axis variable is specified as:  

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025 

Then if you want to change a parameter value for this axis variable, type: 

SET_AXIS_VARIABLE 1 , 0.1 ,,,  

This changes the minimum value from 0 to 0.1 at which a stepping or mapping 
operation halts. The other parameter values remain the same. Consequently, 
what is typed is equivalent to:  

SET_AXIS_VARIABLE 1 X(FCC,FE) 0.1 0.89 0.025 

 Wild Card Characters 

You can sometimes use the asterisk (*) as a wild card character to, for 
example, refer to all components, phases, or species, when showing calculated 
properties in the POLY module, or when you set axis variables for plotting 
diagrams in the POST module.  

When showing calculated properties in the POLY module, you can also use the 
dollar sign ($) to refer to all stable phases.  

 For activity and/or chemical potential properties, the *and $ normally do 
not work properly as wild card characters. 

Examples of Wild Card Characters in Console Mode 

Command Action 

SHOW_VALUE B(*)  Lists mass (gram) of all components in the system. 
SET_AXIS_VAR Y B(*) * Sets mass (gram) of all components in the system as 

Y-axis variable. 
SHOW_VALUE MUR(*)  Lists chemical potentials of all components in the 

system. 
SET_AXIS_VAR Y ACR(*) * Sets activities of all components in the system as Y-

axis variable. 
SHOW_VALUE HM(*).T  Lists heat capacities of all phases. 
SET_AXIS_VAR Y GM(*) * Sets molar Gibbs free energies of all phases as Y-axis 

variable. 
SHOW_VALUE TC($) Lists curie temperature of all stable phases. 
SHOW_VALUE W(*,*)  Lists mass fractions of all components in all phases. 
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Command Action 

SHOW_VALUE W($,*)  Lists mass fractions of all components in all stable 
phases. 

SHOW_VALUE W(FCC,*)  Lists mass fractions of all components in the FCC 
phase. 

SHOW_VALUE W(*,FE)  Lists mass fractions of the Fe component in all 
phases. 

SHOW_VALUE W($,FE)  Lists mass fractions of the Fe component in all stable 
phases. 

SHOW_VALUE Y(*,*)  Lists site fractions of all species in all sublattices of all 
phases. 

SHOW_VALUE Y($,*)  Lists site fractions of all species in all sublattices of all 
stable phases. 

SHOW_VALUE Y(*,*)  Lists site fractions of all species in all sublattices of all 
phases. 

 Controlling Console Output 

In response to a command Thermo-Calc may display a lot of text in the Console 
window.  

 Also see Increasing the Buffer Size. 

• To pause the text on printing press <Ctrl+S>.  
• To resume the printing on screen, press <Ctrl+Q>. 
• When Thermo-Calc is performing a mapping operation, the results are 

continuously printed in the Console window. To terminate the calculation 
of the current region of the mapping and stop the output, press <Ctrl+C>. 

 Command History 

• To scroll through the last twenty commands used, type two exclamation 
marks (!!) and press <Enter>.  

• To repeat the last n commands, type ! followed by the number of previous 
commands to be executed again.  

• To scroll through previous performed commands, use the Up (↑) or Down 
arrow (↓) keys. 

• To read more information about the command history functionality in 
Thermo-Calc, type ! ? at the command line prompt.  

 Log, Macro and Workspace Files 

In Console Mode, Thermo-Calc uses different kinds of files, including: 

• Log Files (*.LOG) 
• Macro Files (*.TCM or *.LOG) 
• POLY Workspace Files (*.POLY3),  
• Experimental data files (*.EXP) (see the Data Optimisation User Guide on 

the website for information).  

http://www.thermocalc.com/support/documentation/


Thermo-Calc User Guide 
Version 2015b 

98 | The Console Mode Interface  

• The GIBBS module uses a workspace file (*.GES5) 
• The PARROT module uses files with the suffixes *.PAR and *.POP.  

 Log Files 

Log files are plain text files used to save a sequence of commands. Log files can 
be edited in a text editor. 

• To start saving your input into such a file, use SET_LOG_FILE in the SYS 
module, followed by the name of the file that you want to save your 
command sequence to.  

• If you want to save the output in the log file as well, use SET_ECHO before 
the SET_LOG_FILE command. Doing this is useful if you want use the log 
file later as a macro file. 

 For details about the SET_LOG_FILE and SET_ECHO commands see the 
Thermo-Calc Console Mode Command Reference on the website. 

 Macro Files 

Macro files are plain text files used to save a sequence of commands that can 
be loaded and executed. Macro files can be edited in a text editor.  

 For details about the MACRO_FILE_OPEN command see the Thermo-Calc 
Console Mode Command Reference on the website.  

 Also see Example 12 in Console Mode Examples. 

Action Command Description and Comments 

To load a macro file In the SYS module, 
MACRO_FILE_OPEN 
followed by the name 
of the macro file. 

Thermo-Calc starts the command 
sequence that the file contains. 

Regain control of the 
console 

SET_INTERACTIVE End a macro file with this 
command to have control of the 
Console returned to you. 

Add comments to a 
macro file 

Start a line with @@, 
or enclose it between 
an @ (-line and a @)-
line.  

When lines are enclosed the 
software ignores them when 
running the macro. 

Open a macro file MACRO_FILE_OPEN When creating the log file, you can 
make a macro file load up to five 
other macro files. 

http://www.thermocalc.com/support/documentation/
http://www.thermocalc.com/support/documentation/
http://www.thermocalc.com/support/documentation/
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Action Command Description and Comments 

Nest macro files 
inside of each other 

MACRO_FILE_OPEN 
SET_INTERACTIVE 

If a nested macro file ends with 
SET_INTERACTIVE, then 
Thermo-Calc resumes with the 
higher-level macro file at the 
command immediately following 
the MACRO_FILE_OPEN 
command that loaded and 
executed macro file that has just 
been terminated. If a nested 
macro file doesn’t end with 
SET_INTERACTIVE (but with an 
end-of-file character), then the 
console shuts down and the macro 
is stopped. 

6.16.1 Control Characters 
The @? character allows you to make a macro interactive by allowing input. At 
the @? character, which is placed where a parameter value or argument is 
normally put, Thermo-Calc prompts to input the value of a parameter or 
argument. You can enter a string immediately following the @? character. This 
string is presented to the user when prompted to enter the parameter value or 
argument. The entered value is used by Thermo-Calc as input to the command 
in question. For example, you can request the user to specify the temperature 
range of a stepping calculation by entering the following in a macro file: 

SET_AXIS_VARIABLE 1 T @?Low-temperature-limit: 
@?High-temperature-limit: 

You can also use up to nine variables in your macro file and prompt the user to 
enter values that can be assigned to these variables. Use the @#n character 
when you want to prompt the user to provide a value to the variable, where 
the n is a digit between 1 and 9. You can then use this value by with the ##n 
character. For example, you can request the user to provide the first element 
of a system by entering the following in the macro file: 

@#3First-element? 

You can then use this variable with the entering the character ##3 later in the 
macro file. For example, you can write: 

SET_AXIS_VARIABLE 1 x(##3) 0 1,,, 

Finally, there is the @& pause character. Thermo-Calc pauses and waits for 
input from the user when this pause character is read from a macro file. 
Inserting pause characters is useful if you want to allow the user to monitor 
what is happening when Thermo-Calc is running the macro. 
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6.16.2 Response-driven Modules and Macros 
Macro files that are created while you use a response-driven module begin 
with the module-entering command (for example, GOTO_MODULE SCHEIL) 
followed by a number of lines with responses to the module’s questions and 
requests. The file terminates with the POST or the SET_INTERACTIVE 
command (this command gives you back control of the Console). An empty line 
cannot be edited with any input rather than the default answer (to a specific 
question). Comment lines, commands to open other macro files, pause 
characters or input-controlling characters cannot be inserted between these 
empty lines (otherwise the response-driven module cannot be executed 
properly). 

 Workspace Files 

You can save all the data in your current workspace by first using 
SAVE_WORKSPACES. This command is available in the POLY, GIBBS and 
PARROT modules. The workspace has all the settings specified and the result 
of any stepping or mapping operations performed after using 
SAVE_WORKSPACES. Consequently, the command opens a workspace in which 
all data is saved which is generated after the SAVE_WORKSPACE command is 
executed. The saved data includes original and modified thermodynamic data, 
the last set of conditions and options, and calculation results.  

To load the data and calculation results of a workspace file, use the 
READ_WORKSPACES command available in the POLY module. The file can be 
used for calculation in POLY, visualization in POST, or data manipulation in 
GIBBS. You are also given the option in the POURBAIX and SCHEIL modules to 
open a previously saved workspace file. This allows you to make new 
POURBAIX or SCHEIL calculations on the same chemical system as before but 
with different temperature, pressure, and composition conditions, or to plot 
new property diagrams based on the previous calculations. 

 For more details about the SAVE_WORKSPACES and READ_WORKSPACES 
commands search the online help or see the Thermo-Calc Console Mode 
Command Reference on the website. 

 Main Menu Commands 

The File menu and toolbar are reserved for Graphical Mode. In Console Mode 
you use commands to access these menu options. The Tools, Window and 
Help menus are described in the Main Menu and Toolbar section. If there is an 
equivalent command, it is listed in the table below.  

 Also search the online help or see the Thermo-Calc Console Mode 
Command Reference on the website. 

Console Mode Main Menu Commands 

Option Command 

Open files In Thermo-Calc, drag and drop the file into the Console 
window. 

http://www.thermocalc.com/support/documentation/
http://www.thermocalc.com/support/documentation/
http://www.thermocalc.com/support/documentation/
http://www.thermocalc.com/support/documentation/
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Option Command 

In the SYS module: MACRO_FILE_OPEN 
In the SYS module: OPEN_FILE 

Save (workspace) This command depends on the module you are in. Type ? at 
the prompt to look for a command such as 
SAVE_GES_WORKSPACE (GIBBS module) 

Exit In any module: EXIT 

Close In the SYS module: CLOSE_FILE 

Display license info In the SYS module: DISPLAY_LICENSE_INFO 

 

 Defining a System in Console Mode 

Defining a system means to select the chemical components and to retrieve 
thermodynamic data about those components from an appropriate database 
in order to do the calculations. You use database(s) with thermodynamic data 
and then define what system elements as components. Once the system is 
defined, you retrieve the system’s thermodynamic data from the database(s).  

• If you use a response-driven module to perform your calculation, such as 
BIN or POURBAIX, then the module prompts you to select database(s) and 
define the system.  

• When doing calculations in the POLY module, you typically have to 
manually select databases and define the system in the DATA module. 
However, it is also possible to define the system directly in POLY using 
DEFINE_MATERIAL and DEFINE_DIAGRAM  

 Search the online help or see the Thermo-Calc Console Mode Command 
Reference on the website for information about the commands used in this 
section. See DATABASE_RETRIEVAL Commands. 

6.19.1 How to Define a System in Console Mode 
1. Go to the DATA module. At the SYS prompt, type GOTO_MODULE DATA. 

2. Change the default database unless you directly specify the name of the 
database as a parameter to the command. Type SWITCH_DATABASE and 
follow the prompts. 

The second part of the command prompt indicates the current default 
database. For example, if the prompt is TDB_TCFE8, then the current 
database is TCFE8. 

3. Use DEFINE_ELEMENTS followed by a list of the elements that you want in 
your system. (To list the elements that are available in your current 
database, use LIST_DATABASE ELEMENTS.) For example, if you want to 
have Fe and C in your system, type: 

DEFINE_ELEMENTS Fe C 

4. Use REJECT PHASES if you want to avoid retrieving any phases from the 
database. (To list the phases that are available in your current database, 
use LIST_DATABASE PHASES. To list the phases that can form in the 

http://www.thermocalc.com/support/documentation/
http://www.thermocalc.com/support/documentation/
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defined system, use LIST_SYSTEM CONSTITUENT.) For example, if you do 
not want the graphite phase to be retrieved, you type: 

REJECT PHASES GRAPHITE 

If the number of phases to include is much lower than the total number of 
phases, then it can be convenient to first REJECT PHASES * and then 
restore the phases to include using RESTORE PHASES. 

5. Use GET_DATA to search the database and send the thermodynamic data 
about your system to the GIBBS workspace.  

At this point you can proceed to the POLY module (with GOTO_MODULE 
POLY). However, you may want to add elements, phases and species to the 
GIBBS workspace from other databases. If so, then proceed to the next 
step. 

6. Use APPEND_DATABASE to select the (additional) database from which 
you want to retrieve data. This command works exactly in the same way as 
the SWITCH_DATABASE command, with the exception that it does not 
reinitialize the DATA module and the GIBBS workspace, but instead 
appends or replaces the data that has already been retrieved with new 
data from the additional database. 

7. Define your elements and specify whether to reject and restore any 
phases. Do this in exactly the same way when using the 
SWITCH_DATABASE command (see the preceding steps 2 and 3). 

8. Use GET_DATA to search the database and add the thermodynamic data 
to the data that already exists in the GIBBS workspace.  

9. Use APPEND_DATABASE again if you want to add data from yet another 
database. When you have retrieved all the data you need, you can proceed 
to the POLY module. 
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7. Equilibrium Calculations 
• About Equilibrium Calculations 
• Calculating an Equilibrium 
• Calculating an Equilibrium with a Fixed Phase 
• Calculating an Equilibrium with Suspended or Dormant Phases 

 About Equilibrium Calculations 

An equilibrium describes what the composition of the end state of a system is, 
given a full specification of state variables such as temperature, pressure, 
initial composition, system size, etc. An equilibrium calculation is normally 
done in POLY according to the Global Minimization Technique, which ensures 
that the most stable minimum under the specified conditions is computed.  

For an equilibrium calculation to be performed, the state variables must all be 
set as conditions for the calculations. Such conditions include, for example, 
temperature, pressure, and system composition. When you calculate an 
equilibrium in the POLY module, you have to set these conditions manually.  

Setting a condition normally involves giving a single state variable a specific 
value. For example, you can set the temperature to 1273.5 Kelvin (T=1273.5). 
Alternatively, setting a condition can involve giving a linear expression with 
more than one state variable a specific value. For example, you can set the 
mole fraction of the S component to be the same in the liquid and the 
pyrrohotite phases (X(LIQ,S)-X(PYRR,S)=0). 

The number of state variables that needs to set is determined by the Gibbs 
Phase Rule. Typically, the state variables to give values to are: 

• temperature (in K) 

• pressure (in Pascal) 

• system size in number of moles (in mole) or mass (in grams) 

• the fraction of each component (in number of moles or mass) 

The following table lists some of the available state variables you can use to 
set conditions: 

Examples of State Variables for Setting Conditions 

State variable SET_CONDITION parameter 

temperature in the system (in K) T 

pressure in the system (in Pascal) P 

system size (mole number in moles) N 

system size (mass in grams) B  

number of moles of a component in the system N(<component>) 

mole fraction of a component in the system X(<component>)  

mass fraction of a component in the system W(<component>)  

activity of a component in the system ACR(<component>) 
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State variable SET_CONDITION parameter 

chemical potential of a component in the system MUR(<component>) 

mole fraction of a component in a phase X(<phase>,<component>) 

mass fraction of a component in a phase W(<phase>,<component>)  

activity of a species referred to a phase at ambient 
temperature and pressure 

ACR(<species>,<phase>) 

chemical potential of a species referred to a phase 
at ambient temperature and pressure 

MUR(<species>,<phase>) 

enthalpy in the system (in J) H 

enthalpy of a phase (in J/mol) HM(<phase>) 

If you fix the phase of the equilibrium and all but one of the state variables, 
you can discover the value of the other state variable at equilibrium. 

It is possible to specify a set of conditions that does not have any equilibrium 
and the program detects this by failing to reach equilibrium during the 
calculation.  

Here is an example of the kind of information about the equilibrium normally 
shown: 

 

 Calculating an Equilibrium 

This section explains how to calculate an equilibrium in POLY. To calculate an 
equilibrium means to calculate the equilibrium composition of your system, 
given a full specification of conditions that reduce the degrees of freedom of 
the calculation to zero. 

If you are running a network client installation of Thermo-Calc and cannot 
enter the POLY module, this may be because all the license instances on that 
the license server makes available have been checked out.  
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1. Define your system (see Defining a System in Console Mode). 

2. Go to the POLY module. At the SYS prompt, type GOTO_MODULE POLY. 

3. Use SET_CONDITION followed by conditions and value assignments to set 
the conditions of your calculation. For example, to set temperature, 
pressure, initial composition and system size for a Fe-Cr-C system, you 
might enter the following: 

SET_CONDITION T=1200 P=1E5 W(CR)=0.18 
W(C)=0.0013 N=1 

This sets the temperature (T) to 1200 K, the pressure to 1 bar (100,000 
Pascal), the mass fraction of Cr to 18 mole percent, the mass fraction of C 
to 0.13 weight percent, and the total amount of material to 1 mole. The 
fraction of Fe in the system is calculated from the fractions of Cr and C. 
You have to set the fraction of all the components in your system except 
one. 

4. Use COMPUTE_EQUILIBIRUM to run the calculation. 

5. Use LIST_EQUILIBRIUM to see the results of the calculation. 

 Calculating an Equilibrium with a Fixed Phase 

There are many ways to calculate equilibriums in Thermo-Calc. The following is 
one example.  

You can calculate an equilibrium that has a certain amount of a certain stable 
phase. Use CHANGE_STATUS PHASE to specify the phase and the amount of 
that phase (in normalized mole number) that you want to set as fixed. For 
example, if you want to find out at what temperature a system starts to melt, 
enter the following: 

CHANGE_STATUS PHASE LIQUID=FIX 0 

You must leave the state variable whose equilibrium value you are interested 
in unspecified. However, if you have already specified that state variable, you 
can make it unspecified again by using SET_CONDITION and set that state 
variable to NONE. For example, if you have given temperature a value, you can 
type:  

SET_CONDITION T=NONE 

The calculated equilibrium includes the value of the unspecified variable at 
which the equilibrium enters the phase that is fixed. 

 For an example where an equilibrium is calculated with a fixed phase, see 
Example 7 in Console Mode Examples. 

 Calculating an Equilibrium with Suspended or Dormant 
Phases 

You can calculate an equilibrium under the assumption that one or several 
phases are SUSPENDED or DORMANT using CHANGE_STATUS PHASE. For 
example, to specify that all phases except one should be suspended, you can 
first suspend all phases and then enter a single phase in the following way: 
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CHANGE_STATUS PHASE *=SUSPENDED 
CHANGE_STATUS PHASE FE_LIQUID=ENTERED 

 For an example where this is done, as well as where the status of phases is 
set to be dormant, see Example 10 in Console Mode Examples. 
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8. Property Diagrams 
• About Property Diagrams 
• Calculating and Plotting a Property Diagram 
• Calculating a Property Diagram One Phase at a Time 
• Calculating Several Properties in the Same Diagram 

 About Property Diagrams 

When you calculate and plot a property diagram, there is only one 
independent state variable. Many different properties can be plotted as a 
function of this independent variable. For example, if the independent state 
variable is temperature, then the mole fractions of all phases can be plotted as 
a function of temperature. Or the composition of a specific phase may be 
plotted relative to temperature, or the activity of a component in the system 
as a whole or in a specific phase may be plotted relative to it. 

A property diagram is plotted based on a series of equilibria that is computed 
while the value of one state variable is varied between a minimum and a 
maximum value. This variable is referred to as the stepping axis variable. In 
Thermo-Calc, first calculate one initial equilibrium, and then new equilibria are 
calculated at incremental steps in both directions on the stepping axis from 
the initial equilibrium. This continues until the stepping operation has covered 
the length of the axis between a minimum and a maximum value that is 
specified.  

For an example of the calculation of a property diagram, see Example 8 in 
Console Mode Examples. 

 Calculating and Plotting a Property Diagram 

This section explains how to calculate a property diagram in POLY. To calculate 
a property diagram means to calculate a series of equilibria while the value of 
the stepping axis variable varies between a minimum and a maximum value. 
With the exception of the stepping axis variable, all the state variables that you 
set when you calculate the initial equilibrium retain the values when the new 
equilibria are calculated.  

1. Calculate an initial equilibrium in the POLY module (see Equilibrium 
Calculations). 

2. Use SET_AXIS_VARIABLE to set the axis variable, the minimum and the 
maximum stepping variable values and the step length. The first parameter 
of SET_AXIS_VARIABLE is the axis number. Since a property diagram only 
has one axis variable, this is set to 1. For example, if you want to set the 
axis variable to temperature, and calculate an equilibrium at every 50 K 
between a minimum temperature of 100 K and a maximum temperature 
of 2000 K, enter 

SET_AXIS_VARIABLE 1 T 100 2000 50 
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An axis variable must be a state variable that is set when you calculated 
the initial equilibrium. For example, if you set the fraction of a component in 
number of moles, then you cannot set the mass fraction of this component as 
an axis variable. Also, the minimum stepping variable value must be smaller 
than, and the maximum value larger than, the value that you set the state 
variable to when calculating the initial equilibrium. 

3. Use STEP NORMAL to perform the stepping operation.  

Thermo-Calc lists the phase regions along the stepping axis, the phases 
contained in each region, and the number of equilibria calculated in that 
region. Each region is defined by the phases it contains.  

 The number of equilibria calculated is not just the number of steps that 
are performed according to the step length and the minimum and maximum 
values on the axis variable. This is because Thermo-Calc calculates extra 
equilibria when a new phase is discovered in order to determine the phase 
region boundary more precisely. 

 
4. To plot the diagram, use POST to open the POST module and then use 

PLOT. By default, the X-axis represents the stepping axis variable and Y-
axis represents the sum of the mole fractions of all phases (NP(*)).  
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 Calculating a Property Diagram One Phase at a Time 

There are many ways to calculate property diagrams in Thermo-Calc. One 
example is where you can calculate a property diagram with a separate 
stepping operation being performed for each phase at a time in its default 
most stable composition (the major constitution). This is useful if you want to 
create a property diagram for a heterogeneous system with both ordered 
phases and their disordered pairs. 

To calculate a property diagram one phase at a time, use STEP 
ONE_PHASE_AT_TIME to perform the stepping operation.  

 Calculating Several Properties in the Same Diagram 

There are many ways to calculate property diagrams in Thermo-Calc. The 
following is another example. If you perform several stepping calculations after 
each other, the results of these calculations are all saved in your workspace 
file. This allows you to the following: 

• Calculate (and then plot) missing parts of a specific property inside the first 
property diagram. These parts are calculated inside the range of the 
stepping variable with a different control condition. 

• Calculate (and then plot) two or more sets of a specific property on the 
same property diagram for the same system. These can be calculated 
under different control conditions with stepping operations being 
performed across the same stepping axis variable range. 

• Calculate phase boundary lines and then plot them in a corresponding 
phase diagram for the same system. This can be especially useful for some 
defined secondary phase-transformations. For example, if you want to find 
the phase boundary between BCC_A1 and BCC_B2, or the equal-Gm for 
two specific phases, or the equal-fraction or equal-activity for two specific 
phases of a certain species, then this can be useful. 

Unless you have opened a new workspace file previously using 
SAVE_WORKSPACES, the results of the stepping calculations are saved in a 
RESULT.POLY3 file. To save the results of several stepping calculations in a file 
different from the workspace file that your results are currently saved to, then 
use SAVE_WORKSPACES before you perform the first stepping calculation. 

 SAVE_WORKSPACES overwrites and deletes the results of all previous 
stepping calculations! 
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9. Phase Diagrams 
• About Phase Diagrams 
• Calculating and Plotting a Phase Diagram 
• Calculating a Quasi-Binary Phase Diagram 
• Calculating a Quasi-Ternary Phase Diagram 

 About Phase Diagrams 

Phase diagrams have two or more independent axis variables. Any state 
variable that has already been set can be used as the mapping variable for a 
mapping calculation and then as the axis variable for a phase diagram. From a 
mapping calculation, many types of phase diagrams can be plotted, with one 
of the mapped variables as one axis variable, and with other mapped variables 
or any varied property (state or derived variables) or entered symbol 
(variables, functions or table values) as the other axis variables. 

All phase diagrams consist of zero phase fraction lines. There are two distinct 
types of phase diagrams: those with the tie-lines in the plane of the diagram 
and those where the tie-lines are not in the plane. The former includes binary 
phase diagrams and ternary isotherms. The latter includes more general 
isopleth diagrams with one or more fixed extensive variables (normally, this is 
a composition). The BIN and TERN modules calculate binary and ternary phase 
diagrams. The POTENTIAL and POURABIX modules calculate the more general 
isopleth diagrams and other related diagrams. 

The following describes how to calculate the types of phase diagrams in the 
POLY module. In POLY, you can calculate phase diagram for systems with up to 
40 components and with thousands of phases. You can combine activity 
conditions and fixed phase status and fraction conditions in any way. Thermo-
Calc can calculate any arbitrary 2D section through composition space.  

There is no guarantee that the conditions set will result in a calculation 
that reaches an equilibrium.  

 For an example of the calculation and plotting of a phase diagram, see 
Example 4 in Console Mode Examples. 

 Calculating and Plotting a Phase Diagram 

This section describes how to calculate a phase diagram in the POLY module. 

1. Calculate an initial equilibrium in the POLY module (see Equilibrium 
Calculations).  

2. Use SET_AXIS_VARIABLE to set the first axis variable, its minimum and 
maximum mapping value and the length of each incremental step on this 
axis. The first parameter of SET_AXIS_VARIABLE is the axis number and is 
set to 1. For example, suppose you want the mass fraction of C as your first 
axis variable. You want it to vary between 0 and 0.1, with the length of 
each incremental step being no more than 0.002. You then enter: 

SET_AXIS_VARIABLE 1 W(C) 0 .1 0.002 
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An axis variable must be a state variable that is set when you calculated 
the initial equilibrium. For example, if you set the fraction of a component in 
number of moles, then you cannot set the mass fraction of this component as 
an axis variable.  

3. Use SET_AXIS_VARIABLE to set the second axis variable and specify its 
minimum, maximum, and step length values. The axis number is set to 2. 
For example, suppose you want temperature as your second axis variable 
and you want it to vary between 900 K and 1900 K, with an incremental 
step of 25 K. You then enter: 

SET_AXIS_VARIABLE 2 T 900 1900 25  

4. If you want more than two axis variables, then use SET_AXIS_VARIABLE 
until you have set all the axis variables. You can set up to five axis 
variables. Axis variables 3, 4 and 5 must be set temperature, pressure or to 
the chemical potentials of components. 

You may want to save your workspace with SAVE_WORKSPACES before 
you perform the mapping calculation. This saves the axis variables you 
have set. However, it overwrites the results of any previous stepping or 
mapping calculations done. 

5. Use MAP to perform the mapping calculation. 

The console lists the phase region boundaries and the phases contained on 
one side of each boundary. 

 
6. To plot the diagram, use POST to open the POST module and then use 

PLOT. By default, the X-axis represents mapping axis variable 1 and the Y-
axis represents mapping axis variable 2. 

 Calculating a Quasi-Binary Phase Diagram 

There are many ways to calculate phase diagrams in Thermo-Calc. The 
following is an example where a quasi-binary phase diagram is used for 
calculations on a ternary system in which one component has an activity or 
chemical potential that is fixed (although if you have fixed a phase and the 
phase composition varies, then the activity or chemical potential may also 
vary). The tie-lines in a quasi-binary diagram are in the diagram’s plane of the 
diagram. This means that the calculation follows the lever rule as well as other 
rules.  
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Use CHANGE_STATUS to set the component that has a fixed activity or 
chemical potential. For example, suppose you want to compute a phase 
diagram for a Ca-Fe-O system in which the liquid oxide (FE-LIQ) is in 
equilibrium with liquid Fe. You then enter: 

CHANGE-STATUS FE-LIQ=FIX 0 

 For an example of a calculation of a quasi-binary phase diagram, see 
Example 17 in Console Mode Examples.  

 Calculating a Quasi-Ternary Phase Diagram 

There are many ways to calculate phase diagrams in Thermo-Calc. The 
following is an example of a quasi-ternary phase diagram used for calculations 
on a quaternary system where one component has a fixed activity or fixed 
chemical potential. 

When calculating a quasi-ternary phase diagram it is necessary to set a 
condition on either activity or chemical potential of the fourth component. 
To specify a meaningful value it is recommended that you first change 
the component’s reference state using SET_REFERENCE_STATE. For example, 
to calculate a phase diagram for a quasi-ternary Fe-Cr-Ni-C system with fixed 
carbon activity, you can enter the following: 

SET_REFERENCE_STATE C GRAPH ,, 

You must also use SET_CONDITION to set the activity of the component whose 
activity or chemical potential you have fixed. Do this by assigning a value to the 
ACR state variable. For example, if the component is carbon, you might enter 

SET_CONDITION ACR(C)=0.002 
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10. Scheil Simulations 
• About Scheil Simulations 
• Simulating a Scheil-Solidification 
• Plotting Additional Scheil Simulation Diagrams 

 About Scheil Simulations 

Thermo-Calc is primarily a program for performing equilibrium calculations, 
but some non-equilibrium transformations or partial-equilibrium 
transformations can be simulated. One example of such a transformation is a 
Scheil-Gulliver solidification. In a Scheil-Gulliver solidification, the diffusion in 
the solid phases is assumed to be so slow that it can be ignored, while the 
diffusion in the liquid phase is assumed to be very fast. With this 
approximation, the conditions at the liquid/solid interface can be described as 
a local equilibrium.  

By making a stepping operation on the temperature variable (or enthalpy or 
amount liquid phase) with small decrementing steps, the new composition of 
the liquid can be determined. After each step, the amount of formed solid 
phase is removed and the overall composition is reset to the new liquid 
composition. In effect, the whole system is described as a non-equilibrium 
state regarding various parts of solidified phases at various solidification 
stages.  

You can simulate Scheil-Guilliver solidification processes with the SCHEIL 
module. When you enter the module, you are prompted to answer a series of 
questions about which database to use, what the major element is and in 
which amount. Thermo-Calc then displays a property diagram showing how 
the fraction of solid phase varies with temperature (in Celsius). You can then 
plot diagrams using other variables you are interested in. Do this by starting a 
new simulation, by opening an old file with the results of a previous simulation 
that you can plot differently. For example, you might be interested in plotting 
the fraction of remaining liquid against temperature, the fraction of each solid 
phase or the total of solid phases against temperature, the microsegregation in 
each solid phase, or the latent heat evolution against temperature. 

It is possible to use the SCHEIL module to run a modified Scheil-Gulliver 
simulation that also take back-diffusion of some fast-diffusing interstitial 
elements such as C or N into account, as well as BCC to FCC phase 
transformation phenomena.  

 Also see the Thermo-Calc Command Reference and Console Mode 
Examples for more information about how to use the SCHEIL module:  

• See Examples 15 and 30 to simulate non-equilibrium transformations 
without considering fast-diffusion elements. 

• See Example 48 to simulate partial-equilibrium transformation with fast-
diffusion elements taken into consideration. This example also shows how 
you can perform lever-rule calculations (full-equilibrium transformations).  
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 If you also have a license for DICTRA, you can import a previously 
calculated Scheil segregation profile into the software using the command 
INPUT_SCHEIL_PROFILE.  

 Search the online help or see the DICTRA Command Reference.  

 Simulating a Scheil-Solidification 

Simulating a Scheil-Gulliver solidification process involves calculating the liquid 
composition of a higher-order multicomponent system at each step of a 
cooling process, and resetting the liquid composition as the composition of the 
entire system (after having removed all amount of solid phase).  

1. Use GOTO_MODULE SCHEIL to enter the SCHEIL module. 

2. Type START-WIZARD. 

3. Specify which Database to use. 

4. Specify the Major element or alloy in your system. 

For example, for a steel/Fe-alloy, enter Fe, for an Al-based alloy, enter Al, 
and for a Ni-based super alloy, enter Ni.  

5. Set whether to specify the Composition input in mass (weight) 
percent (the default) or in Mole percent. Enter Y for mass percent and 
N for mole percent. 

6. Specify the name of the 1st alloying element. You can directly 
specify mass or mole percent after the name (for example, enter Cr 5). If 
this is not specified, then you are prompted to enter it separately.  

7. Specify the other alloying elements in the same way as you specify the first 
(for example, c 1).  

8. After you have specified your last alloying element, press <Enter> when 
requested to specify the next element. This ends the process of defining 
the bulk composition of the alloy system.  

You can also specify all the alloying elements and their corresponding 
compositions on the same line when you are prompted to specify your first 
alloying element in Step 6. For example, you can enter Cr 5 Ni 1 Mo 
0.5 C 0.01 N 0.02. 

9. Specify the starting Temperature (C) in Celsius. The default is 2000. 

This value should be sufficiently high so that the solidification simulation 
starts with the alloy system in the liquid single-phase region. 

10. Decide which phases (if any) to reject at the Reject phase(s) prompt. 
Enter the name of the phases to reject or press <Enter> for NONE.  

11. Decide whether to Restore phase(s). You may want to restore a phase 
that you rejected when you ran the simulation earlier, or you may want to 
restore a phase that is rejected by default in your database. Enter the 
name of the phases to restore or press <Enter> for NONE. 

12. When prompted OK? type N to go back to Step 9 to reconsider which 
phases to reject or restore. Type Y to continue. 
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Thermodynamic data about the alloy system you defined is retrieved from 
the database. 

13. At the Should any phase have a miscibility gap check 
prompt, press <Enter> for N or answer Y.  

If you answer Y, you are prompted to specify the Phase with 
miscibility gap. Answer with a solution phase name(s) (in this 
example FCC is entered) as well as the Major constituents for 
sublattice (for each sublattice site) (for this example, Cr is entered for 
sublattice 1 and C for sublattice 2). In this example the Phase with 
miscibility gap is LIQUID PHASE NAME: LIQUID.  

14. Press <Enter> to specify another phase. 

15. Specify the names of any Fast-diffusing components. Press <Enter> 
for NONE or type all the names on the same line then press <Enter>. If you 
do specify any fast-diffusing components, then you are prompted to set 
whether BCC to FCC phase transformations should be simulated. 

The Scheil-Gulliver solidification simulation runs, and the default diagram 
(Temperature versus Mole Fraction of Solid) is automatically plotted in the 
Console Results window.  

 

 Plotting Additional Scheil Simulation Diagrams 

Post processing is done the same way as POLY-3 Post Processing module, 
specific variables for plotting in the Scheil Module are listed in the table.  

The following variables can be plotted along the X- and Y-axes. In the table, ph 
is an abbreviation of phase, and el is an abbreviation of element. Use the 
abbreviations of the variables when you specify what the X- and Y-axes 
represent in a diagram. 
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Scheil State Variable Abbreviations 

State variable Abbreviation 

Temperature in Celsius T 

Mole/mass fraction of liquid NL/BL 

Mole/mass fraction of all solid phases NS/BS 

Mole/mass fraction of a solid phase NS(ph)/BS(ph) 

Weight fraction of an element in a phase W(ph,el) 

Mole fraction of an element in a phase X(ph,el) 

Site fraction of an element in a phase Y(ph,el) 

Distribution of an element in a phases NN(ph,el) 

Heat release and Latent heat per mole/gram NH/BH 

Apparent heat capacity per mole/gram CP/BCP 

Molar volume of the system or a phase NV/NV(ph) 

Average density of the system or a phase DS/DS(ph) 

Apparent volumetric TEC of the system BT 



Thermo-Calc User Guide 
Version 2015b 

117 | T0 Temperature Simulations 

11. T0 Temperature Simulations 
The T0-temperature is the temperature at which two phases have the same 
Gibbs energy for a certain composition in a multicomponent system. The T0-
temperature is located within the two-phase field between the phases and it is 
the theoretical limit for a transformation without diffusion. T0-temperatures 
are often of interest if you want to understand how diffusionless 
transformations work. The T0 temperature in a multicomponent system with a 
fixed composition is temperature at which the tangent lines of the Gibbs 
energies of the two target phases are the same.  

If the composition of one or two components varies, the common Gibbs 
energy for the two phases in partial equilibrium of a diffusionless 
transformation becomes a plane or surface, and the T0 temperature becomes 
a line or plane.  

 Also see Making a T0 Temperature Simulation for step-by-step 
instructions. 

 Making a T0 Temperature Simulation 

This section describes how to perform a T0 temperature simulation and apply 
a stepping calculation to its initial result. 

Before you perform a T0 temperature calculation, you must have defined your 
initial system and be in POLY. The initial overall composition must have 
appropriate settings for the desired T0 temperature calculation for the two 
target phases.  

1. Use SET_CONDITION to set the conditions of your calculation in the same 
way as when you calculate an ordinary equilibrium. 

2. Use COMPUTE_EQUILIBIRUM to run the calculation. The calculation does 
not need to reach an equilibrium in which any of the target phases is 
stable. 

3. When you have calculated your initial equilibrium, use 
ADVANCED_OPTIONS T-ZERO.  

4. When prompted, specify the names of the two target phases for which the 
T0 temperature (where the phases’ Gibbs energies are equal) is to be 
calculated. 

5. If the T0 temperature between the two target phases is calculated, this 
temperature (in Kelvin) is shown in the Console window.   

6. If you want to do a stepping calculation based on this initial T0 
temperature calculation, then use SET_AXIS_VARIABLE to specify which 
state variable to use as the stepping variable. This is done the same way as 
when you calculate a normal property diagram.  

When a T0 temperature simulation is run, you cannot set temperature as 
the stepping variable. 
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7. Use STEP T-ZERO to initiate the stepping calculation. You are prompted to 
specify the names of the target phases for which the T0 temperature is 
calculated. 

During the STEP T-ZERO calculation procedure, the calculated T0 values are 
presented next to the stepping variable. For example, part of the output 
might look like this: 

Phase Region from   1.000000E-01 for: 

BCC_A2 

FCC_A1 

1.000000E-01         940.24 

9.250000E-02         941.20 

2.500000E-03         977.61 

7.500000E-09         979.34 

When the stepping calculation has finished, you can move to the POST 
module and plot the T0 line against the stepping composition variable or 
another varying axis value. Or you can impose the calculated T0 line onto a 
normal phase diagram.  

 See Examples 23 and 41 in Console Mode Examples.  

 Also see Console Mode Visualisation. 
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12. Paraequilibrium 
A paraequilibrium is a partial equilibrium where one interstitial component 
(such as carbon C and nitrogen N) in a multicomponent alloy can diffuse much 
faster than the other components (the substitutional elements, including the 
matrix element and alloying elements). The chemical potential for the 
interstitial component in two partially equilibrated phases is equal in such a 
case, but this is not true for the other components. In such a paraequilibrium 
state, it is possible to have a transformation that is partly without partitions, 
where a new phase of the mobile component can form with different content 
but where the slowly diffusing components retain their compositions.  

A paraequilibrium calculation is useful when, for example, you want to study 
phase transformations in systems with large differences in the diffusivities of 
different elements. Transformations occurring under paraequilibrium states 
can be much more rapid than if full local equilibrium holds at the phase 
interface.  

 Also see Calculating a Paraequilibrium for step-by-step instructions. 

 See Example 42 in Console Mode Examples. 

 Calculating a Paraequilibrium 

This topic describes both how to calculate an initial paraequilibrium with two 
target phases, and how to base a stepping calculation on this initial calculation. 

Before you do any paraequilibrium calculations, you must have defined your 
initial alloy system and be in POLY. The initial overall composition must have 
appropriate settings for the desired paraequilibrium calculation for the two 
target phases.  

1. Use SET_CONDITION to set the conditions of your calculation just like 
when you calculate an ordinary equilibrium. 

2. Use CHANGE_STATUS to set the status of the chosen interstitial 
components to SPECIAL. For example, if C is an interstitial component, 
enter:  

CHANGE_STATUS COMPONENTS C=SPECIAL 

This gives you a clear picture on u-fractions of the substitutional and 
interstitial components, which are different from the overall composition 
in the system. The SPECIAL status means that the specified components 
are not included in summations for mole or mass fractions. Therefore, all 
the composition variables plotted from paraequilibrium calculations are u-
fraction related quantities. 

3. Use COMPUTE_EQUILIBIRUM to run the calculation. 

4. When you have calculated your initial equilibrium, use 
ADVANCED_OPTIONS then choose Paraequilibrium to perform the 
paraequilibrium calculation.  

5. Specify the names of the target phases of the paraequilibrium state. For 
example, FCC#1 BCC and FCC#2 M23C6. 
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Both phases must have similar interstitial/vacancy sublattices that the fast-
diffusion interstitial components occupy. Both target phases should have 
phase constitution definitions that cover all the defined substitutional and 
interstitial components of the current alloy system. 

6. Specify the names of one or more fast-diffusing components. These 
components must be located on the interstitial/vacancy sublattices in both 
of the chosen phases. 

Interstitial components (for instance C and N combined) may have 
significantly different behaviours depending on how they are partitioned in 
different structured phases.  

If the paraequilibrium between the two specified phases is successfully 
calculated, then a message is displayed, for example:  

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-
02 N = 4.1548129E-03 

NP(BCC) = 0.6414 with U-fractions C = 7.10061E-
04 N = 2.3781027E-04 

All other compositions are the same in both 
phases 

The first two lines show the phase amounts expressed in mole-percent 
[NP(phase)] and the contents of the interstitial components C and N in 
each phase. These contents are expressed in u-fractions. The third line 
states that the compositions of the matrix component and all the 
remaining compositions (regarding substitutional components) are equal 
in the two target phases at the paraequilibrium state. 

7. If you want to do a stepping calculation based on this initial 
paraequilibrium, then use SET_AXIS_VARIABLE to specify which state 
variable to use as the stepping variable. This is done exactly in the same 
way as when you calculate a normal property diagram. 

8. Use STEP_WITH_OPTIONS then choose Paraequilibrium to initiate the 
stepping calculation. You are prompted to specify the names of the target 
phases of the paraequilibrium states as well as the fast-diffusing 
components.  

The stepping calculation is performed, and the different phase regions are 
listed with columns for the value of the stepping variable, the amounts of 
the two target phases, the u-fractions of interstitial(s) in each of the two 
phases, and the LNACR value(s) of the interstitial component(s). The 
following figure is an example: 
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It is possible to now move to the POST module and plot some of the results 
of the calculation.  

 For an example of a paraequilibrium calculation and how it can be 
plotted, see Example 23 in Console Mode Examples. 
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13. Potential Diagrams 
• About Potential Diagrams 
• Calculating a Potential Diagram 
• Calculating a Potential Diagram with Different Pressure 

 About Potential Diagrams 

If you have a metal-oxide/sulphide-gas interaction system, you might want to 
calculate a so-called potential phase diagram given certain temperature and 
pressure. A potential diagram uses the activities of two major species in the 
gaseous mixture phase as mapping variables. The activities (that is, the 
fugacities at 1 bar) of these two species are typically set as the X- and Y-axis 
when the diagram is plotted. The phase relations between the gaseous mixture 
and various metal forms, metal-oxides, metal-sulphides, or other metal-
bearing solids, are represented by different fields controlled by these two 
potential quantities.  

This section describes how to calculate such potential diagrams with the 
POTENTIAL_DIAGRAM module (short name, the POTENTIAL module), and how 
to later modify the pressure of such a calculation in POLY.  The calculation 
done by the POTENTIAL module always assumes a pressure of 1 bar. 

 Calculating a Potential Diagram 

You need access to a substance or solution database that contains a gaseous 
mixture phase, metals (or alloys), and solids such as metal-oxides, sulphides, 
sulphates, carbonates, silicates, nitrides or nitrates (stoichiometric or solution 
phases). You can always use the TC Public Substances Database (PSUB), which 
is distributed with the Thermo-Calc program for free. It contains the six 
elements Fe, Cu, H, O, S and N. 

1. Use GOTO_MODULE POTENTIAL to enter the POTENTIAL module. 

2. Specify which substance or solution database to use. Any substance or 
solution database can be used that has a gaseous mixture phase, metals 
(or alloys), and solids such as metalxides, sulphides, sulphates, carbonates, 
silicates, nitrides, and nitrates (stoichiometric or solution phases).  

3. Specify the matrix element (a metal) and the two gaseous species that 
define you metal-gas interaction system. The names of these components 
must be available in the database you are using. 

4. Set the temperature (in Kelvin). (The pressure is always 1 bar.) 

A potential diagram with the activities of the two gaseous species as 
mapping variables is calculated. These mapping variables are also set as 
the axis variables in the plotted diagram.  

 The following is from example 35 in Console Mode Examples. 
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A POLY3-file is also automatically saved in the current working directory 
with the default name POT.POLY3. 

5. When the diagram is plotted, it opens the POST module where you can 
modify the plotted diagram in any way you like.  

 Calculating a Potential Diagram with Different Pressure 

It is possible to modify both the calculation and the plotted diagram that the 
POTENTIAL module generates in the POLY and POST modules. You can do this 
by opening a POLY3-file with the results from a POTENTIAL module calculation 
in either POLY or POST. You can modify the calculation in the same way that 
you can modify any ordinary mapping calculation or phase diagram. For 
example, this is useful for calculating a potential diagram at a pressure other 
than 1 bar. 

You must have calculated a potential diagram already, and have the saved 
POLY3-file available. 

1. Use GOTO_MODULE POLY to enter the POLY module. 

2. Use READ, followed by the name of the POLY3-file that contains the results 
of the potential diagram calculation that you want to modify.  

This opens the workspace file and loads the previous settings and results. 
The activities of the two gaseous species is now part of the conditions, and 
these conditions are set as the mapping variables. 

3. Use SET_CONDITION to specify the pressure under which you want the 
potential diagram to be calculated. For example, to set the pressure to 
1000 bar, enter: 

SET_CONDITION P=1e8 

4. Use COMPUTE_EQUILIBRIUM to compute the initial equilibrium. 

You may also want to use ADD_INITIAL_EQUILIBRIUM to calculate some 
additional equilibria that the mapping calculations are based on.  
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5. Use MAP to perform the mapping calculations. 

6. Use GOTO_MODULE POST to enter the POST module to set conditions for 
visualization and to plot the diagram. 
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14. Aqueous Solutions 
• About Aqueous Solutions 
• Calculating a Pourbaix Diagram 
• Plotting Additional Aqueous Solution Diagrams 
• Stepping Calculations in an Aqueous Solution 
• Pourbaix Examples TCEX40, 40A to 40E, and TCEX53 

 About Aqueous Solutions 

Heterogeneous equilibrium calculations involving aqueous solutions are not 
different from other equilibrium calculations, but the setup of the equilibrium 
conditions and the reference states of the system is more complex. For 
example, the pH and Eh values of the aqueous solution phase are normally 
complex functions of bulk composition, temperature and pressure conditions.  

For some simple systems, thermodynamic approximations of pH-Eh 
calculations can be used. But Thermo-Calc also has comprehensive 
thermodynamic models and databases for various non-ideal solution phases. 
These let you accurately calculate pH and Eh property diagrams (and many 
other types of property diagrams) in complex aqueous solutions in a variety of 
conditions.  

A Pourbaix diagram is a pH-Eh phase diagram where the tie-lines are not in the 
plane. The chemical potentials or activities of two system components (H+ and 
EA) are used as mapping variables and the pH and Eh quantities are normally 
plotted on the X- and Y-axes of the diagram. You can use many other 
properties as axis variables in various property diagrams for the interaction 
system at a specific temperature and pressure. The phase relations between 
the aqueous solution and various metal forms, oxides, hydroxides, sulphides, 
sulphates, nitrates, silicates, carbonates and other solids, or gaseous mixtures, 
are represented as different fields defined by acidity and electric potential.  

You can calculate Pourbaix diagrams with the Pourbaix module. The 
compositional definition and variations and the basic solvent and electron 
components H2O, H+1 and ZE are automatically determined by the aqueous 
solution phase in the Pourbaix module. These key components are defined as 
follows:  

Component Component 
status 

Reference state Ref-T(K) Ref-P(Pa) 

H2O ENTERED AQUEOUS   *  100000  

H+1 ENTERED SER   

ZE   ENTERED REFERENCE_ELECTRODE * 100000 

Besides the aqueous solution phase, your system may also contain a gaseous 
mixture phase. Other neutral and charged gaseous species may also be 
constituents. For multicomponent systems there are normally also some 
interacting solid phases (stoichiometric or solution) as the so-called secondary 
phases. These are typically the matrix and/or precipitate phases in the alloys of 
interest.  
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Some databases have been specially developed for the Pourbaix module’s 
diagram calculations. Such a database contains all necessary phases, i.e., an 
aqueous solution phase, a gaseous mixture phase, some alloy solid solution 
phases and some secondary solid phases. Databases developed for the 
Pourbaix module include PAQ (TCS Public Aqueous Solution Database) or PAQS 
(TGG Public Aqueous Solution Database). 

If such a dedicated Pourbaix module is not used, then an aqueous solution 
database such as TCAQ (TC Aqueous Solution Database), AQS (TGG Aqueous 
Solution Database), or any user-specified aqueous databases can be used. This 
database contains at least the AQUEOUS and REFERENCE_ELECTRODE phases. 
The aqueous solution database needs to be appended with additional required 
data and phases, such as interacting alloy (solid) solution phases and 
secondary (solid and liquid) phases. Additional data is from one or more 
databases, such as SSUB/SSOL/TCFE or other substances/solutions databases. 

 Calculating a Pourbaix Diagram 

The POURBAIX module lets you construct Pourbaix diagrams and other types 
of property diagrams for heterogeneous interaction systems with aqueous 
solution phases.  

When calculating a Pourbaix diagram, you need to have a database with an 
aqueous solution phase (that is, a phase with water as the dissolving solvent 
and with aqueous cation/anion and complex species as the dissolved solutes). 
Due to restrictions of aqueous solution models (SIT, HKF, Pitzer) used in the 
Thermo-Calc software, the aqueous solution database must be designed in the 
same Thermo-Calc database format as that used in the PAQ, PAQS, TCAQ and 
AQS databases for the aqueous solution phase.  

Pourbaix diagram calculations are done in the advanced Pourbaix module. 

1. At the SYS prompt, enter GOTO_MODULE POURBAIX. 

2. At the Need any instruction on the POURBAIX module? prompt 
press <Enter> to skip or enter Y to learn more. 

3. Press <Enter> at the prompt Enforce a PAUSE after plotting 
when running a MACRO?. 

4. Press <Enter> to accept the default 1 to Start a completely new 
POURBAIX diagram calculation or enter 3 to Open an old file 
and make another POURBAIX calculation. 

To choose 3, you must have already done a Pourbaix calculation and have 
it saved in a POLY3-file. The new calculation uses the same system 
definition as the previous calculation, but the other conditions, such as the 
bulk composition, temperature and pressure, can be modified in the next 
step. 

5. Type Y or N to set whether to Consider the GAS phase (gaseous 
mixture phase) in the calculation. 

The gaseous mixture phase should at least contain H2O, O2 and H2. If a 
GAS phase is not considered, then only the interactions between the 
aqueous solution phase and various solid phases (alloy phases and 
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secondary phases) are calculated. Such a calculation may not accurately 
present all the heterogeneous interactions. Some secondary phases are 
therefore usually needed. Such phases exist in the PAQ or PAQS Public 
Aqueous Solution Databases. They can also be appended from the 
SSUB/SSOL/TCFE or other appropriate substances/solutions databases. 

6. Type Y or N to set whether to Use single database (Y) or a multiple 
database (N).  

If you choose to use a single database, at the Combined Database: 
/PAQ2/ prompt specify a database that is specially developed for the 
Pourbaix module’s diagram calculations.  

If you choose to use a multiple database, then you are prompted to specify 
an aqueous solution database and to append any additional required data 
and select necessary phases, such as various interacting alloy (solid) 
solution phases, and secondary (solid and liquid) phases, for example. 

7. Specify all your solutes and the molality of each solute when prompted to 
do so. This can be done in terms of elements (such as Fe, Ni, Na, Cl, C or S) 
or arbitrary complex species (such as NaCl, CO2, CoCl3, Fe0.93S, NaSO4-1, 
or H2SO4). You can enter the element/species and the molarity on one line 
(for an example, NaCl 2.5). 

The first letter of the element abbreviation must always be upper case. 
Any second letters must be lower case. When you have finished your 
specification, press <Enter> when asked to specify Next solute.  

The definition of your system and its initial bulk composition is now 
presented. 

8. Type Y to confirm the defined system and its bulk composition. 

The thermodynamic data for your system is now retrieved from the 
database(s) chosen. 

9. Answer the questions that you are prompted regarding various parameters 
of your calculation. You are asked to do any of the following: 

• Reject phase(s)or Restore phase(s) 
• Check for miscibility gaps on any phase (Should any phase have 

a miscibility gap check?) 
• Enforce the Global Minimization Technique in 

calculations? 
• Save all functions, variables and tables in POLY3 

file? 
• Set numerical limits on the calculation 
• Confirm defined conditions? 
• Accept the default settings for two mapping 

variables 
10. The Pourbaix calculation starts. Answer the question Any missing 

phase boundary you could possibly think of? Type Y or N to 
set whether you want to add starting points to the calculation. If you 
suspect that the calculation has missed some phase boundaries, this may 
help the program to detect them. 
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11. Answer questions about how the diagram is plotted and how to save the 
results of your calculation. You are asked to do any of the following: 

• Change the pH/Eh steps for smoother curves? 
• Zoom in on a specific region of the diagram 
• Change the curve-label option for the diagram 
• Add label-texts onto the Pourbaix diagram 
• Change the subtitle of the diagram 
• Change the axis-texts 
• Further refine the diagram in the POST Module 
• Print the diagram (save a Hard copy of the diagram) 
• Save the X-Y coordinates of curve on a text file 
• Modify the diagram 
• Calculate and plot another Pourbaix diagram (Any more 

diagram?) 

 Plotting Additional Aqueous Solution Diagrams 

When you have calculated a Pourbaix diagram, you can plot additional 
diagrams based on the results of the same calculation, but with different axis 
variables than Ph and Eh. 

The following variables can be plotted along the X- and Y-axes. Use the 
abbreviations of the variables when you specify what the X- and Y-axes 
represent in a diagram. In the table, AQsp refers to the name of a specific 
aqueous species. The asterisk (*) can be used as a wild card character for all 
such species. If neither AQsp nor * is entered in parenthesis, then all species 
are searched. 

Aqueous Solution Variable Abbreviations 

Variable Abbreviation 

Acidity pH 

Electronic Potential (V) Eh 

Electronic Affinity  (kJ) Ah 

Electronic Activity (log10ACRe) Pe 

Ionic Strength IS 

Total Concentration TM 

Activity of Water Aw 

Osmotic Coefficient Oc 

Mole Fractions of Aqueous Species MF(AQsp) 

Molalities of Aqueous Species ML(AQsp) 

Activities of Aqueous Species AI(AQsp) 

Activity Coefficients of Aqueous Species RC(AQsp) 
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You must have plotted a Pourbaix diagram to plot a diagram with other 
variables than Ph and Eh on the Y-axis and the X-axis. You can either plot such 
additional diagrams directly after having finished the plotting and 
saving/printing of a Poubaix Ph-Eh diagram or by choosing option 2 (Open an 
old file and plot other property diagrams) when you enter the POURBAIX 
module and opening a POLY3 workspace file. 

How to Plot an Aqueous Solution Diagram 

1. Type Y when prompted whether to plot any more diagrams, or select 
option 2 when you enter the POURBAIX module. 

2. Specify which variable you want the X-axis to represent. Use the 
abbreviation specified in the preceding table. When you specify the name 
of an aqueous species, you can use the asterisk (*) to select all species. 

3. Specify which variable you want the Y-axis to represent. 

The diagram is then automatically plotted. 

4. Answer questions about how the diagram is plotted and how to save it. 
You are asked to do any of the following: 

• change the axis-type (linear, logarithmic or inverse) on the X-axis or 
Y-axis 

• zoom in on a specific region of the diagram 
• change the curve-label option for the diagram   
• add label-texts onto the Pourbaix diagram 
• change the subtitle of the diagram 
• change the axis-texts  
• refine the diagram in the POST Module 
• print the diagram (save a hard copy) 
• save the X-Y coordinates of curve on a text file 
• modify the plotted diagram 
• calculate and plot another aqueous solution diagram 

 Stepping Calculations in an Aqueous Solution 

When you have calculated a Pourbaix diagram, you can use the saved results 
of the calculation (the POLY3-file), and make a property diagram based on 
stepping calculation. 

Performing the stepping calculation overwrites all the previous settings 
and stepping results on the POLY3-file. To avoid this, use SAVE WORKSPACE to 
create a new workspace. 

You can use any of the following state variables as a stepping variable. 

State variable Abbreviation 

Temperature (K) T 

Pressure (bar) P 

Acidity pH 

Electronic potential (V) Eh 
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State variable Abbreviation 

Mole number of a dissolving component 
(such as Fe, Na, Cl, or NaCl) in 1 kg of water. 

N(Comp) 
(for example, N(Fe)) 

Since the program normally sets the calculated initial equilibrium point as the 
starting point, the minimum value for the stepping variable must be specified 
as smaller or equal to the specific initial condition, and the maximum value as 
larger or equal to that condition. If pH is set as the stepping variable, the 
program automatically calculates the equilibrium constant in logarithmic 
(log10Ka) of the electrolysis reaction H2O (water) = H+ + OH- for the real 
aqueous solution under the current temperature-pressure-composition 
conditions, and thus this constant log10Ka value is considered as the highest 
pH in specifying the maximum value along stepping. Subsequently, confirm or 
modify an increment factor with a default value; for pressure and mole of a 
component, specify the step in logarithmic (log10P or log10N).   

You must have plotted a Pourbaix diagram before making a stepping 
calculation on an aqueous solution. 

Performing a Stepping Calculation 

1. Use GOTO_MODULE POURBAIX to enter the POURBAIX module. 

2. Type 4 to Open an old file and make another STEPPING calculation. 

3. Choose which POLY3-file to load. 

4. Specify the conditions of the calculation by answering the questions that 
follows.  

The system definition is the same as in the previous Pourbaix calculation, 
but you can modify conditions such as bulk composition, temperature and 
pressure, and change some component definitions if necessary. 

5. Specify which variable to use as the stepping variable (see the preceding 
table), its minimum and maximum value, and the length of each 
incremental step. 

The settings and stepping results are written to the opened POLY3-file, and 
a first default property diagram is plotted. 

 Pourbaix Examples TCEX40, 40A to 40E, and TCEX53 

TCEX40 

• Using PAQ2 or PAQS2 database;  
• For the Fe-H2O-NaCl heterogeneous interaction systems  
• With the Main Option 1  
• Using the Single-Database Option, i.e., retrieving data from the PAQ2 [TCS 

Public Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous 
solution model] or PAQS2 [TCS Public Aqueous Solution Database, v2.4; 
using the Complete Revised HKF aqueous solution model]; both of which 
contain an AQUEOUS solution phase and REF_ELECTRODE phase (as a 
reference for electron in aqueous electrolyte systems), as well as some 
data for various solid phases (solution or stoichiometric) and gaseous 
mixture phase. The PAQ2 and PAQS2 are specially designed for 
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demonstrations of calculations of the so-called Pourbaix diagrams (i.e., pH-
Eh plots) and other types of phase diagrams or property diagrams in some 
aqueous-bearing multicomponent heterogeneous interaction systems 
within the limited chemical framework of Fe-Co-Cr-Ni-C-N-S-H2O-NaCl, via 
the Single-Database Option in the advanced POURBAIX module or through 
the normal TDB-GES-PLOY-POST routine. 

To further run the following Main Options:  

Main Option 2 for plotting many other property diagrams of the calculated 
interaction system; 

Main Option 3 for making another POURBAIX calculation of the same chemical 
system but under a different P-T-X condition; 

Main Option 4 for making a POLY3 STEPPING calculation of the same chemical 
system but varied with only one independent variable; 

** The Main Options 2, 3 and 4 are not illustrated in this TCEX40 example. 

Five more examples (TCEX40A, TCEX40B, TCEX40C, TCEX40D and TCEX40E) are 
also provided to demonstrate various options and features in the POURBAIX 
module and to show more advanced applications of the TCAQ2 and AQS2 
aqueous solution databases [in the Multiple-Database Option, i.e., with 
appended data from the SSOL5 and SSUB5 databases].  

TCEX40A 

• Option 1 
• Using the Single-Database Option, i.e., retrieving data from the PAQ2 [TCS 

Public Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous 
solution model] or PAQS2 [TCS Public Aqueous Solution Database, v2.4; 
using the Complete Revised HKF aqueous solution model]; both of which 
contain an AQUEOUS solution phase and REF_ELECTRODE phase (as a 
reference for electron in aqueous electrolyte systems), as well as some 
data for various solid phases (solution or stoichiometric) and gaseous 
mixture phase. The PAQ2 and PAQS2 are specially designed for 
calculations of the so-called Pourbaix diagrams  (i.e., Eh-pH plots) and 
other types of diagrams in aqueous-bearing multicomponent 
heterogeneous interaction systems, via the Single-Database Option in the 
POURBAIX module or through the normal TDB-GES-PLOY-POST routine. 

• A POLY3 file called POURBAIX.POLY3 is automatically saved.  
• For the purposes of recalling this file in other Main Options (as in the 

TCEX40B, TCEX40C & TCEX40D), the POURBAIX.POLY3 has to be renamed 
or copied as another file name (in this particular example, as 
TCEX40A.POLY3, and TCEX40B.POLY3, TCEX40C.POLY3 & TCEX40D.POLY3). 
Note that the renaming or copying has to be done outside TCCS, otherwise 
the POLY3 file structure will be destroyed. However, under 
WindowsNT/2000/XP environments, one can use MS-DOS commands to 
do so, e.g., @copy POURBAIX.POLY3 TCEX40B.POLY3 

• The Main Option 1 also provides the opportunity to plot many property 
diagrams along phase boundaries, after the default Pourbaix diagram is 
generated and refined (not necessarily going through the Main Option 2).  
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TCEX40B 

• Demonstration of the Main Option 2 Graphical Processing (by plotting 
more diagrams); various options for refining a plotted diagram (including 
direct interactions with the POST Module); Graphical processing of related 
property diagrams. 

• Reading a previously saved POURBAIX.POLY3 file (or renamed as another 
name, for instance, the TCEX40B.POLY3), and then plotting some property 
diagrams for the previously calculated system.  

• The loaded POLY3 file will not be modified by this Main Option. It is thus 
not necessary to save the file in another name; however, it is still 
recommended that the user to copy the TCEX40A.POLY3 (or 
TCEX40E.POLY3) as TCEX40B.POLY3 before the Main Option 2 is executed 
in this particular example.  

TCEX40C 

• Demonstration of the Main Option 3 Calculation (by modifying T-P-X 
conditions); graphical processing of a Pourbaix diagram. 

• Reading a previously saved POURBAIX.POLY3 file (or renamed as another 
name, for instance, the TCEX40C.POLY3), and then making another 
POURBAIX-type calculation and graphical processing of a new Pourbaix 
diagram for the same chemical system but under a different P-T-X 
condition.  

• The loaded POLY3 file will be rewritten according to the T-P-X settings in 
the new POURBAIX-type calculation. It is thus recommended to save the 
file in a new name outside of TCCS before this Main Option is proceeded 
(in this particular example, the TCEX40A.POLY3 is copied to 
TCEX40C.POLY3). 

• The Main Option 3 also provides the opportunity to plot many property 
diagrams along phase boundaries, after the default Pourbaix diagram is 
generated and refined (not necessarily going through the Main Option 2).  

TCEX40D 

• Demonstration of the Main Option 4 Calculation (by utilizing various 
stepping variables); graphical processing of related property diagrams. 

• Reading a previously saved POURBAIX.POLY3 file (or renamed as another 
name, for instance, the TCEX40D.POLY3), and then making some normal 
POLY3 STEPPING CALCULATIONs.  

• The loaded POLY3 file will be rewritten according to the T-P-X and stepping 
variable settings in the stepping calculation. It is thus recommended to 
save the file in a new file name outside of TCCS before this Main Option is 
proceeded (in this particular example, the TCEX40A.POLY3 is copied to 
TCEX40D.POLY3). 

• The resulting POLY3 file (in this example, TCEX40D.POLY3) can be 
subsequently called by a Main Option 2 for plotting more property 
diagrams, or by another Main Option 4 for making other stepping 
calculations.  

• The Main Option 4 also provides the opportunity to plot many property 
diagrams after the default Pourbaix diagram is generated and refined (not 
necessarily going through the Main Option 2).  
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• Exploration of the possibility of modifying the definitions for some desired 
system-components, through the direct and internal POURBAIX-POLY3 
intersection, for a STEPPING (and/or MAPPING) calculation inside the 
POURBAIX Module. 

TCEX40E 

• Demonstration of the Main Option 1 Calculation with the Multiple-
Database Option; graphical processing of a Pourbaix diagram. 

For a more complex application than in Example 40A. 

This example requires licenses to three types of commercial Thermo-Calc 
databases otherwise it cannot be run, i.e.,  

• A: TCAQ2 (TCS Aqueous Solution Database, v2.5; SIT model) or AQS2  
(TGG Aqueous Solution Database, v2.5; HKF model);  

• B: SSUB4 (SGTE Pure Substances Database, v4) or TCMP2 (TCS 
Materials Processing Database, v2);  

• C: SSOL4 (SGTE Alloy Solutions Database, v4) or TCFE6 (TCS Steels/Fe-
Alloys Database, v6) or ALIKE.  

• This particular example uses the multiple-database combination of 
TCAQ2+SSUB4+SSOL4; among them, TCAQ2 database contains only an 
AQUEOUS solution phase (using the SIT model) and REF_ELECTRODE phase 
(as a reference state for electron in aqueous electrolyte systems), SSUB4 
database is appended for the GASeous mixture phase and some pure solid 
phases (so-called secondary phases formed during aqueous-involving 
interaction processes), and SSOL database is also appended for various 
solid solution phases.  

• A POLY3 file called POURBAIX.POLY3 is automatically saved. By reading this 
POURBAIX.POLY3 file (or renamed as another name), one can further run 
the following Main Options:  Main Option 2 for plotting many other 
property diagrams of the calculated interaction system; Main Option 3 for 
making another POURBAIX calculation of the same chemical system but 
under a different P-T-X condition; Main Option 4 for making a POLY3 
STEPPING calculation of the same chemical system but varied with only 
one independent variable; The Main Options 2, 3 and 4 are illustrated in 
the TCEX40B, TCEX40C and TCEX40D examples. 

• For the purposes of recalling this file in other Main Options (as in the 
TCEX40B, TCEX40C & TCEX40D), the POURBAIX.POLY3 has to be renamed 
or copied as another file name (in this particular example, as 
TCEX40A.POLY3, and TCEX40B.POLY3, TCEX40C.POLY3 & TCEX40D.POLY3). 
Note that the renaming or copying has to be done outside TCCS, otherwise 
the POLY3 file structure will be destroyed. However, under Windows 
environments, one can use MS-DOS commands to do so, e.g., @copy 
POURBAIX.POLY3 TCEX40B.POLY3 

• The Main Option 1 also provides the opportunity to plot many property 
diagrams along phase boundaries, after the default Pourbaix diagram is 
generated and refined (not necessarily going through the Main Option 2).  

• The POURBAIX module inside the TCCS software also accepts the AQS2 
aqueous solution database (using the complete Revised HKF model) in the 
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Multiple-Database Option, in addition to the TCAQ2 aqueous solution 
database (using the SIT model).  

IMPORTANT NOTES FOR ACTIONS AFTER TCEX40A OR TCEX40E IS 
EXECUTED:  

In order to be able to subsequently run the TCEX40B (Main Option 2), 
TCEX40C (Main Option 3) and TCEX40D (Main Option 4), which open the 
previously-saved POURBAIX-type calculation POLY3 file, the user should 
make four copies of the resulting POURBAIX.POLY3 as TCEX40A.POLY3, 
TCEX40B.POLY3, TCEX40C.POLY3 and TCEX40D.POLY3.  

However, this has to be properly done outsides of the TCCS software after 
the TCEX40A is executed. The reason is that, if saving the POLY3 workspace 
of the POURBAIX calculation results in the POLY3-module monitor 
(through the command sequence "GO PLOY3" and "SAVE TCEX40A.POLY3 
Y"), all the initial equilibrium points and the mapping/stepping calculation 
results will be lost, and parts of the POLY3 file structure (e.g., some 
definitions of the previously defined POURBAIX-type calculation system) 
will be destroyed. In principle, before executing any Main Option (for 
calculations and graphical processing), it is highly recommended that the 
user shall save/rename/copy the previously-generated POLY3 file as 
another POLY3 file. Only in this way, it can avoid destroying the previous-
saved POURBAIX-type calculation results.   

Under Windows DOS-session (outside TCCS): 

• copy POURBAIX.POLY3 TCEX40A.POLY3 (or TCEX40E.POLY3) 

• copy POURBAIX.POLY3 TCEX40B.POLY3 

• copy POURBAIX.POLY3 TCEX40C.POLY3 

• copy POURBAIX.POLY3 TCEX40D.POLY3 

or inside TCCS (under Windows NT/2000/XP, but not Windows 95/98/ME):  

• @copy POURBAIX.POLY3 TCEX40A.POLY3 (or TCEX40E.POLY3) 

• @copy POURBAIX.POLY3 TCEX40B.POLY3 

• @copy POURBAIX.POLY3 TCEX40C.POLY3 

• @copy POURBAIX.POLY3 TCEX40D.POLY3 

Under Linux/UNIX platforms (outside TCCS): 

• cp POURBAIX.poly3 TCEX40A.poly3 (or TCEX40E.poly3) 

• cp POURBAIX.poly3 TCEX40B.poly3 

• cp POURBAIX.poly3 TCEX40C.poly3 

• cp POURBAIX.poly3 TCEX40D.poly3 

TCEX53 

• Using PAQ2 or PAQS2 database; for the Fe-X-H2O-NaCl heterogeneous 
interaction systems (X = Cr-Ni-Co) 
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Note: The PAQ2 (TCS Public Aqueous Solution (SIT) Database, v2.4; using the 
SIT aqueous solution model) or PAQS2 (TCS Public Aqueous Solution Database, 
v2.4; using the Complete Revised HKF aqueous solution model) contains an 
AQUEOUS solution phase and REF_ELECTRODE phase (as a reference for 
electron in aqueous electrolyte systems), as well as some data for various solid 
phases (solution or stoichiometric) and gaseous mixture phase. Therefore, it 
can be used, via the Single-Database Option in the POURBAIX module or 
through the normal TDB-GES-PLOY-POST routine, for calculations of the so-
called Pourbaix diagrams (i.e., pH-Eh plots) and other types of diagrams in 
aqueous-bearing multicomponent heterogeneous interaction systems. 

Note: The initial bulk composition of Fe-based alloy in this demonstrating 
calculation is just preliminarily assigned, in which the BCC_A2 and/or FCC_A1 
solution phase(s) are considered as of primarily interest. For practical 
calculations, one shall have more precise inputs for the initial bulk 
compositions of alloys. 
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15. Tabulation of Chemical Substances, Phases or 
Reactions 
The TAB module can be used to tabulate all kinds of thermodynamic functions 
of any type of substance, stoichiometric phase or solution phase, or reaction. 
The module can tabulate thermodynamic functions of pure stoichiometric 
phases or solution phases at fixed composition, as well as various kinds of 
partial derivatives for a pure stoichiometric phase or solution phase at a given 
composition.  

The TAB module begins by evaluating the most stable species of a substance in 
either a homogeneous state or in a reaction. Results are presented in a table 
or plotted as a graph. 

 Also see Tabulating a Reaction.  

A reaction tabulation presents you with the following properties, on rows 
representing different temperature levels: 

• Heat capacity change / Delta-Cp (Joule/K) in column 2. 
• Enthalpy change / Delta-H (Joule) in column 3. 
• Entropy change / Delta-S (Joule/K) in column 4. 
• Gibbs energy change / Delta-G (Joule) in column 5. 

Here is a screenshot of one such table: 

 
In the case of a tabulation of a substance or solution phase at a fixed 
composition, the properties presented are the heat capacity, enthalpy, 
entropy and Gibbs energy, rather than the degree of change in those 
properties.  

 Also see Tabulating a Substance or Solution Phase at Fixed Composition. 

You can add a 6th column to the table that shows the values of a property or 
user-defined function of your choice.  
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 Tabulating a Reaction 

A tabulation of a given chemical reaction provides you with data about the 
rate of change of the standard tabulation properties at various levels of 
temperature. You can also add a column for a property of your choice to the 
table. 

1. Use GOTO_MODULE TAB to enter the TAB module. 

2. If you want to add one thermodynamic functions to the tabulation 
calculation, which is present in a sixth column in the table, use 
ENTER_FUNCTION.  

You are prompted to enter the name of the column that is given at its 
head, and the function itself. The following state variables can be used to 
define the function: G, H, S, T, P, V and H298. 

3. Use TABULATE_REACTION followed by a formula that specifies of the 
reacting species and products to perform the tabulation calculation. The 
name of the elements must be entered in upper case letters only. 
Terminate the chemical reaction with a semi-colon. For example, you can 
enter: 

TABULATE_REACTION 3H2+N2=2N1H3; 

Elements that are designated with a single letter must be followed by a 
stoichiometry factor, even if this factor is 1. CO hence be interpreted as 
Cobalt rather than as carbon monoxide. Carbon monoxide is entered as 
C1O1 or O1C1. 

4. Set the pressure, the range of temperature that you want the tabulation to 
cover, and change in temperature between each row in the table. You can 
also specify if you want to output the calculation results to an EXP-file and 
whether you want any graphical output, and if so, which column you want 
to be plotted against temperature. 

The tabulation calculation is performed and you are given a table that 
shows the various properties at each temperature level within the range 
defined.  

If you have chosen to receive graphical output, then the Console Results 
window presents a graph that plots the column of you chose (on the Y-
axis) against temperature (on the X-axis). When this graph is plotted, you 
are now in the POST module, where you can modify the graph in various 
ways.  

 Tabulating a Substance or Solution Phase at Fixed 
Composition 

A tabulation of a substance or solution phase at fixed composition provides 
you with data about the standard tabulation properties at various levels of 
temperature for a given chemical reaction. You can also add one extra 
property column of your choice to the table. 

1. Use GOTO_MODULE TAB to enter the TAB module. 
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2. Use SWITCH_DATABASE to switch to a database that contains solution-
based data, such as TCFE for example.  

You cannot use the default SSUB database when tabulating substances or 
solution phases at a fixed composition. 

3. If you want to add one thermodynamic function to the tabulation 
calculation, which is present in a sixth column in the table, use 
ENTER_FUNCTION.  

You are prompted to specify the column header and the function itself. 
The following state variables can be used to define the function: G, H, S, T, 
P, V and H298. 

4. Use TABULATE_SUBSTANCE followed by the name of the substance or 
solution phase to perform the tabulation calculation. 

5. Set the pressure, the range of temperature that you want the tabulation to 
cover, and change in temperature between each row in the table. You can 
also specify if you want to output the calculation results to an EXP-file and 
whether you want any graphical output, and if so, which column you want 
to be plotted against temperature. 

The tabulation calculation is performed and a table shows the various 
properties at each temperature level within the defined range. 

If you have chosen to receive graphical output, then the Console Results 
window presents a graph that plots the column you chose (on the Y-axis) 
against temperature (on the X-axis). ). When this graph is plotted, you end 
up in the POST module, where you can modify the graph in other ways.  
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16. Console Mode Visualisation 
The results of a calculation in Thermo-Calc can be plotted by the post-
processor module, also called the POST module. The diagram is presented in 
the Console Results window. 

In the POST module, you can define and plot various kinds of diagrams based 
on a calculation. You can modify diagram type, which variables to plot on each 
axis and between which minimum and maximum values, append experimental 
data from an EXP-file, change labels and symbols in the diagram, zoom in on 
(and out from) a certain region in a diagram, etc. 

If you calculate a property or phase diagram in POLY, then you have to open 
the POST module yourself. If your calculation was performed by a response-
driven module such as SCHEIL or POURBAIX, then the plotting of a diagram 
based your calculation is part of the dialogue of questions and answers you 
have in that module (but under the hood, the response-driven module is 
actually utilizing the POST module to get the plotting done).  

• Plotting Diagrams 
• Modifying Diagrams 
• Saving Diagrams 
• Loading Saved Diagrams 

 Plotting Diagrams 

Plotting a diagram is to graphically represent how several variables (typically 
two variables) co-vary. Each axis in a property diagram or a phase diagram 
represents the value of one variable. The default variables represented by the 
X- and Y-axes are the following: 

• If you plot a diagram based on the results of a mapping operation (a phase 
diagram), then by default the X- and Y-axes represent the mapping axis 
variables 1 and 2 (set using SET_AXIS_VARIABLE in POLY).  

• If you plot a diagram based on the results of a stepping operation (a 
property diagram), then by default, the X-axis represents the stepping 
variable (set using SET_AXIS_VARIABLE in POLY) and the Y-axis represents 
the sum of the mole fractions of all phases (that is, NP(*)). 

How to Plot a Diagram 

To plot a diagram, you must have already made a stepping or mapping 
operation in POLY (or in some cases, made a calculation as part of some 
opening a response-driven module), and you must have entered the POST 
module.  

You use POST to enter the POST module (using GOTO_MODULE POST gives a 
NO SUCH MODULE message). The POST command is only available inside 
POLY. 

1. If you want to directly plot your diagram with the default variables 
represented by the X- and Y-axes, type PLOT and press <Enter>. This plots 
a property or phase diagram with the default variables represented at 
each axis. If you do not want to plot your diagram with these default 
variables, go to the next step.   
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2. Use SET_DIAGRAM_AXIS to set which variables to plot on the X-axis and 
the Y-axis. For example, if you want to plot a phase diagram with pressure 
on the Y-axis and temperature on the X-axis, type: 

SET_DIAGRAM_AXIS X T 

SET_DIAGRAM_AXIS Y P 

3. Use PLOT to plot your diagram. 

 Modifying Diagrams 

 Also see Changing Global Settings. 

Modifying a diagram amounts to changing the settings that determine how the 
POST module presents the calculated results and plots a new diagram. 
Suppose that you have already plotted a binary phase diagram with the 
mapping axis variables temperature and mole fraction of one of your 
components (the Fe component, say) on the X- and Y-axes. If you then want to 
modify your diagram so that the Y-axis instead represents, say, the mass 
fraction of Fe rather than the mole fraction, then you use SET_DIAGRAM_AXIS 
to set diagram axis Y to w(Fe), and then use PLOT again to plot the new 
diagram. 

There are many ways in which you can modify your diagram and how it is 
presented. Any modification made in the plot settings is taken into account the 
next time you use PLOT.  

The following are some of the modifications you can make.  

 Also see the Thermo-Calc Console Mode Command Reference. 

• Use SET_TITLE to set add a title or to change an already existing title. The 
title is displayed above the plotted diagram in the Console Results window. 

• Use ADD_LABEL_TEXT to add a label text that starts at a certain X- and Y-
coordinate. If you have plotted a phase diagram, then you can let Thermo-
Calc set the label text that specifies the names of the stable phases at that 
coordinate. 

 As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. 
For existing users who may have plots and files that use the LTEXT format, and 
especially when using Console Mode, the following examples show the 
command changes from LTEXT and its LaTeX equivalent: 

LTEXT vs LaTeX Commands for Labels 

Symbol or text 
format 

LTEXT LaTeX 

Subscripts in an 
axis text 

S-A-TEXT Y N Mole-fraction 
Al^DO2$O^DO3$ 

S-A-TEXT Y N \latex Mole-
fraction Al_2O_3 

Label with 
subscript 

add .13 .15 n c-ZrO^DO2$ add .13 .15 n \latex c-ZrO_2 

Greek symbol ADD .05 .50 N ^GRd$ ADD .05 .50 N \latex \delta 
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• Use SET_AXIS_TYPE to set whether the scale of an axis is linear, logarithmic 
or inverse. 

• Use SET_DIAGRAM_TYPE to plot a triangular diagram with the X-axis on 
the triangle’s base and the Y-axis on the triangle’s left side. Such a diagram 
is often useful if you want to plot the fractions of two components in a 
ternary diagram. 

• Use SET_SCALING_STATUS to modify the range of values that are displayed 
on an axis. In effect, you can use it to zoom in or out of the diagram. For 
example, to set the scale of the X-axis to range from 0 to 0 .3, type: 

SET_SCALING_STATUS X N 0 0.3 

The X specifies which axis to change the scaling on, the N turns off Thermo-
Calc’s automatic scaling, and 0 and 0.3 specifies the minimum and 
maximum values on the scale. You can turn on automatic scaling again by 
setting the second parameter to Y. 

• Use SET_LABEL_CURVE_OPTION to label each set of curves that have the 
same stable phases with a certain digit. A legend is also added, where you 
specify which phases each digit designates. The following screenshot 
shows how this might look: 

 

 Saving Diagrams 

When a diagram is plotted, there are several ways in which you can save it: 

• Use MAKE_EXPERIMENTAL_DATAFILE to save all the data about the 
plotted diagram in an EXP-file. An EXP-file is a plain text file that describes 
the diagram in the DATAPLOT graphical language.  For more information 
about DATAPLOT, search the online help or refer to the DATAPLOT User 
Guide. 
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Information about the underlying calculations that the diagram is based on 
is not saved in an EXP-file. 

• Use DUMP_DIAGRAM to save the diagram image to a PS, PDF, SVG, EMF, 
GIF, or PNG file. You are asked what format to save it in.  

• To save the diagram image in a variety of image file formats right click on 
diagram and choose Save Plot. 

• Use PRINT_DIAGRAM to print a hard copy of the diagram. 

 Loading Saved Diagrams 

If you have previously saved a diagram in an EXP-file, then you can load and 
superimpose the diagram on another diagram. Both the following command 
requires you to specify which prologue and dataset(s) that are loaded from an 
experimental data file.  

Use APPEND_EXPERIMENTAL_DATA to plot selected data from an 
experimental data file (EXP-file). If you have set the axes of the diagram 
already, the labels on the diagram are not changed when you plot the 
additional data from the EXP-file, irrespectively of the data in that file. 

Use QUICK_EXPERIMENTAL_PLOT to plot selected data from an experimental 
data file (EXP-file). If you have set the axes of the diagram already, these 
settings are overwritten with the axes settings from the EXP-file.  
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17. Changing Global Settings 
In the Options window (select Tools →Options) you can globally set general 
settings for Graphical Mode as well as default settings for any new activities 
for both Graphical Mode and Console Mode.  

• General 
• Graphical Mode - Default Units 
• Graphical Mode – Activities 
• Graphical and Console Mode-Plotting 
• Console Mode-Default Appearance 

 General 

These settings are for both Graphical and Console modes. To open this 
window, from the main menu select Tools →Options. 

 
General Global Settings 

Setting Options 

Tooltips enabled Select whether to turn on tooltips information. By default the 
Tooltips enabled check box is selected. This displays a small 
text box when you hover the cursor above some buttons or 
other items.   

Localization To change the GUI language from the Localization list choose 
English (the default), Swedish, Spanish, German, Russian, 
Chinese or Japanese.  

Look and feel To change the Look and feel of the GUI layout, choose 
Windows (the default), Metal, Nimbus, CDE/Motif or 
Windows Classic. 

Database 
directory 

In the Database directory field, specify the path to the 
directory that contains the data directory. This is where the 
Thermo-Calc database directory is located. For example, the 
default for a Windows installation is: 
C:\Program Files\Thermo-Calc\<version>\ 

Do not specify the path to where the database files are 
found (that is, in the data directory).  

 Also see Modifying the Database Directory Path: 
Important Note. 

Log level Select the level and type of information to display in the Event 
Log window using the Log level slide bar. Choose from a 
Debug, Info, Warning or Error level of detail.  
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Setting Options 

Check update 
interval 

From the Check update interval list, choose not to check 
(Don’t check, the default) or On startup. You can also 
manually check for updates – choose Help →Check for 
update. 

Reset to original 
settings 

In the lower corner of the window, click the Reset to original 
settings button to restore the original settings. You may have 
to expand the window to view the button. 

Modifying the Database Directory Path: Important Note 

Any licensed databases purchased from Thermo-Calc Software are encrypted 
in files with the extension .tdc; these files cannot be edited. Unencrypted 
databases have the file extension .tdb. For example, user-defined database 
files can be modified. 

All databases located in the database directory path are cached after they have 
been read once to ensure that the standard databases included with Thermo-
Calc are loaded quickly and efficiently into the program. If you modify your 
own user-defined database, or if you choose to edit an unencrypted database, 
it is recommended that you create a separate directory to store these 
database files. This way the most recent version of the user-defined or edited 
databases are loaded into the program when the System Definer is performed. 

 Graphical Mode - Default Units 

To open this window, from the main menu select Tools →Options and click the 
Default Units tab. 

 
Default Units - Settings in Graphical Mode 

Setting Options 

Temperature Kelvin (the default), Celsius or Fahrenheit 

Pressure Pascal (the default), Atmospheres or Bar 

Amount Mole (the default), Gram, Kilogram or Pound 

Composition Mass percent (the default), Mole percent, Mass fraction or 
Mole fraction 

Energy Joule (the default), Calorie or Electron volt 

Volume Cubic meter (the default), Cubic decimeter or Cubic centimeter 

Density Kilogram per cubic meter (the default) or Gram per cubic meter 

Entropy Joules per Kelvin (the default), Calorie per Kelvin or Electron volt 
per Kelvin 

Length Meter (the default), Micrometer or Nanometer 
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Setting Options 

Time Seconds (the default), Hours or Days 

Reset to original 
settings 

In the lower corner of the window, click the Reset to original 
settings button to restore the original settings. You may have to 
expand the window to view the button. 

 Graphical Mode – Activities 

To open this window, from the main menu select Tools →Options and click the 
Activities tab. 

 
There are System definition, Calculation, Scheil, Plotting and Tabulation 
settings windows.  

 For Plotting, the default settings are shared with the Graphical and 
Console Modes. Any changes you make also apply to the default settings on 
the Console Mode →Plotting tab in the Options window (and vice versa).  

 Also see Graphical and Console Mode-Plotting. 

17.3.1 System Definition (System Definer) 
When you create a new System Definer, the default databases are taken from 
these defaults. The database selections for each System Definer can then be 
configured individually. Once created, the specific (local) settings for a System 
Definer are not affected if you later make changes to the global defaults. 

To open this window, from the main menu select Tools →Options and click the 
Activities tab. Then click System definition.  

 Also see System Definer. 
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System Definer Default Settings in Graphical Mode 

Setting Options 

Default database selection Choose to define a Database or a Database 
package. 
If you choose Database, then select the default 
installed database to use globally for all System 
Definer nodes. For example, choose TCFE8 or 
TCNI8. 
If you choose Database Package, select an option 
from the list. These Database Packages are 
defined in the section Database Packages. 

User Databases 

Database name Click the Add button to add a custom database. 
After you have added the user database it is 
available from the list to choose as the default. 
Once a user database is added to the Database 
name list, you can also click the Remove button 
to delete it from your project. 

Database Packages 

Based on the installed 
databases, there are also 
default Database Packages 
available. 

Create and remove Database Packages by clicking 
the Add a database package  button or 
Remove this database package  button. 

 The addition or removal of a database 
package does not take effect until a new 
System Definer node is defined. 

Click Show details to display the list of databases 
included with the package. Click Hide details to 
only display the name of the package.  

 Also see Creating a Database Package. 

Reset to original settings In the lower corner of the window, click the Reset 
to original settings button to restore the original 
settings. You may have to expand the window to 
view the button. 

Creating a Database Package 

1. From the main menu select Tools → Options. 

2. Click the Activities tab and click System definition. 

3. Under Database Packages, click the Add a database package  button. 

4. Replace the default text with a name for the package, for example My 
database package. 

5. Select a database from the Choose database list, for example, TCNI8. 

6. Click the Add a database  button and from the Choose database list, 
select another database, for example, TCAL4 
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7. Click OK. The Database Package is now available to choose as the default 
for new System Definer activities. 

 

 The package is available for new System Definer nodes defined after 
adding the package. 

 
Clearing a Database Package Message 

Sometimes when working on the System Definer Configuration window, you 
may add or delete Databases. If you originally added a Database Package, the 
addition or removal of a database means that the original package you 
selected does not now match the databases you are using. To clear the 
message Selected databases and selected package may differ and reset the 
databases you need to either: 

• Change the newly added database back to the one that matches the 
database package, or 

• Choose another package from the Package list, then select the package 
you want. 

For example, from the Package list you select Demo: Steels and Fe-alloys. 

 
This adds the FEDEMO and MFEDEMO databases. 

 
If you add or remove Databases, in this example MFEDEMO is removed, then 
this does not match the Package and the message displays: 

 
To clear the message, click the Add a database  button and from the Choose 
database list, select the database that belongs with the package, in this 
example, MFEDEMO. The message is cleared. 
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You can also choose another package from the list, which changes the 
databases, and then re-select the original package to reset the message. 

17.3.2 Calculation (Equilibrium Calculator) 
When you create a new Equilibrium Calculator, its initial settings are taken 
from these defaults. The settings of each Equilibrium Calculator can then be 
configured individually. Once created, the specific (local) settings for an 
Equilibrium Calculator are not affected if you later make changes to the global 
defaults. 

To open this window, from the main menu select Tools →Options and click the 
Activities tab. Then click Calculation.  

 Also see Equilibrium Calculator. 

These settings can also be changed locally for a certain Equilibrium Calculator. 

 

Equilibrium Calculator Default Settings in Graphical Mode 

Setting Options 

Default calculation mode Simplified (the default) or Advanced 

Default calculation type Single equilibrium (the default), Property 
diagram, Phase diagram or Property grid 

Single equilibrium and property grid 

Global minimization The check box is selected by default to ensure 
that the most stable minimum under the specified 
conditions is computed. 

Max no of iterations Default is 500 

Max grid points Coarse (2000 grid points, the default), Medium 
(20,000 grid points), Fine (200,000 grid points), or 
Custom (set your own number of grid points) 
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Setting Options 

Required accuracy The default is 1.0E-6 

Smallest fraction The default is 1.0E-12 

Approximate driving force for 
metastable phases 

The check box is selected by default 

Force positive definite phase 
Hessian 

The check box is selected by default 

Control stepsize The check box is selected by default 

Property diagram 

Global minimization The check box is selected by default to ensure 
that the most stable minimum under the specified 
conditions is computed. 

Global test interval Every 10th eq (the default), Always or Custom 

Phase diagram 

Global minimization The check box is selected by default to ensure 
that the most stable minimum under the specified 
conditions is computed. 

Global test interval At node points (the default), Every 10th eq, Always 
or Custom 

Generate starting points 
automatically 

The check box is selected by default 

Use inside meshing points Click to select the check box as required 

No of meshes along an axis The default is 3 

Reset to original settings In the lower corner of the window, click the Reset 
to original settings button to restore the original 
settings. You may have to expand the window to 
view the button. 

17.3.3 Scheil (Scheil Calculator) 
When you create a new Scheil Calculator, its initial settings are taken from 
these defaults. The settings of each Scheil Calculator can then be configured 
individually. Once created, the specific (local) settings for a Scheil Calculator 
are not affected if you later make changes to the global defaults. 

To open this window, from the main menu select Tools → Options and click 
the Activities tab. Then click Scheil.  

 Also see Scheil Calculator. 

These settings can also be changed locally for a certain Scheil Calculator. 
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Scheil Calculator Default Settings in Graphical Mode 

Setting Options 

Start temperature Enter a default Start temperature that is higher 
than the liquidus temperature of the alloy, in 
other words, the temperature at which the alloy 
is completely melted. 

Temperature step Enter a default Temperature step. Decreasing the 
temperature step increases the accuracy, but the 
default value is usually adequate. 

Global minimization By default the Global minimization check box is 
not selected. Click to select it to perform a global 
minimization test when an equilibrium is reached. 
This costs more computer time but the 
calculations are more robust.  

Allow BCC → FCC By default the Allow BCC → FCC check box is not 
selected. Select the check box to allow 
transformations in the solidified part of the alloy 
caused by each of the components specified to be 
a fast diffuser. It is recommended that you only 
select this for steels. 

Reset to original settings In the lower corner of the window, click the Reset 
to original settings button to restore the original 
settings. You may have to expand the window to 
view the button. 

17.3.4 Tabulation (Table Renderer) 
When you create a new Table Renderer, its initial settings are taken from these 
default settings. The settings of each Table Renderer can then be configured 
individually. Once created, the settings of a Table Renderer are not affected by 
changes in the default settings. To open this window, from the main menu 
select Tools →Options and click the Activities tab. Then click Tabulation.  

 Also see Table Renderer. 

Table Renderer Default Settings in Graphical Mode 

Setting Options 

Decimal digits The default is 5 

Number format Auto (the default), Decimal or Scientific 

Phase description detail Composition (the default), Condensed, Constitution, or 
Composition and constitution 

Primary display color Click Modify to change the default 

Secondary display color Click Modify to change the default 

Reset to original settings In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. 
You may have to expand the window to view the 
button. 
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 Graphical and Console Mode-Plotting 

 The default settings are shared with both modes. Any changes you make 
also apply to the default settings on the Console Mode →Plotting tab in the 
Options window (and vice versa). 

 
To make local changes to the appearance of a specific plot, in the Results 
window right-click a plot and select Properties. In the Plot Properties window 
a variety of settings can be made.  

You can also edit some properties for individual plot lines (the color, the line 
width and type, and whether data points are included). In the Results window, 
hover the mouse over a plot line. The crosshair cursor turns into a cursor 
resembling a pointing hand when it is over a line that can clicked. Alternatively, 
hold down Ctrl while you move the cursor around the plot to only display it as 
a crosshair and prevent unintended edits. 

To globally configure the default settings for plotting, from the main menu 
select Tools →Options. Click the Graphical Mode →Activities tabs and then 
click the Plotting node. 

When you create a new Plot Renderer, its initial settings are taken from these 
default settings. The settings can then be configured individually. Once 
created, the settings of a Plot Renderer are not affected by changes to the 
default global settings. 

To configure the settings of an individual Plot Renderer rather than the default 
settings, right-click a plot in the Results window and select Properties from the 
menu. 

Plot Renderer Settings for Console and Graphical Modes 

Setting Options 

Title Enter a title. Select Plain text (the default) or LaTeX 
formatted text.  
Click α button to add symbols. Click a symbol category (for 
example, Latin characters or Greek and math symbols).  
Then click to choose the symbol located on the right-hand 
side.  
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Setting Options 

When you select LaTeX formatted text you can use the 
LaTeX math text to enter text.  

 For a list of supported LaTeX commands, see 
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-
mode.html 

Title font, Legend 
font, Label font, 
Header font 

Click Modify to edit the Font Name, Style, Size and Color. 

Legend phase 
caption style 

Choose All, Constitution description or Ordering 
description.  

 Also see About Legend Styles. 

Legend background 
color, Background 
color, Canvas color, 
Border color,  

Click Modify to choose a color or enter a specific color. 

Label format Select Plain text (the default) or LaTeX formatted text. 

Show anchor By default, an anchor between the label and the plot point is 
displayed. 

Retain labels 
(Graphical Mode 
only) 

By default the check box is selected. Plot labels are kept 
(retained) when plots are updated. It can be applied globally 
or locally to individual plots. 

Show header 
(Console Mode only) 

Click to select the Show header check box to display the 
basic details about the plot along the top. This includes the 
date and time the plot is generated, the database used and 
the properties. 

Border width Choose a plot border width between 1 (thin, the default) 
and 10 (thick). 

Color option For the plot line colors, choose from the options in the list: 
Legacy, Printer friendly, JFree chart, Pastel, Medium dark, 
Bright dark, Vivid or Earth. 
This option is also available for specific plot lines. To change 
the color of an individual plot line double-click it in the 
Results window and use the color palette to define it or 
enter a specific color. 

Line width For the plot line width, choose from the options in the list. 
These options are also available for specific plot lines. To 
change an individual plot line width double-click it in the 
Results window. 

Line type This option is only available for individual plot lines. To 
change an individual plot line type double-click it in the 
Results window and choose an option from the list. 

 

http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
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Setting Options 

Show data points Click to select the check box to display the data points on 
the plot lines. This option is also available for specific plot 
lines. To show data points on an individual plot line double-
click it in the Results window and select the check box. 

Data point marker 
size 

Choose the data point marker size between 1 (small) and 10 
(large). The default is 3. 

Plot Area Size The Fit the plot area size to the enclosing window option is 
selected by default. Excluding triangular plots, click Define 
the plot area size to enter a Plot area height and Plot area 
width.  

Reset to original 
settings 

In the lower corner of the window, click the Reset to original 
settings button to restore the original settings. You may 
have to expand the window to view the button. 

 Console Mode-Default Appearance  

To open this window, from the main menu select Tools →Options. To change 
the name, buffer size, fonts and colours for a specific Console window, right-
click the label for that particular Console and select Properties. 

 

Default Appearance Settings in Console Mode 

Setting Options 

Console name The default is Console or enter another name to 
display  

Buffer size The default buffer size is 40,000.  

 Also see Increasing the Buffer Size. 

System output font Click Modify to open the Select Font window and 
makes changes to the font type, style, size or color as 
required. Command prompt font 

User input font 

Background color Click Modify to open the Select Color window to 
choose a background color for the Console Mode 
window where you enter commands. 
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Setting Options 

Default directory Set the default directory where log files and workspace 
files are saved. 

Reset to original settings In the lower corner of the window, click the Reset to 
original settings button to restore the original settings. 
You may have to expand the window to view the 
button. 

17.5.1 Increasing the Buffer Size 
Sometimes the output overflows the window text buffer. 

 Also see Controlling Console Output.  

To increase the buffer size in a specific Console tab: 

1. Right-click the Console tab header in the Console window (if this is the first 
Console tab, it is labelled Console 1). 

2. Click Properties, and increase the Buffer size in the Console Properties 
window.  
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